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1   Introdução 

O Capture Pro Software é um aplicativo de digitalização de produção, fácil de 
instalar e utilizar, para captura eletrônica de documentos. 

Por ser um aplicativo independente, ele é ideal para aplicações de fluxo de 
trabalho, processamento de formulários e geração de imagens. Ele gerencia 
digitalização em um e dois lados, indexação e processamento em lote, em 
cores, em preto e branco e em escala de cinza. Os lotes podem ser facilmente 
exportados para muitos dos aplicativos mais usados. O Capture Pro Software 
permite a plena utilização de todos os recursos dos scanners para máxima 
produtividade. Todas as funções são executadas no software; não 
é necessária nenhuma aceleração especial de hardware.

O Capture Pro Software foi criado para proporcionar velocidade, precisão 
e facilidade de operação. Ele permite o rendimento ideal do scanner 
e a máxima produtividade. Uma tela de alta velocidade e com várias páginas 
apresenta as imagens e os dados de índice opcionais, à medida que os 
documentos são digitalizados. Um conjunto completo de ferramentas 
baseadas em ícones está disponível para simplificar o gerenciamento das 
digitalizações. 

Este Guia do administrador fornece informações detalhadas sobre a criação 
de configurações de trabalho que oferecerão aos usuários os meios mais 
eficientes de usar o Capture Pro Software. Também inclui informações sobre 
configurações de página, códigos de barras e códigos de correções, 
importação automática etc. 

Suporte do scanner O Capture Pro Software é compatível com scanners Kodak e Alaris. Alguns 
scanners de terceiros também estão habilitados a usar o Capture Pro. 
Uma lista completa pode ser encontrada no link abaixo:
www.kodakalaris.com/go/kcsscannersupport.

Para saber quais os requisitos de sistema atualizados e os sistemas 
operacionais certificados, consulte a página Especificações no site da 
Capture Pro em:
https://www.alarisworld.com/solutions/software/document-scanning-software/
capture-pro-software#Specifications.

https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
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Documentação de 
suporte

Além deste Guia do administrador, a documentação a seguir também está 
disponível:

• Ajuda on-line — fornece informações sobre o produto, incluindo 
configuração detalhada, detalhes sobre a interface do usuário e muitos 
recursos avançados. Para localizar informações no arquivo de Ajuda, você 
pode usar o sumário, o índice ou o recurso de pesquisa. 

Para acessar a Ajuda, pressione F1, selecione o botão Ajuda em uma 
caixa de diálogo ou clique no ícone ? no canto superior direito de qualquer 
janela.

• Guia de introdução — apresenta procedimentos simples para iniciar 
a operação rapidamente, incluindo a instalação e inicialização do Capture 
Pro Software. Também são apresentados procedimentos para digitalizar 
usando configurações de trabalho predefinidas padrão. Um arquivo em 
PDF deste guia está disponível na seção Manuais e guias da página 
Suporte do site do Capture Pro Software: 
https://support.alarisworld.com/capture-pro-software#Manuals. 

• Guia do usuário — apresenta as etapas básicas para criar um novo lote, 
digitalizar documentos, editar imagens digitalizadas e enviar um lote. Além 
disso, uma descrição de janelas, menus e ferramentas também é descrita.

Network Edition: Guia do sistema — apresenta os procedimentos de 
instalação do Capture Pro Network Edition. Um arquivo em PDF deste guia 
está disponível na seção Manuais e guias da página Suporte do site do 
Capture Pro Software:
• https://support.alarisworld.com/capture-pro-software#Manuals

Notas de versão — contêm informações que podem não ter sido 
disponibilizadas em outras documentações de apoio. Para ver as Notas de 
versão, acesse www.kodakalaris.com/go/kcsdownloads e vá até a seção 
Estação de Trabalho/Software Cliente do site. Esta seção contém um link 
para as Notas de versão mais recentes. 

Aplicativos de 
detecção de vírus

Se você estiver usando um aplicativo de detecção de vírus, o desempenho do 
sistema melhorará se você impedir o grupo de trabalho, as imagens 
digitalizadas e as pastas e subpastas de saída de lotes do Capture Pro 
Software de serem acessados pelo aplicativo de detecção de vírus. 

Os nomes padrão das pastas são: 

c:\ScanPro

c:\BatchesPro

c:\Usuários\Público\Documentos\KCS Pro

c:\Arquivos de Programas (x86)\Kodak\Capture Pro

OBSERVAÇÃO: se você modificou as pastas de instalação padrão 
selecionando a opção de instalação Avançada (Advanced), 
exclua essas pastas ao configurar seu software antivírus.

https://support.alarisworld.com/capture-pro-software#Manuals
https://support.alarisworld.com/capture-pro-software#Manuals
www.kodakalaris.com/go/kcsdownloads
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Instalação do 
software

Antes de começar, consulte o website da Kodak Alaris para ter certeza de que 
seu computador está de acordo com a Configuração recomendada para 
o Capture Pro Software:
https://www.alarisworld.com/solutions/software/document-scanning-software/
capture-pro-software#Specifications 

Para executar a instalação, você precisará do seguinte:

• O CD de driver do scanner fornecido pelo fabricante do scanner, se você for 
se conectar a um scanner.

• O arquivo PDF anexo ao e-mail de notificação da licença que contém seu 
número de série.

• Faça o download do aplicativo no site do Capture Pro Software em 
www.kodakalaris.com/go/CaptureProDownload.

Antes de instalar, verifique as Notas de versão para obter informações 
adicionais. As notas de versão estão disponíveis no site da Kodak Alaris em 
www.kodakalaris.com/go/kcsdownloads. Navegue até a seção Estação de 
trabalho/Software Cliente do site. Esta seção contém um link para as 
Notas de versão mais recentes.

Execute o instalador EXE que foi baixado para começar a instalação.

• Se o computador no qual o Capture Pro Software será instalado não tiver 
acesso à Internet, você também deverá fazer download da ferramenta 
Gerenciador de licença, que pode ser encontrada no site do Capture Pro 
Software. O Gerenciador de licença será instalado em um computador com 
acesso à Internet.

• Chave de hardware opcional (dongle USB), caso adquirida.

• Ter direitos de administrador no computador onde o software está sendo 
instalado.

1. Instale os drivers do scanner inserindo o respectivo CD na unidade e siga 
as instruções. 

2. Conecte o scanner e teste a conexão usando a Ferramenta de validação 
do scanner. Consulte o Guia do usuário do scanner para obter mais 
informações.

Quando você instalar o driver do scanner Kodak Alaris, a Ferramenta de 
validação de scanner será instalada automaticamente. Essa ferramenta 
será usada para testar se o scanner está conectado corretamente 
e funcionando.
OBSERVAÇÃO: siga as recomendações do fabricante para instalar 

e testar o scanner no computador.

https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
https://www.alarisworld.com/solutions/software/document-scanning-software/capture-pro-software#Specifications
http://www.kodakalaris.com/go/kcsdownloads
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3. Antes de instalar, verifique as Notas de versão para obter informações 
adicionais. As notas de versão estão disponíveis no site da Kodak Alaris 
em www.kodakalaris.com/go/kcsdownloads. Navegue até a seção 
Estação de trabalho/Software Cliente do site. Esta seção contém um 
link para as Notas de versão mais recentes.
Execute o instalador EXE que foi baixado para começar a instalação.

4. Quando a tela Menu de instalação for exibida, selecione o idioma 
desejado e clique na opção Instalar Capture Pro Software (Install 
Capture Pro Software).

5. Clique em Eu aceito os termos do contrato de licença (I accept the 
terms of the license agreement) após ter lido o Contrato de licença e clique 
em Avançar. A janela Chave de licença de hardware (Hardware License 
Key) será exibida.

6. Selecione Eu não usarei uma chave de hardware USB (I will not be 
using a USB Hardware Key) e clique em Avançar. 

OBSERVAÇÃO: se tiver comprado a chave de hardware USB opcional, 
selecione Eu inseri minha chave de hardware USB 
(I have inserted my USB Hardware Key) e clique em 
Avançar.

A tela Tipo de instalação (Installation Type) será exibida.

7. Clique em Avançar. A tela Número de série do software (Software Serial 
Number) será exibida.
OBSERVAÇÃO: só marque a opção Instalar como cliente do Capture 

Pro Network Edition (Install as Capture Pro Network 
Edition Client) se você tiver comprado o Capture Pro 
Software Network Edition e estiver instalando um 
cliente.

8. Digite o número de série do seu software e clique em Avançar. A tela 
Registro do produto (Product Registration) será exibida.

9. Digite sua ID de registro como mostrado no e-mail de notificação da 
licença que você recebeu. Se você não tiver uma ID de registro, selecione 
Registrar agora (Register Now) e conclua o registro. Clique em Avançar. 
A tela Obter licença (Get License) é exibida enquanto a licença é obtida do 
servidor de licenças da Kodak Alaris.

OBSERVAÇÃO: caso seu computador não tenha acesso à Internet, 
consulte “Apêndice A Gerenciador de licenças”, para 
informações sobre como obter uma licença. 

10. Na janela de Tipo de instalação (Setup Type), selecione Típica (Typical) 
e clique em Avançar. A tela Resumo da instalação (Installation Summary) 
será exibida.

11. Clique em Avançar. A tela Pronto para instalar o programa (Ready to 
Install the Program) será exibida.

12. Clique em Instalar (Install) para começar a instalação. Serão exibidas 
telas de progresso. Siga as instruções.

13. Clique em Concluir (Finish).

14. Se solicitado, selecione a opção de reiniciar o computador.

http://www.kodakalaris.com/go/kcsdownloads
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Inicialização do 
Capture Pro Software

Se não estiver usando a edição Somente índice ou Importação automática, 
certifique-se de que o scanner esteja ligado e conectado corretamente ao 
computador. Se tiver adquirido uma chave de hardware opcional, certifique-se 
de que seja inserida em uma porta USB no seu computador. 

• Clique com o botão direito do mouse no ícone do Capture Pro Software na 
área de trabalho e selecione Executar como administrador.

OBSERVAÇÕES:

• Os clientes do Network Edition o alertarão de que estão obtendo uma 
licença.

• Os clientes do Capture Pro Software Network Edition realizarão 
a sincronização inicial com o Capture Pro Server Software.

• Clique duas vezes no ícone do Capture Pro Software na área 
de trabalho ou

• vá para: Iniciar > Programas > Kodak > Kodak Capture Pro 
Software.
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2   Configuração de trabalho

A função 
Configuração do 
trabalho

A função Configuração do trabalho permite configurar os parâmetros de um 
trabalho. Este capítulo fornece informações e procedimentos sobre como 
selecionar opções das guias Captura (Capture), Índice (Index) e Saída 
(Output) que permitem configurar um trabalho que atenda às suas 
necessidades de digitalização. Depois que um trabalho é configurado, você 
pode selecionar um trabalho que atenda aos requisitos de saída 
e digitalização para um lote de documentos.

Para configurar trabalhos para uso com o Capture Pro Software, você 
precisa acessar a caixa de diálogo Configuração do trabalho (Job Setup). 
Na Configuração do trabalho (Job Setup), é possível selecionar um Nome do 
trabalho (Job Name) já definido e usá-lo como modelo para a personalização 
dos trabalhos que você precisar usar em seu ambiente. 

Há três trabalhos predefinidos no Capture Pro Software:

Pronto para digitalizar (Ready to Scan) — permite iniciar a digitalização dos 
documentos sem nenhuma configuração usando as configurações padrão. 
Esse trabalho não tem índices predefinidos e coloca todas as imagens 
digitalizadas em uma estrutura de pastas no diretório C:\ScanPro.

Digitalizar para PDF (Scan to PDF) — é igual à opção Pronto para digitalizar 
exceto que, quando documentos são digitalizados, a primeira página será 
exibida no Visualizador de imagens (Image Viewer) e você será solicitado 
a inserir um nome de arquivo como dados de índice. Os dados de índice são 
usados para gerar o nome dos arquivos de documentos gerados.

Digitalizar para envio por e-mail (Scan to e-mail) — é igual à opção 
Digitalizar para PDF, exceto pelo fato de que um arquivo PDF será criado 
e incluído como anexo de e-mail. Quando a digitalização estiver concluída, 
o aplicativo de software de e-mail será aberto com o anexo digitalizado 
e estará pronto para ser enviado a um endereço da sua conta de e-mail.

Dependendo do que deseja fazer, você pode selecionar uma destas 
configurações de trabalho para serem usadas como ponto inicial para 
configurar seu trabalho.
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Acesso a uma 
configuração de 
trabalho

• Clique em Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

Caixa de diálogo 
Configuração do 
trabalho (Job Setup)

As informações a seguir são comuns a todas as guias da caixa de diálogo 
Configuração do trabalho (Job Setup).

Nome do trabalho (Job name) — exibe na lista suspensa os trabalhos 
predefinidos e outros trabalhos que foram definidos. 

A caixa de diálogo Configuração do trabalho (Job Setup) possui três guias: 
Captura (Capture), Índice (Index) e Saída (Output). As seções a seguir 
apresentam informações detalhadas sobre como usar essas guias.
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• A guia Índice (Index) permite definir os campos de índice nos níveis lote 
e documento. A guia Pesquisa de banco de dados (Database Lookup) 
permite especificar a fonte de dados, o modo como a pesquisa será feita 
e quais dados serão usados para preencher os campos de índice ou validar 
o conteúdo desses campos. Consulte “Configuração de trabalho: Guia 
Índice (Index)” a seguir neste mesmo capítulo.

• A guia Saída (Output) permite configurar as opções Destinos (Destinations) 
e Avançadas (Advanced) para a configuração do trabalho. Consulte 
“Configuração de trabalho: guia Saída (Output)” a seguir neste mesmo 
capítulo.

Ícones

Adicionar: permite adicionar uma nova configuração de 
trabalho. 
1. Clique no ícone Adicionar (Add).

2. Insira um nome para a nova configuração de trabalho 
e clique em Salvar (Save).

3. Use as guias Captura (Capture), Índice (Index) e Saída 
(Output) para definir critérios para esta configuração de 
trabalho. Consulte as seções a seguir para obter 
informações detalhadas sobre cada uma dessas guias.

4. Clique em OK quando terminar.

OBSERVAÇÃO: O último caractere do nome da configuração 
de trabalho não pode ser um ponto (.).

Renomear: permite renomear a configuração de trabalho 
selecionada no momento. Você não pode renomear um trabalho 
que esteja aberto.
1. Selecione a configuração de trabalho que você deseja 

renomear na lista suspensa Nome do trabalho (Job Name).

2. Clique no ícone Renomear. 

3. Insira um novo nome para a configuração de trabalho 
e clique em OK. 

OBSERVAÇÃO: O último caractere do nome da configuração 
de trabalho não pode ser um ponto (.)

Excluir: permite excluir a configuração de trabalho selecionada. 
Não é possível excluir uma configuração de trabalho que esteja 
aberta, nem antes do processamento ou da exclusão de todos 
os lotes.
1. Selecione a configuração de trabalho que você deseja 

excluir na lista suspensa Nome do trabalho (Job Name).

2. Clique no ícone Excluir (Delete). Uma caixa de confirmação 
será exibida.

3. Clique em Sim (Yes) para confirmar a exclusão.
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Exportar: permite exportar a configuração do trabalho para 
outro local e salvá-la no Capture Pro Software.
1. Selecione uma configuração de trabalho na lista suspensa 

Nome do trabalho (Job Name).

2. Clique no ícone Exportar. A caixa de diálogo Exportação 
(Export) será exibida.

3. Clique em Procurar (Browse) para navegar até a pasta de 
destino para a qual você deseja exportar a configuração do 
trabalho.

4. O nome da exportação será preenchido com o nome do 
trabalho que você está exportando. Para alterar esse nome, 
digite o novo nome no campo Nome da exportação (Export 
name).

OBSERVAÇÃO: Diretório e Arquivos (Directory and Files) 
é o único Tipo de exportação (Export type) 
disponível no momento.

5. Clique em OK. Uma mensagem será exibida para avisar que 
a exportação obteve êxito.
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Depois de inserir todas as entradas da configuração de trabalho, clique em:

Mais destinos de saída (More Output destinations) — este botão só 
é apresentado na guia Saída (Output). Quando clicado, exibe os destinos de 
saída do sistema usados menos frequentemente e de terceiros.

Assistente de configuração de índice do SharePoint (SharePoint Index 
Setup Wizard) — fornece uma maneira rápida e fácil de configurar uma 
definição de trabalho do Capture Pro Software para usar com seu site 
SharePoint existente. Para mais informações, consulte “Uso do assistente de 
configuração do índice de SharePoint” posteriormente neste capítulo.

OK — fecha a caixa de diálogo e salva suas entradas.

Cancelar (Cancel) — fecha a caixa de diálogo sem salvar nenhuma alteração. 

Aplicar (Apply) — salva suas alterações, mas a caixa de diálogo permanece 
aberta.

Importar: (Import) permite importar uma configuração de 
trabalho para o Capture Pro Software de outro lugar. 
1. Clique no ícone Importar. A caixa de diálogo Importação 

(Import) será exibida.

2. Clique em Procurar (Browse) para navegar até uma 
configuração de trabalho exportada que você deseja 
importar. 

3. O nome da importação será preenchido com o nome do 
trabalho que você está importando. Para alterar esse nome, 
digite o novo nome no campo Nome da importação (Import 
name).

OBSERVAÇÃO: Diretório e Arquivos (Directory and Files) 
é o únicos Tipo de importação (Import 
type) disponível no momento.

4. Clique em OK. Uma mensagem será exibida para avisar que 
a importação obteve êxito.

OBSERVAÇÃO: se estiver importando um trabalho que usa um 
modelo de scanner diferente do que você está 
usando, será necessário reconfigurar 
configurações específicas do scanner (como 
configurações da impressora e do contador).
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Configuração de 
trabalho: Guia 
Captura (Capture)

A guia Capturar (Capture) permite configurar as opções Geral, Lote, Código 
de barras e OCR, Separação e Digitalizador.

• General (General) — permite definir como as imagens serão armazenadas 
após a digitalização.

• Configurações do lote (Batch Settings) — permite definir o formato de 
nomeação dos lotes para a configuração de trabalho selecionada, bem 
como limitar o número de documentos do lote ou de páginas de 
documentos.

• Código de barras, OCR e Detecção de marcas (Bar Code, OCR & Mark 
Detection) — permite que você crie e modifique o código de barras, OCR 
e zonas de detecção de marcas e que as ative para uso.

• Separação (Separation) — permite configurar as separações de 
documento e lote por: total, página em branco, zona de código de barras, 
zona OCR ou código de correção.

• Scanner — permite criar configurações para endereçamento e impressão 
de imagens em scanners com esses recursos. As configurações do 
scanner, como endereço da imagem, impressora e de correção, devem 
sempre ser feitas em Configuração do trabalho (Job Setup) e não em 
Configuração de página (Page Setup). As configurações conflitantes usarão 
como padrão a Configuração do trabalho (Job Setup).

• Classificar (Sort) — permite identificar como você deseja classificar 
páginas e documentos para um trabalho. A classificação pode ser física 
(automática) nos modelos de scanner que comportam várias bandejas de 
saída (por exemplo, Kodak i5x50S) ou pode ser manual. Vários tipos de 
regras de classificação podem ser adicionados ao seu trabalho. 
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Configurações gerais 
(General) — guia Captura 
(Capture)

Selecione Geral (General) na guia Captura (Capture) para definir ou alterar as 
seguintes configurações:

Local da imagem digitalizada (Scanned image location) — exibe o local em 
que as imagens digitalizadas do trabalho selecionado serão armazenadas. 
Se você não quiser armazenar as imagens digitalizadas no local exibido, 
clique em Procurar (Browse) para selecionar outro local.

Local da imagem de saída (Output image location) — permite selecionar 
o destino final das imagens de saída. Se você não quiser que as imagens vão 
para o local exibido, clique em Procurar (Browse) para selecionar outro local.

Descrição (Description) — permite inserir qualquer observação importante 
como lembrete das configurações desta configuração de trabalho.

Configuração de página (Page setup) — define a configuração da página 
padrão selecionada quando um novo lote é aberto. A lista de configurações de 
página disponíveis ao usuário durante a digitalização também pode ser 
selecionada. Selecione Configuração (Setup) para exibir a caixa de diálogo 
Selecionar configuração de página (Select Page Setup). Use os botões 
Adicionar item (Add Item) e Remover item (Remove Item) para criar uma 
lista de Configurações de página selecionadas (Selected Page Setups) 
a partir da lista Configurações de página disponíveis (Available Page Setups). 
Quando terminar, clique em OK. 

Na lista suspensa Configuração de página (Page setup), selecione 
a configuração de página padrão que será usada quando um novo lote 
for aberto.

• Encerrar o lote automaticamente quando a digitalização for concluída 
(Automatically close batch after scanning is finished) — se esta opção 
estiver selecionada, o lote é fechado no Explorador de lotes (Batch 
Explorer) e no Visualizador de imagens (Image Viewer) quando o transporte 
do scanner parar.

• Promover saída automaticamente quando o lote for encerrado 
(Automatically output when batch is closed) — se esta opção estiver 
selecionada, os lotes são processados para saída imediatamente após 
serem fechados. 
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• Manter o lote após a saída (Keep batch after output) — se esta opção 
estiver selecionada, o lote é salvo no local da imagem digitalizada e o lote 
de saída é criado.

• Adicionar páginas digitalizadas ao último documento do lote (Add 
scanned pages to the last document in the batch) — se esta opção estiver 
selecionada, as páginas digitalizadas na sequência serão adicionadas ao 
último documento do lote.

Configurações de lote 
(Batch settings) — guia 
Captura (Capture)

Selecione Configurações de lote (Batch Settings) na guia Captura (Capture) 
para definir o formato de nomeação de lotes para este trabalho e limitar 
o número de páginas do documento ou documentos do lote. Por exemplo, 
se você souber que todos os lotes contêm 100 documentos, a definição de 
limites alertará se um dos lotes não tiver o número de documentos esperado.

• Nomeação de lotes (Batch naming) — selecione:

- Nome do lote (Batch name) — selecione o nome de um lote na lista 
suspensa. O nome padrão para os lotes é “LoteXXX”. Se quiser mudar 
o nome do seu lote para “Faturas” e a data, clique em Configurar 
(Setup) para abrir a caixa de diálogo Configurações padrão (Standard 
Setup). Nessa caixa de diálogo você pode fazer essas configurações. 
Consulte “Alteração das configurações de nomeação de lotes” para 
conhecer os procedimentos.

- Número do lote seguinte (Next batch number) — insira o número do 
lote seguinte desejado.
O número do lote real é determinado no momento em que o lote é criado. 
Não será possível inserir um valor se a opção Ativar números de lote de 
nível de trabalho (Enable Job Level batch numbering) estiver 
desmarcada. Consulte “Configurando sua estação de trabalho” no 
Capítulo 2 do Guia do usuário para o Kodak Capture Pro Software.

• Limites (Limits) - Documentos por lote (Documents per Batch) — 
selecione:

- Números (Numbers): insira ou selecione os números mínimo e máximo 
de documentos que deseja permitir em um lote.
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- Avisar (Warn): insira um número de documentos que funcione como 
aviso de que o lote está próximo de alcançar o número máximo de 
documentos. Quando a digitalização ultrapassar esse limite (em um ou 
dois documentos), a digitalização será interrompida.

• Limites (Limits) - Páginas por documento (Pages per Document) — 
defina estas configurações:

- Números (Números): insira ou selecione os números mínimo e máximo de 
páginas que deseja permitir em um documento.

- Avisar (Warn): insira um número de página que funcione como aviso de 
que o documento está próximo de alcançar o número máximo de páginas. 
Quando a digitalização ultrapassar esse limite (em uma ou duas páginas), 
a digitalização será interrompida.

• Reiniciar ID de documentos (Reset document ID): marque esta caixa para 
redefinir o contador de documentos como 0.

Alteração das configurações 
de nomeação de lotes

Ao selecionar Padrão (Standard) e Configuração (Setup) no campo 
Nomeação de lotes (Batch naming), a caixa de diálogo Configuração padrão 
(Standard Setup) é exibida. Nela, é possível adicionar valores ao nome do lote 
ou excluí-los.

A lista Valores predefinidos (Predefined values) fornece valores que você 
pode selecionar para adicionar à fórmula de texto em uso no momento. Para 
adicionar qualquer número de itens ao nome do lote, basta selecionar o item 
desejado na lista Valores predefinidos (Predefined values).

Por exemplo, se desejar que o lote tenha o nome do usuário, a data e a hora, 
insira o seguinte: 

Nome do usuário, Data (dd), Ano (aa), Hora24 (HHmmss) 
O resultado seria: John Smith0409115503.

Para adicionar um valor:

1. Na lista Valores predefinidos (Predefined values), selecione o valor que 
você deseja adicionar.

2. Clique em Adicionar item (Add Item). O item será adicionado à fórmula.

OBSERVAÇÃO: ao especificar um nome de caminho, o limite será de até 
248 caracteres. 

3. Se desejar adicionar mais valores, repita as etapas 1 e 2.
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OBSERVAÇÃO: os campos Adicionar zeros à esquerda (Add leading 
zeros) e Extensão de número (Number length) ficam 
disponíveis quando você seleciona o valor Contador de 
lotes (Batch counter).

4. Se aplicável, clique em Adicionar zeros à esquerda (Add leading zeros) 
para adicionar zeros à esquerda da sequência numérica. 

5. Se aplicável, insira um valor no campo Extensão de número (Number 
length) para limitar o número de valores predefinidos permitidos na 
fórmula do texto. 

6. Clique em OK quando terminar.

OBSERVAÇÕES:

• Clicar em Excluir item (Delete Item) remove o último valor predefinido da 
fórmula do texto.

• Clicar em Excluir fórmula (Delete Formula) remove a fórmula do texto.

Quando são selecionados Redefinição do contador diário (Daily Counter 
Reset) e Configuração (Setup) no campo Nomeação de lotes (Batch 
naming), a caixa de diálogo Configuração de redefinição do contador diário 
(Counter Reset Setup) é exibida, onde é possível adicionar valores ao nome 
de lote ou excluí-los e selecionar o valor de redefinição.

A lista Valores predefinidos (Predefined values) fornece valores que você 
pode selecionar para adicionar à fórmula de texto em uso no momento. Para 
adicionar qualquer número de itens ao nome do lote, basta selecionar o item 
desejado na lista Valores predefinidos (Predefined values). Para ativar 
a Redefinição de contador diário (Daily Counter Reset), é necessário 
selecionar o valor predefinido de Contador de lote (Batch Counter). Quando 
Contador de lote (Batch Counter) é selecionado, o contador aumenta para 
cada novo lote. Quando Redefinir número de lote diariamente (Reset batch 
number every day) é selecionado, o Contador de lote será redefinido para 
o valor especificado por Redefinir valor (Reset value) no início de cada dia.
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OBSERVAÇÕES:

• Para evitar nomes de lote em duplicidade, a Fórmula de texto 
(Text Formula) deve incluir no mínimo um valor que mude diariamente. 
Por exemplo, se desejar que o lote tenha a data e um número que aumente, 
insira o seguinte:

Data(aaaa), Data(MM), Data(dd), Contador de lote
Para o primeiro lote do dia, o resultado será: 20120528001
O segundo lote será: 20120528002
O primeiro lote do próximo dia será: 20120529001

• Ao usar um scanner Kodak ou Alaris com uma impressora, a Redefinição 
de contador diário (Daily Counter Reset) também redefinirá o contador do 
scanner para um valor de 1 no início de cada dia.

Para adicionar um valor:

1. Na lista Valores predefinidos (Predefined values), selecione o valor que 
você deseja adicionar.

2. Clique em Adicionar item (Add Item). O item será adicionado à fórmula.

OBSERVAÇÃO: ao especificar um nome de caminho, o limite será de até 
248 caracteres.

3. Se desejar adicionar mais valores, repita as etapas 1 e 2.

OBSERVAÇÃO: os campos Adicionar zeros à esquerda (Add leading 
zeros) e Redefinir número de lote diariamente (Reset 
batch number every day) ficam disponíveis quando 
é selecionado o valor Contador de lotes (Batch 
counter).

4. Se aplicável, clique em Adicionar zeros à esquerda (Add leading zeros) 
para adicionar zeros à esquerda da sequência numérica.

5. Se aplicável, insira um valor no campo Extensão de número (Number 
length) para limitar o número de valores predefinidos permitidos na 
fórmula do texto.

6. Se aplicável, clique em Redefinir número de lote diariamente 
(Reset batch number every day) para que o número de sequência seja 
redefinido para um valor específico no início de cada dia.

7. Se aplicável, insira um valor no campo Redefinir valor (Reset value) 
para especificar o número de sequência inicial a ser usado no início de 
cada dia.

OBSERVAÇÕES:

• Clicar em Excluir item (Delete Item) remove o último valor predefinido da 
fórmula do texto.

• Clicar em Excluir fórmula (Delete Formula) remove a fórmula do texto.

Configurações da 
detecção de marcas, 
OCR e código de barras 
— Guia Captura 
(Capture)

Consulte “4 Configuração do código de barras, OCR e detecção de marcas” 
para obter informações sobre como configurar o seu código de barras, o OCR 
e as configurações de detecção de marcas.
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Configurações de 
separação — guia 
Captura (Capture)

A opção Separação (Separation) da guia Captura (Capture) permite identificar 
como você deseja separar os lotes e documentos deste trabalho. Há várias 
formas de adicionar separadores aos lotes. A lista a seguir fornece as opções 
que você pode usar para criar configurações de separação no Capture Pro 
Software:

• com uma zona de código de barras (consulte “4 Configuração do código de 
barras, OCR e detecção de marcas”)

• com uma zona de OCR (consulte “4 Configuração do código de barras, 
OCR e detecção de marcas”)

• com Códigos de correção 2, 3 ou T (consulte “3 Configuração de correção”)

• com a contagem de páginas automática de um ou mais documentos em um 
lote (para definir essa opção, use a opção Pelo total (By Count))

• com uma página em branco (para definir essa opção use a opção 
Por página em branco (By Blank Page)) 

• selecionando Documento > Novo (Document>New) ou Lote > Avançar 
(Batch>Next)

• pressionando Enter durante a digitalização
• clicando com o botão direito do mouse em um arquivo da page no 

Explorador de lotes (Batch Explorer) e clicando em Dividir (Split)

As seções a seguir fornecem informações e procedimentos para o uso do 
Capture Pro Software para separação automática de documentos ou lotes 
pelo total de páginas e como usar a separação de página em branco.

Pelo total (By Count) A configuração de separação Pelo total (By Count) na guia Captura (Capture) 
permite inserir o número de documentos em cada lote e o número de páginas 
em cada documento. 

1. Escolha Nível de lote (Batch Level) e/ou Nível de documento 
(Document Level).

2. Clique em Cada (Every) em Nível do lote (Batch Level) e insira o número 
de documentos que o lote deve conter para que um novo lote seja criado.
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3. Clique em Cada (Every) em Nível do documento (Document Level) 
e insira o número de páginas que o documento deve conter para que um 
novo documento seja criado.

Por página em branco 
(By Blank Page) 

Ao digitalizar imagens, você pode inserir páginas em branco para servirem de 
separadores. O Capture Pro Software reconhece as páginas em branco e as 
utiliza para iniciar novos lotes, documentos, ou para criar anexos de 
documentos.

Para usar esse método, ative a opção Por página em branco (By Blank 
Page) e selecione as configurações desejadas.

Quando você estiver digitalizando imagens em preto-e-branco e coloridas/em 
tons de cinza simultaneamente, o Capture Pro Software pode usar as imagens 
em preto-e-branco ou coloridas para determinar uma página em branco. 
Quando o software detecta uma página em branco, as quatro imagens 
(Frente colorida; Verso colorido; Frente em preto-e-branco; e Verso em preto-
e-branco) da página são excluídas do documento novo/atual ou anexadas 
a ele, dependendo das configurações que você criou.

O tamanho (em bytes) das imagens da frente e do verso de uma página deve 
ser inferior ao valor de bytes inserido para que o Capture Pro Software 
reconheça a página como em branco. Se o software não reconhecer uma 
página em branco, ele vai ignorá-la como separador. 

OBSERVAÇÃO: é recomendável testar esses valores para garantir que 
o software detecte suas páginas em branco como 
separadores. Consulte “Teste das suas configurações” para 
conhecer os procedimentos.

Separação de páginas em branco quando (Blank Page Image Separator 
when) — ativa a separação com páginas em branco.

• O tamanho da imagem (em bytes) é inferior a (Image size (byte) is 
below) — cria separações com páginas em branco de acordo com 
o tamanho (em bytes) da imagem da página em branco. Especifique 
a quantidade máxima de dados (bytes) que uma imagem pode conter 
e ainda ser considerada em branco para cada tipo de imagem (Preto-e-
branco, Colorido/Tons de cinza) que você digitalizará. 
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O tamanho da imagem é comparado com o tamanho da imagem não 
processada proveniente do scanner antes da operação. 

- Preto-e-branco (Black & White): digite o tamanho máximo da imagem 
para preto-e-branco. Por padrão, sugere-se usar 3.000 bytes para 
imagens em preto-e-branco.

- Em cores/tons de cinza (Color/Grayscale): digite o tamanho máximo da 
imagem para cores ou tons de cinza. O tamanho de imagem máximo que 
pode ser especificado é 1.000.000 bytes (1 MB), para permitir a separação 
com páginas em branco durante a digitalização em cores. Recomenda-se 
usar 100.000 bytes.

• O conteúdo da imagem (em %) for inferior a (Image content (%) is below) 
— cria separações com páginas em branco de acordo com o percentual do 
conteúdo da imagem da página em branco.

OBSERVAÇÃO: se as páginas que você está digitalizando forem de 
tamanhos diferentes, o total de bytes de imagem de uma 
página menor pode ser inferior ao total de bytes de uma 
imagem em branco mesmo que ela contenha dados. Para 
evitar isso, você pode querer especificar a porcentagem 
do conteúdo em vez do tamanho em bytes para 
descrever uma imagem em branco.

- Preto-e-branco (Black & White): digite o limite percentual para imagens 
em preto-e-branco.

- Em cores/tons de cinza (Color/Grayscale): digite o limite percentual 
para imagens coloridas e em tons de cinza.

Teste (Test) — abre a caixa de diálogo Testar imagem (Test Image), que 
permite digitalizar e testar a página em branco que está sendo usada como 
separador e será considerada em branco quando comparada com as 
configurações de Conteúdo da imagem (em %). Use esta opção para verificar 
se o software considera a página como em branco. Consulte “Teste das suas 
configurações” para obter mais informações.

O que fazer se uma página estiver em branco (What to do if a page is 
blank) — selecione uma das opções como a próxima etapa depois que 
o software reconhecer uma separação com página em branco. 
• Criar novo lote (Create a new batch) — cria um novo lote quando uma 

página em branco é detectada. 
• Criar novo documento (Create a new document) — cria um novo 

documento quando uma página em branco é detectada.
• A página seguinte permanece no documento atual (Next page stays in 

current document) — exclui a página em branco. 
• Excluir página (Delete page) — quando esta opção está selecionada, 

a página em branco não é incluída como separação no lote ou documento. 

Teste das suas configurações 1. Insira no scanner um documento semelhante ao que você quer testar 
quanto à separação com páginas em branco.



A-61993_pt-br  Março de 2022 21

2. Clique em Teste (Test) para exibir a caixa de diálogo Testar imagem 
(Test Image). 

3. Clique no botão Digitalização (Scan). Os resultados serão exibidos na 
caixa de diálogo Resultado do teste (Test result).

• A imagem é (The image is): indica se a imagem está Em branco (Blank) 
ou Não está em branco (Not Blank).

• A imagem tem - (bytes) (Image size is - (bytes)): o tamanho da imagem 
de teste em bytes.

• O conteúdo é - % (Content is - %): o percentual do conteúdo na imagem 
de teste.

4. Avalie os valores exibidos na área de resultados de teste A imagem tem - 
(bytes) (Image size is - (bytes)) e/ou O conteúdo é - % (Content is - %) 
e clique em Fechar (Close).

5. Com base nos resultados, reajuste os valores inseridos como necessário 
e clique em OK.

Configurações de 
classificação — guia 
Capturar (Capture)

Na tela Configuração do trabalho (Job Setup), guia Capturar (Capture), 
a opção Classificar (Sort) permite identificar como você deseja classificar 
páginas ou documentos para uma configuração de trabalho. A classificação 
pode ser a classificação física em modelos de scanner que fornecem várias 
bandejas de saída (por exemplo, scanner Kodak i5x50S) ou pode ser 
classificação manual. 

Classificar resulta em diferentes tratamentos na saída do scanner: 

• A página ou documento classificado é desviado para uma bandeja diferente 
(para classificação física).

• O scanner é parado e as instruções são exibidas ao usuário para a página/
documento classificado (para classificação manual).

A lista a seguir apresenta as opções que você pode usar para criar 
configurações de classificação no Capture Pro Software:

1. Por multialimentação

2. Por tamanho

3. Por código de correção

4. Por código de barras

5. Por índice de documento
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Se várias opções de classificação estiverem configuradas, a ordem de 
classificação será conforme listado acima. Para todas as opções de 
classificação, exceto índice de documentos, a classificação é feita por página. 
Para a classificação de índice de documento, todo o documento será 
classificado na bandeja definida ou instruído manualmente. 

Quando o scanner suporta classificação física e a classificação está 
configurada, o Destino padrão (Default Destination) deve ser definido na 
página Classificar - Geral (Sort – General). 

OBSERVAÇÃO: o Destino de papel (Paper destination) (a bandeja de papel 
padrão) será ativado somente quando o modelo de scanner 
suportar classificação física (por exemplo, um scanner 
Kodak i5x50S). 

As seções a seguir fornecem informações e procedimentos para usar 
o Capture Pro para classificar automaticamente páginas ou documentos.
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Por multialimentação No painel esquerdo da guia Capturar (Capture), escolha Classificar por 
multialimentação (Sort By Multifeed). Para esta opção de classificação, 
a detecção de multialimentação deve estar ativada no driver do scanner 
(consulte a documentação TWAIN ou ISIS do scanner). 

Para ativar Classificar por multialimentação, selecione o botão Classificar 
por multialimentação (Sort by Multifeed). Se o scanner suportar 
a classificação física (por exemplo, o scanner Kodak i5x50S), o campo 
Destino (Destination) listará as bandejas suportadas pelo scanner e os 
campos Mensagem serão ocultados. Se a classificação física não for 
suportada pelo scanner, o menu suspenso Destino (Destination) conterá 
Pausar e Continuar (Pause and Continue) e Parar (Stop) e o campo 
Mensagem (Message) será exibido e ativado. Se a opção Pausar e Continuar 
(Pause and Continue) for selecionada, você deverá definir o número de 
Segundos (Seconds) que deseja pausar a digitalização antes que o scanner 
retome o trabalho.

Durante a digitalização: quando a opção Classificar por multialimentação 
(Sort by Multifeed) estiver ativada e uma multialimentação for detectada pelo 
scanner:

• Para os scanners que suportam a classificação física, a página irá para 
a Bandeja de destino (Destination Tray) definida para Classificação física 
(Physical sorting) e a digitalização continuará. 

• Quando a classificação é manual e o Destino (Destination) é Pausar 
e Continuar (Pause and Continue), a digitalização será interrompida, 
a mensagem configurada será exibida durante o número especificado de 
segundos e fechada e, em seguida, a digitalização será retomada.

• Quando a classificação é manual e o Destino (Destination) é Parar (Stop), 
a digitalização será interrompida e a mensagem configurada será exibida. 
As opções do botão serão Continuar digitalização (Continue scanning) ou 
Parar (Stop).
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Por tamanho No painel esquerdo da guia Capturar (Capture), escolha Classificar por 
tamanho (Sort By Size). Para ativar essa opção, escolha o botão de opção 
Classificar por tamanho se (Sort by Size if) e selecione Adicionar (Add) 
para configurar as regras de tamanho. Nesta tela, cada linha da tabela mostra 
a que página de tamanho a regra é aplicada e aonde a página irá (para 
classificação física) ou a mensagem que será exibida e a ação do scanner 
(para classificação manual). 

Adicionar (Add) — Exibe a caixa de diálogo Adicionar tamanho (Add Size) 
para ativar a definição de uma regra de classificação de tamanho. 

• Dimensão (Dimension): escolha Comprimento (Length) ou Largura 
(Width) (se compatível). Para scanners que comportam a classificação 
física (por exemplo, i5x50S), a classificação por Comprimento 
(Length) é aceita.

• Comparação (Comparison): Menor que (Less than), Maior que 
(Greater than) ou Entre (Between). 

• Valor (Value): insira o valor em polegadas/mm que fará com que uma 
página seja classificada. 
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• Destino (Destination), Mensagem (Message) e Segundos (Seconds): 
se o scanner comportar a classificação física, (por exemplo, o scanner 
Kodak i5x50S), o Campo Destino (Destination) listará as bandejas 
compatíveis com o scanner e o campo Mensagem (Message) ficará 
oculto. Se o scanner não comportar a classificação física, o meu 
suspenso Destino (Destination) conterá Pausar e Continuar (Pause 
and Continue) e Parar (Stop) e o campo Mensagem (Message) será 
exibido e estará ativado. Se a opção Pausar e Continuar (Pause and 
Continue) for selecionada, você deverá definir o número de Segundos 
(Seconds) que deseja pausar a digitalização antes que o scanner 
retome o trabalho.

• OK: adiciona regra e fechar a caixa de diálogo Adicionar tamanho 
(Add Size).

• Cancelar (Cancel): fecha a caixa de diálogo Adicionar tamanho 
(Add Size) sem adicionar a regra.

OBSERVAÇÃO: para scanners que comportam a digitalização física, até 
duas regras de classificação poderão ser definidas. 

Editar (Edit) — Abrir a regra selecionada para edição na caixa de diálogo 
Adicionar tamanho (Add Size).

Excluir (Delete) — Remover a regra selecionada.

Mover para cima / Mover para baixo (Move Up / Move Down) — Mover 
a regra selecionada para cima ou para baixo na lista. A ordem pode ser 
importante: a primeira regra que é cumprida será aplicada. 

Durante a digitalização: Quando Classificar por tamanho (Sort by Size) 
é ativado e uma regra de tamanho é atendida, a ação abaixo será tomada. 
As páginas subsequentes serão avaliadas para regras de classificação:

• Para os scanners que suportam a classificação física, a página irá para 
a Bandeja de destino (Destination tray) definida para classificação física. 
A digitalização continuará. 

• Quando a classificação é manual e o Destino (Destination) é Pausar 
e Continuar (Pause and Continue), a digitalização será interrompida, 
a mensagem configurada será exibida durante o número especificado de 
segundos e fechada e, em seguida, a digitalização será retomada.

• Quando a classificação é manual e o Destino (Destination) é Parar (Stop), 
a digitalização será interrompida e a mensagem configurada será exibida. 
As opções do botão serão Continuar digitalização (Continue scanning) ou 
Parar (Stop).



26 A-61993_pt-br  Março de 2022
 

Por código de correção No painel esquerdo da guia Capturar (Capture), escolha Classificar por 
código de correção (Sort By Patch Code). Para ativar essa opção, escolha 
Classificar por código de correção se (Sort by Patch Code if). Selecione 
Adicionar (Add) para configurar regras de código de correção. As regras de 
classificação definem como lidar com folhas de código de correção. Nesta 
tela, cada linha da tabela mostra o código de correção a que essa regra 
é aplicada, se a imagem de código de correção é mantida e aonde a página 
de códigos de correção irá (para classificação física) ou a mensagem que será 
exibida e a ação do scanner (para a classificação manual). 

Adicionar (Add) — Exibe a caixa de diálogo Adicionar código de correção 
(Add Patch Code). 

• Código de correção (Patch Code): para os scanners que suportam 
a classificação física, o menu suspenso Código de correção 
(Patch Code) contém Todos (All), T, 1, 2, 3, 4 ou Alternar (Toggle), 
6, 10, 11, 12, 13, 14, 15. Para scanners sem classificação física, 
o menu suspenso contém 1, 2, 3, T. 

• Excluir imagem de correção (Delete patch image): marque se 
a imagem do código de correção precisar ser excluída. 
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• Destino (Destination), Mensagem (Message) e Segundos (Seconds): 
se o scanner comportar a classificação física, (por exemplo, o scanner 
Kodak i5x50S), o Campo Destino (Destination) listará as bandejas 
compatíveis com o scanner e o campo Mensagem (Message) ficará 
oculto. Para scanners sem classificação física, o menu suspenso 
Destino (Destination) conterá Pausar e Continuar (Pause and 
Continue) e Parar (Stop) e o campo Mensagem (Message) será 
exibido e ativado. Se a opção Pausar e Continuar (Pause and 
Continue) for selecionada, você deverá definir o número de Segundos 
(Seconds) que deseja pausar a digitalização antes que o scanner 
retome o trabalho.

• Folhas a classificar após a correção (Sheets after the patch to sort): 
permite selecionar quais folhas de papel, imediatamente após a folha 
de correção, serão enviadas para o destino definido. Este recurso só 
será habilitado para classificação física (por exemplo, Kodak i5x50S).

- (nenhuma) (none)

- Número especificado (Specified Number): permite selecionar um 
número exato de folhas de 1 a 99.

- Todas até esta correção (All Until This Patch): indica que todas as 
folhas de papel serão enviadas ao destino até a próxima folha de 
papel de quando a correção dessa regra for detectada.

OBSERVAÇÃO: use esta opção se você tiver um número 
desconhecido de páginas consecutivas no conjunto 
de documentos que deseja classificar. Nesse caso, 
obtenha duas folhas de correção com esse tipo de 
correção, em seguida, coloque uma folha de correção 
antes e a outra depois das páginas a serem 
classificadas.

- Todos os seguintes (All Following): indica cada folha de papel 
depois que a folha de correção é enviada para o destino, até 
a sessão de digitalização terminar.

OBSERVAÇÕES:

• A classificação em andamento continuará até terminar. Portanto, 
se você tiver uma regra para classificar um número específico de folhas 
e uma segunda regra de classificação for atendida antes que esse 
número de folhas seja classificado, a segunda regra será ignorada. 

• A classificação terminará mediante qualquer um dos seguintes 
eventos: interrupção da digitalização, multialimentação que 
interrompe a digitalização ou obstrução que interrompe 
a digitalização.

Destino (Destination): o local de saída para entregar cada folha para a qual 
esta regra de classificação de correção é aplicada.

OBSERVAÇÃO: o destino está disponível somente quando Folhas após 
o Patch para Classificar (Sheets After the Patch to Sort) 
não está (nenhum) (none).

OK: adicionar regra e fechar a caixa de diálogo Adicionar código de 
correção (Add Patch Code)

Cancelar (Cancel): fechar a caixa de diálogo Adicionar código de correção 
(Add Patch Code) sem adicionar a regra.
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Editar (Edit) — Abrir a regra selecionada para edição na caixa de diálogo 
Adicionar código de correção (Add Patch Code).

Excluir (Delete) — Remover a regra selecionada.

Mover para cima / Mover para baixo (Move Up / Move Down) — Mover 
a regra selecionada para cima ou para baixo na lista. A primeira regra que for 
cumprida será aplicada. 

Durante a digitalização: Quando Classificar por código de correção (Sort by 
Patch Code) é ativado e uma regra de tamanho é atendida, a ação abaixo 
será tomada. As páginas subsequentes serão avaliadas para regras de 
classificação:

• Para os scanners que suportam a classificação física, a página irá para 
a Bandeja de destino (Destination tray) definida para classificação física. 
A digitalização continuará. 

• Quando a classificação é manual e o Destino (Destination) é Pausar 
e Continuar (Pause and Continue), a digitalização será interrompida, 
a mensagem configurada será exibida durante o número especificado de 
segundos e fechada e, em seguida, a digitalização será retomada.

• Quando a classificação é manual e o Destino (Destination) é Parar (Stop), 
a digitalização será interrompida e a mensagem configurada será exibida. 
As opções do botão serão Continuar digitalização (Continue scanning) ou 
Parar (Stop).

Por código de barras No painel esquerdo da guia Capturar (Capture), escolha Classificar por 
código de barras (Sort By Bar Code). As regras de classificação definem 
como lidar com páginas com códigos de barras. 

Se o seu scanner fizer uma classificação física (por exemplo, um scanner 
Kodak i5x50S), você verá a seguinte caixa de diálogo. 

Escolha Classificar por tipo de código de barra (Sort by bar code type). 
A interface de usuário do driver TWAIN será exibida, permitindo que você 
configure regras de classificação de códigos de barras. 
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Se você adicionar regra(s) de código de barras e selecionar OK na caixa de 
diálogo TWAIN, então Classificar por tipo de código de barras (Sort by bar 
code type) permanecerá habilitado e o texto ao lado do botão Configurações 
(Settings) mostrará (As configurações estão configuradas) ((Settings are 
configured)). Se você não salvar uma regra de código de barras na caixa de 
diálogo TWAIN, o botão de opção Desativado (Off) será selecionado 
automaticamente, uma vez que nada foi configurado. O botão Configurações 
(Settings) é ativado somente quando uma ou mais regras de classificação de 
códigos de barras foram salvas. Utilize o botão Configurações (Settings) para 
voltar a digitar a guia de classificação do código de barras do driver TWAIN. 

A classificação por código de barras que você configurou na interface TWAIN 
será armazenada na definição de Configuração de trabalho para o seu tipo de 
scanner.

Se o seu scanner não fará a classificação física, a seguinte caixa de diálogo 
permitirá que você configure as regras de classificação do código de barras:

Escolha Classificar por código de barras se (Sort by Bar Code Zone if) para 
configurar regras de classificação manuais com base em uma ou mais zonas 
de código de barras predefinidas. Selecione Adicionar (Add) para configurar 
regras de classificação de códigos de barras. As regras são salvas na 
definição de Configuração de trabalho para scanners que não classificam. 
Nesta caixa de diálogo, cada linha da tabela mostra à qual zona do código de 
barras a regra é aplicada, a condição de classificação e a mensagem que será 
exibida. 

Adicionar (Add) — Abre a caixa de diálogo Adicionar zona de código de 
barras (Add bar code zone). 
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• Zona do código de barras (Bar code zone): lista de zonas de códigos 
de barras definidas na configuração do código de barras.

• Comparação (Comparison): escolha uma opção da lista. As opções do 
campo seguinte, Valor (Value), serão alteradas de acordo com a opção 
de Comparação (Comparison) escolhida:

• Destino (Destination): Pausar e Continuar (Pause and Continue) ou 
Parar (Stop). 

• Mensagem (Message): digite uma mensagem para exibir para 
o operador do scanner (por exemplo, “Remover página de códigos de 
barras”.) 

• Segundos (Seconds): se o Destino (Destination) é Pausar e Continuar 
(Pause and Continue), você deve definir o número de Segundos 
(Seconds) que deseja que a digitalização pare antes de reiniciar 
o scanner.

• OK: adicionar regra e fechar a caixa de diálogo Adicionar zona de 
código de barras (Add bar code zone).

• Cancelar (Cancel): fechar a caixa de diálogo Adicionar zona de 
código de barras (Add bar code zone) sem adicionar regra.

Editar (Edit) — Abrir a regra selecionada para edição na caixa de diálogo 
Adicionar zona de código de barras (Add bar code zone).

Excluir (Delete) — Remover a regra selecionada.

Seleção em Comparação 
(Comparison)

Entrada em Valor (Value) 

Valor entre (Value 
between)

Comprimento entre 
(Length between)

Controles para inserir valores ou comprimentos 
mínimos e máximos

Valor contém (Value 
contains)

Valor não contém (Value 
does not contain)

Valor começando com 
(Value starting with)
Valor terminando em 
(Value ending with)

Caixa de texto

Comprimento igual a 
(Length equal to)

Comprimento não igual 
a (Length not equal to)

Comprimento menor que 
(Length less than)

Comprimento maior que 
(Length greater than)
Valor igual a (Value 

equal to)
Valor não igual a (Value 

not equal to)
Valor inferior a (Value 

less than)
Valor maior que (Value 

greater than)

Controle para um comprimento ou valor
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Mover para cima / Mover para baixo (Move Up / Move Down) — Mover 
a regra selecionada para cima ou para baixo na lista. A primeira regra que for 
cumprida será aplicada. 

Durante a digitalização: quando Classificar por código de barras (Sort by Bar 
Code) é ativado e uma regra de tamanho é atendida, a ação abaixo será 
tomada. As páginas subsequentes serão avaliadas para regras de 
classificação:

• Para os scanners que suportam a classificação física, a página irá para 
a Bandeja de destino (Destination tray) definida para classificação física. 
A digitalização continuará. 

• Quando a classificação é manual e o Destino (Destination) é Pausar 
e Continuar (Pause and Continue), a digitalização será interrompida, 
a mensagem configurada será exibida durante o número especificado de 
segundos e fechada e, em seguida, a digitalização será retomada.

• Quando a classificação é manual e o Destino (Destination) é Parar (Stop), 
a digitalização será interrompida e a mensagem configurada será exibida. 
As opções do botão serão Continuar digitalização (Continue scanning) ou 
Parar (Stop).

Por índice de documento No painel esquerdo da guia Capturar (Capture), selecione Classificar por 
índice de documento (Sort By Document Index). Selecione Adicionar (Add) 
para configurar regras de índice de documento. Nesta tela, cada linha da 
tabela mostra a qual índice a regra é aplicada, a comparação a ser feita, 
o valor a ser usado para a comparação e aonde o documento irá (para 
classificação física) ou a mensagem que será exibida e a ação do scanner 
(para a classificação manual). 
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Adicionar (Add) — Mostra a caixa de diálogo Adicionar índice de 
documento. 

• Índice (Index): lista de campos de índice de documentos definidos.

• Comparação (Comparison): escolha uma opção da lista. As opções do 
campo seguinte, Valor (Value), serão alteradas de acordo com a opção 
de Comparação (Comparison) escolhida:

• Destino (Destination), Mensagem (Message) e Segundos (Seconds): 
se o scanner comportar a classificação física, (por exemplo, o scanner 
Kodak i5x50S), o Campo Destino (Destination) listará as bandejas 
compatíveis com o scanner e o campo Mensagem (Message) ficará 
oculto. Para scanners sem classificação física, o menu suspenso 
Destino (Destination) conterá Pausar e Continuar (Pause and 
Continue) e Parar (Stop) e o campo Mensagem (Message) será 
exibido e ativado. Se a opção Pausar e Continuar (Pause and 
Continue) for selecionada, você deverá definir o número de Segundos 
(Seconds) que deseja pausar a digitalização antes que o scanner 
retome o trabalho.

• OK: adicionar regra e fechar a caixa de diálogo Adicionar índice de 
documentos (Add Document Index).

• Cancelar (Cancel): fechar a caixa de diálogo Adicionar índice de 
documentos (Add Document Index) sem adicionar a regra.

Editar (Edit) — Abrir a regra selecionada para edição na caixa de diálogo 
Adicionar índice de documento (Add Document Index).

Excluir (Delete) — Remover a regra selecionada.

Mover para cima / Mover para baixo (Move Up / Move Down) — Mover 
a regra selecionada para cima ou para baixo na lista. A primeira regra que for 
cumprida será aplicada. 

Durante a digitalização: quando Classificar por índice de documento (Sort by 
Document Index) está ativado e uma regra de índice de documento é atendida:

Seleção em Comparação 
(Comparison)

Entrada em Valor (Value) 

Está vazio (Is Empty)
Tem valor (Has Value)

O campo Valor (Value) não aparece

Está entre (Is Between) Insira os valores alto e baixo
Igual a (Equal To)

Diferente de (Not Equal To)
Menor que (Is Less Than)

Maior que (Is Greater Than)
Contém (Contains)

Insira um valor
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• Para os scanners que suportam a classificação física, a página com 
o índice de documentos irá para a bandeja de Destino (Destination) 
definida para classificação física. A digitalização continuará. 

• Para a classificação manual e o Destino (Destination) é Pausar e Continuar 
(Pause and Continue), a digitalização será interrompida, a mensagem 
configurada será exibida durante o número especificado de segundos 
e fechada e, em seguida, a próxima página será digitalizada.

• Quando a classificação é manual e o Destino (Destination) é Parar (Stop), 
a digitalização será interrompida e a mensagem configurada será exibida. 
As opções do botão serão Continuar digitalização (Continue scanning) 
ou Parar (Stop).

OBSERVAÇÃO: para todas as outras opções de classificação, a página que 
está “classificada” — desviada para a bandeja de destino — 
é a única página que satisfaz a regra. Para a classificação 
de Índice de documentos (Document Index), um documento 
inteiro (conforme definido no Capture Pro) é afetado pela 
regra de classificação. O documento pode conter uma ou 
várias páginas. As páginas são desviadas para o destino até 
que um índice de documento que NÃO atenda à regra seja 
reconhecido. Nesse ponto, as páginas digitalizadas 
retornam à saída no destino normal.

Configuração de 
trabalho: Guia Índice 
(Index)

Indexar permite adicionar funções de processamento de dados à 
digitalização, captura e saída de imagens no nível do documento e do lote.

Você pode configurar fórmulas de indexação que verifiquem a precisão dos 
metadados contidos em zonas de OCR, de código de barras e de detecção de 
marcas. Se houver um erro na interpretação dos dados durante a leitura do 
código de barras, OCR ou detecção de marcas, a fórmula de indexação pode 
identificar os erros e interromper a digitalização. 

Você também pode configurar fórmulas de indexação que enviem as imagens 
para outros locais com base nos metadados.

• Para obter informações sobre como criar formatos de entrada, consulte 
“Formatos de entrada” mais à frente nesta seção.

• Para obter informações sobre como criar formatos de saída, consulte 
“Formatos de saída” mais à frente nesta seção.

• Para obter informações sobre como configurar índices para saída para 
o SharePoint, consulte “Uso do assistente de configuração do índice de 
SharePoint” mais à frente nesta seção.

A guia Índice (Index) na caixa de diálogo Configuração do trabalho 
(Job Setup) permite definir um campo de índice nos níveis de Lote (Batch) 
e Documento (Document). Os campos do Índice (Index) são configurados da 
mesma forma nos níveis de Lote (Batch) e de Documento (Document).
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Veja a seguir as descrições dos campos da guia Índice (Index): 

Ação quando houver falha na auditoria (Action when audit fails) — 
selecione o que você quer que o scanner faça quando houver falha na 
auditoria. 

• Continuar digitalização (Continue scanning): manter a digitalização 
mesmo se a auditoria encontrar valores de índice ilegais. 

• Interromper digitalização (Stop scanning): interromper a digitalização 
e entrar automaticamente no modo Edição de índice se a auditoria 
encontrar valores de índice ilegais. 

Ignorar auditoria durante a navegação (Bypass audit during navigation) — 
marque essa caixa para desativar a função de auditoria ao navegar por 
documentos no Explorador de lotes (Batch Explorer). O termo “auditoria” 
refere-se ao sistema que verifica se todos os valores de índice são 
compatíveis com o formato de entrada/saída.

O campo Índices (Indexes) exibe os valores definidos para cada índice: 
Nome (Name), Tipo (Type), Valor padrão (Default Value), Formato de 
entrada (Input Format), Formato de saída (Output Format), Somente 
leitura (Read-only) e Oculto (Hidden). Você pode editar, excluir, mover para 
cima ou para baixo um valor na lista ou adicionar um novo valor usando os 
seguintes botões:

• Adicionar (Add): abre a caixa de diálogo Campo de índice de adicionar 
documento (Document Add Index Field) para criar um novo campo de 
índice em um documento ou a caixa de diálogo Campo de índice de adicionar 
lote (Batch Add Index Field) para criar um novo campo em um lote.

• Editar (Edit): abre a caixa de diálogo Campo de índice de editar documento 
(Document Edit Index Field) para modificar um campo de índice em um 
documento ou a caixa de diálogo Campo de índice de editar lote (Batch Edit 
Index Field) para modificar um campo de índice em um lote.

• Excluir (Delete): remove o campo de índice selecionado. 
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• Mover para cima (Move up): move o campo de índice selecionado uma 
posição para cima na lista de índices. 

• Mover para baixo (Move down): move o campo de índice selecionado uma 
posição para baixo na lista de índices.

Adição de um campo de 
índice de documento

Para adicionar um campo de índice de documento:

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione um trabalho na lista suspensa Nome do trabalho (Job Name) 
e abra a guia Índice (Index).

3. Abra a guia Documento (Document).

4. Clique em Adicionar (Add). A caixa de diálogo Adicionar campos de 
índice de documento (Document - Add Index Field) será exibida.

5. Digite o nome do seu índice no campo Etiqueta (Label). 

6. Você pode inserir observações ou comentários no campo Descrição 
(Description).

7. Selecione Valor único (Single Value), Lista suspensa (Drop-down list), 
Lista suspensa, seleção múltipla (Drop-down list, multiple selection) 
ou a API do índice (se disponível) no campo Tipo (Type). Valor único 
(Single Value) permite inserir qualquer valor. Lista suspensa (Drop-down 
list) permite configurar uma lista fixa de valores para escolha (por 
exemplo: se você quiser fornecer uma lista de países para o usuário 
escolher um deles). Lista suspensa, seleção múltipla (Drop-down list, 
multiple selection) é similar a Lista suspensa (Drop-down list), exceto que 
você poderá selecionar vários valores da lista.

OBSERVAÇÃO: se você tiver criado sua própria API do índice, ela será 
mostrada na lista suspensa Tipo (Type). Quando você 
selecionar uma API do índice, o botão Configurar 
(Setup) ficará disponível. Clique no botão Configurar 
(Setup) para alterar qualquer configuração. 
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8. Se você selecionar Valor único (Single Value), poderá marcar Somente 
leitura (Read only) para impedir a gravação do índice. Isso protege as 
informações importantes para impedir que elas sejam excluídas por 
usuários.

9. Marque a opção Obrigatório (Required) para tornar este índice um item 
de verificação obrigatória.

10. Marque Entrada dupla (Double Entry) para permitir uma entrada de 
dados adicional no campo de índice. Para mais informações, consulte 
“Entrada dupla de dados” posteriormente neste capítulo. O Tipo de campo 
(Field Type) deve ser Valor único (Single Value) e o campo não pode ser 
Somente leitura (Read only) ou Oculto (Hidden). A indexação automática 
na primeira entrada de dados pode ser configurada para especificar uma 
zona de OCR, código de barras ou OMR. 

11. Se você selecionar Valor único (Single Value), poderá marcar Oculto 
(Hidden) para ocultar esse índice dos usuários. Isso protege as 
informações confidenciais.

12. No campo Extensão mínima do campo de índice (Minimum index field 
length), insira um número que defina o menor tamanho de campo de 
índice válido. 

13. Marque a caixa Verificar campo durante a digitalização (Check field 
during scanning) se desejar que o sistema verifique campos de índice 
durante a digitalização das páginas. 

14. Insira um valor predefinido no campo Valor padrão (Default value) ou 
clique em Configurar (Setup) para exibir a caixa de diálogo Configuração 
do valor padrão (Default Value Setup) e defina seus próprios valores. 

OBSERVAÇÃO: se você criou uma zona do código de barras, de OCR ou 
de detecção de marcas, ela será mostrada na lista 
Valores predefinidos (Predefined values) (por exemplo: 
BC_[nomedazona] ou OCR_[nomedazona]. Para usar 
uma zona de OCR/código de barras para um campo de 
índice, atribua o BC_[nomedazona]/OCR_[nomedazona] 
adequado como valor padrão para o campo de índice. 
Talvez seja necessário rolar até o fim da lista Valor 
predefinido (Predefined value) para ver os campos de 
índice do código de barras/OCR/detecção de marcas.

Use a caixa de diálogo Configuração do valor padrão (Default Value Setup) 
para criar ou revisar uma fórmula para o valor padrão do campo de índice. 
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• Selecione um valor predefinido na lista Valores predefinidos 
(Predefined Values). A Fórmula de valor padrão (Default Value 
Formula) (se houver) será exibida à direita da caixa.

• Clique em Adicionar item (Add Item).

OBSERVAÇÃO: a opção Excluir item (Delete Item) remove o último 
valor predefinido que foi adicionado à fórmula de 
valor padrão. A opção Excluir fórmula (Delete 
Formula) remove toda a fórmula de valor padrão. 

• Clique em OK quando terminar. A fórmula revisada preencherá a caixa 
de texto Valor padrão (Default Value). 

15. Insira o formato de entrada. Consulte “Formatos de entrada” adiante neste 
capítulo para obter mais informações. 

16. Insira o formato de saída. Consulte “Formatos de saída” adiante neste 
capítulo para obter mais informações. 

17. Se desejar definir Caracteres substitutos (Substitute Characters) para 
substituição automática de pares de caracteres, clique em Configurar 
(Setup). A caixa de diálogo Configuração de caracteres substituídos 
(Substitute Characters Setup) será exibida. 

• Coluna Original — lista os caracteres antigos a serem substituídos. 
No fim da coluna, selecione um caractere original na lista suspensa. 
Selecione o caractere que você quer trocar por um caractere de 
substituição. Você pode selecionar <Espaço> (<Space>), <Mudança de 
linha> (<Linefeed>) ou <Tabulação> (<Tab>). O caractere original pode 
aparecer apenas uma vez na coluna Original.

• Coluna Substituto (Substitute) — lista os novos caracteres a inserir. 
Selecione o caractere substituto na lista suspensa, na parte inferior da 
coluna. Selecione <Espaço> (<Space>), <Mudança de linha> 
(<Linefeed>), <Tabulação> (<Tab>) ou <Substituir> (<Replace>). 
Caracteres substitutos podem aparecer mais de uma vez na coluna 
Substituto (Substitute).

• Adicionar (Add) — clique para adicionar o par de caracteres original 
e substituto selecionado nas duas listas suspensas. Se você tiver 
selecionado apenas o caractere original, o Capture Pro Software usará 
<Substituir> (<Replace>) como padrão para o caractere substituto. 

• Excluir (Delete) — clique para excluir o par de caracteres original 
e substituto das colunas Original e Substituto (Substitute).
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18. Se desejar definir uma lista de valores para o campo índice, clique em 
Configurar (Setup) ao lado da caixa Lista (List). A caixa de diálogo 
Configuração de lista (List Setup) será exibida. 

Você pode selecionar para inserir valores de lista manualmente ou 
importar uma lista de valores existentes de uma fonte de dados em 
conformidade com ODBC ou uma biblioteca do SharePoint.

Cadastro manual

• Insira o valor desejado na caixa de texto na coluna Valor (Value).
• Insira uma descrição do valor na caixa de texto na coluna Descrição 

(Description).
• Clique em Adicionar (Add) para adicionar o par valor e descrição 

inserido por você nos dois campos de texto. Se você não tiver criado 
uma descrição, a linha da coluna Descrição (Description) ficará em 
branco. 

Importação de uma lista

• Clique em Importar lista (Import List).

• Crie uma nova conexão de SharePoint ou ODBC, ou selecione uma 
conexão existente.

• Clique em Avançar.

• Selecione a coluna que será usada para preencher o campo Valor 
(Value) e selecione uma coluna que será usada para preencher 
o campo Descrição (Description).
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• Clique em Importar (Import). Todos os valores únicos e as descrições 
associadas, se especificadas, serão importadas. Se um valor de 
correspondência já estiver na lista, não será substituído pelo valor 
importado. Os valores importados serão anexados na lista.

OBSERVAÇÃO: clique em Excluir (Delete) se deseja remover um 
valor, ou clique em Excluir tudo (Delete All) para 
excluir todas as entradas na lista.

• Marque Permitir qualquer valor (Allow any value) se não quiser definir 
limitações para os valores do índice.

• Selecione uma Ação de indexação (Indexing action) na lista suspensa: 
Usar somente valor (Use value only), Usar somente descrição 
(Use description only) ou Usar valor e descrição (Use value and 
description).

• Quando terminar, clique em OK e retorne à caixa de diálogo Adicionar 
campos de índice de documento (Document - Add Index Field).

19. Clique em OK na caixa de diálogo Adicionar campos de índice de 
documento (Document - Add Index Field). As novas informações de índice 
de documento serão exibidas na tabela na guia Documento (Document). 

OBSERVAÇÃO: para ordenar a tabela na ordem ascendente ou 
descendente, clique no cabeçalho da coluna apropriada. 
Se clicar no cabeçalho da coluna Valor (Value), a tabela 
será ordenada pelos valores na coluna Valor (Value). 
Se clicar no cabeçalho da coluna Descrição 
(Description), a tabela será ordenada pelos valores na 
coluna Descrição (Description).

20. Clique em OK para salvar e sair da caixa de diálogo Configuração do 
trabalho (Job Setup).

Edição do campo de 
índice de um documento

Para editar o campo de índice de um documento:

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione um trabalho na lista suspensa Nome do trabalho (Job Name) 
e abra a guia Índice (Index).

3. Abra a guia Documento (Document).

4. Selecione um campo de índice.
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5. Clique em Editar (Edit). A caixa de diálogo Documento - Editar campos de 
índice (Document - Edit Index Field) será exibida.

6. Altere as informações na caixa de diálogo como desejado e clique em OK. 

Adição de um campo de 
índice de lote

Para adicionar um campo de índice de lote:

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione um trabalho na lista suspensa Nome do trabalho (Job Name) 
e abra a guia Índice (Index).

3. Abra a guia Lote (Batch). 

4. Clique em Adicionar (Add). A caixa de diálogo Lote - Adicionar campos 
de índice (Batch - Add Index Field) será exibida.
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5. Preencha as informações na caixa de diálogo e clique em OK. Consulte 
“Adição de um campo de índice de documento”, anteriormente neste 
capítulo para obter descrições detalhadas dos campos.

6. Clique em OK para salvar e sair da caixa de diálogo Configuração do 
trabalho (Job Setup).

Propriedades de PDF A guia Propriedades de PDF (PDF Properties) permite especificar um valor 
para cada marcador de documento ou atribuir valores de índice ao metadados 
de propriedades de PDF.

OBSERVAÇÃO: para este recurso funcionar corretamente, certifique-se de 
que Agrupar por Páginas múltiplas (Group by Multi-Page) 
para cada Lote (Batch) está selecionado na caixa de 
diálogo Configuração de PDF (PDF Setup). Consulte 
“Opções de configuração de Arquivo (1) e Arquivo (2)” 
a seguir neste mesmo capítulo.

As propriedades de PDF Título (Title), Assunto (Subject), Autor (Author) 
e Palavras-chave (Keywords) podem ser mapeadas para valores do sistema, 
índices de documentos ou índices de lote. Use o botão Configuração (Setup) 
em cada campo para exibir uma caixa de diálogo onde você pode definir 
o mapeamento. 

Para definir Título (Title), Assunto (Subject), Autor (Author) ou Marcador de 
PDF (PDF Bookmark):
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1. Clique em Configurar (Setup) para exibir a caixa de diálogo Definir valor 
de marcador de PDF (Set PDF Bookmark Value).

2. Selecione os valores predefinidos desejados a partir da lista e clique em 
Adicionar item (Add Item).

3. Clique em OK quando terminar.

Para definir Palavras-chave (Keywords):

1. Clique em Configurar (Setup) para exibir a caixa de diálogo Definir 
valores de palavras-chave de PDF (Set PDF Keyword Values).

2. Para adicionar à fórmula de palavras-chave atualmente destacada, 
selecione os valores predefinidos desejados a partir da lista e clique em 
Adicionar item (Add Item).

3. Clique em Excluir item (Delete Item) para remover o valor predefinido no 
final da fórmula destacada.

4. Para criar uma fórmula para uma nova palavra-chave, selecione os 
valores predefinidos desejados na lista e clique em Nova palavra-chave 
(New Keyword). 

5. Clique em Excluir palavra-chave (Delete Keyword) para remover 
a fórmula de palavra-chave destacada da tabela. 

6. Clique em OK quando terminar.

7. Clique em Cancelar (Cancel) para perder as alterações e fechar a caixa 
de diálogo. 
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Entrada dupla de dados A Entrada dupla permite que dois operadores de entrada de índice indexem 
os documentos separadamente para melhorar a precisão dos dados 
indexados.

Quando a digitalização é concluída, o operador seleciona Índice1 (Index1) no 
menu de Índice (Index) para indicar que o lote está pronto para a primeira 
operação de indexação.

O primeiro operador de índice insere os valores de índice para o lote e para 
cada documento. Ao concluir o índice, o operador seleciona Índice2 (Index2) 
no menu de Índice para indicar que o lote está pronto para a segunda 
operação de indexação.

Configuração de entrada 
dupla

Para usar a Entrada dupla, um ou mais campos de índice de lote ou de 
documento devem ser configurados como Entrada dupla (Double Entry).

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione um trabalho na lista suspensa Nome do trabalho (Job Name) 
e abra a guia Índice (Index).

3. Abra a guia Lote (Batch) ou Documento (Document).

4. Selecione o campo de índice Entrada dupla (Double Entry) desejado 
e clique em Editar (Edit). A caixa de diálogo Lote ou Documento - Editar 
campos de índice (Batch or Document - Edit Index Field) será exibida.

5. Marque a caixa de seleção Entrada dupla (Double Entry).

OBSERVAÇÕES:

• O Tipo (Type) deverá ser um Valor único (Single Value).

• O campo de índice não pode ser somente leitura, portanto, Somente 
leitura (Read-only) fica desativado.

• O campo de índice não pode estar oculto, portanto, Oculto (Hidden) fica 
desativado.



44 A-61993_pt-br  Março de 2022
 

• A única maneira de configurar um valor padrão para um campo de entrada 
dupla de dados é usando um campo de índice automatizado, como o valor 
de OCR ou de código de barras. Se esse comportamento for desejado, 
selecione a zona OCR ou a zona do código de barras na caixa de diálogo 
Configuração do valor padrão (Default Value Setup).

• Se alguma das configurações acima não estiver correta, a caixa de seleção 
Entrada dupla (Double Entry) será desmarcada e desativada.

Operação Entrada dupla Um trabalho que tem um ou mais campos de índice de lote ou documento 
configurados como Entrada dupla é usado para digitalizar documentos como 
qualquer outro trabalho.

Quando a digitalização do documento está concluída e o lote está pronto para 
indexação, o operador seleciona Índice > Índice1 (Index > Index1). Isso 
altera o Status do lote de Disponível (Available) para Índice1 (Index1), 
significando que o lote está pronto para a entrada do primeiro conjunto de 
valores de índice.

Quando o operador do primeiro índice tiver inserido os valores de índice de 
todos os documentos, Índice>Índice2 (Index>Index2) será selecionado. 
Isso altera o Status do lote de Índice 1 (Index1) para Índice2 (Index2), 
significando que o lote agora está pronto para a entrada do segundo conjunto 
de valores de índice.

O operador do segundo índice não verá os valores inseridos pelo operador do 
primeiro índice.

Se o valor inserido pelo operador do segundo índice corresponder ao primeiro 
valor, nenhuma ação será necessária, e a indexação continuará.

Se o primeiro e o segundo valores não corresponderem, a caixa de diálogo 
Resolução de entrada (Entry Resolution) será exibida, e a entrada correta 
será selecionada pelo operador.
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OBSERVAÇÕES:

• Se o operador de digitalização também estiver inserindo o primeiro conjunto 
de valores de índice, ele precisará selecionar Índice > Índice1 (Index > 
Index1) e selecionar imediatamente Índice > Índice2 (Index > Index2) ao 
digitalizar, e a operação do primeiro índice estará concluída.

• A comparação dos valores de Índice 1 e Índice 2 possui diferenciação entre 
maiúsculas e minúsculas. Por exemplo, “LETRA MAIÚSCULA” não 
corresponde a “Letra maiúscula”. Além disso, os zeros à esquerda são 
importantes. Por exemplo, o valor 123 não corresponde a 0123.

• Os campos de índice de Entrada dupla (Double Entry) terão qualquer 
espaço em branco à esquerda e à direta removidos antes de o valor ser 
salvo. 

Por exemplo, se o valor “    Envio     ” for inserido, ele será salvo como 
“Envio”. Isso significa que se Índice 1 for inserido como “     Envio” e Índice 
2 for inserido como “Envio     ” os valores corresponderão.

Resolução da entrada A caixa de diálogo Resolução de entrada (Entry Resolution) é exibida quando 
o valor do segundo índice corresponde ao valor do primeiro índice.

O operador de índice tem as seguintes opções:

• Selecionar a entrada feita pelo operador do primeiro índice selecionando 
Entrada 1 (Entry1).

• Selecionar a entrada feita por ele selecionando Entrada 2 (Entry2).

• Inserir um novo valor no campo Nova entrada (New Entry) se nenhuma das 
entradas estiver correta.
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• Cancelar e fechar a caixa de diálogo Resolução de entrada (Entry 
Resolution) se ele não quiser fazer uma escolha. Se for tomada uma 
decisão de não resolver o valor de índice sem correspondência em um ou 
mais campos de índice obrigatórios, a seguinte mensagem será exibida se 
for feita uma tentativa de enviar o lote, Um ou mais campos do índice 
requerem Entrada dupla. O Lote não pode ser enviado neste momento. 
Deseja entrar no modo Índice? (One or more index fields require 
Double Entry. You may not output the batch at this time. Do you wish 
to enter Index Mode?) 

Se nenhum dos campos de Entrada dupla (Double Entry) for obrigatório, 
a caixa de diálogo Resolução da entrada (Entry Resolution) será exibida 
na saída. Todos os campos de índice de Entrada dupla (Double Entry) 
sem correspondências de entrada deverão ser resolvidos antes do envio.

OBSERVAÇÕES:

• Se um campo de Entrada dupla (Double Entry) não for obrigatório, uma ou 
mais entradas de índice poderão ser deixadas em branco, e a caixa de 
diálogo Resolução de entrada (Entry Resolution) não será exibida; não 
haverá nenhum erro no envio.

• Se ambos os valores de Entrada dupla (Double Entry) forem inseridos 
e não corresponderem, o operador deverá fazer uma seleção na caixa de 
diálogo Resolução (Entry Resolution) de entrada antes do envio.

• Um campo de índice ativado para Entrada dupla (Double Entry) não pode 
ser usado para realizar uma Pesquisa de banco de dados (Database 
Lookup) ou ser um campo verificado ou preenchido pela Pesquisa de banco 
de dados (Database Lookup).

Formatos de entrada Um Formato de entrada é uma expressão de texto usada para examinar 
a entrada do usuário em um campo de índice específico. O objetivo disso 
é impedir a entrada de dados incorretos nos campos de índice. A sintaxe do 
formato de entrada pode ser um dos seguintes formatos ou uma combinação 
deles:
• Formatos de texto
• Formatos numéricos
• Formatos de hora 
• Formatos de sequência fixa

Formatos de texto de 
entrada

#
#<maxlength>
#<minlength, maxlength>

# — representa um único caractere de um tipo específico. # pode ser um dos 
seguintes tipos de caractere:

9: o conjunto de caracteres de entrada válidos inclui “0”, “1”, ..., “9”
Z: o conjunto de caracteres de entrada válidos inclui “A”, “B”, ..., “Z”
z: o conjunto de caracteres de entrada válidos inclui “a”, “b”, ..., “z”
A: o conjunto de caracteres de entrada válidos inclui todos os caracteres dos 

tipos Z e z
C: o conjunto de caracteres de entrada válidos inclui todos os caracteres dos 

tipos Z e 9
c: o conjunto de caracteres de entrada válidos inclui todos os caracteres dos 

tipos z e 9
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X: o conjunto de caracteres de entrada válidos inclui todos os caracteres dos 
tipos Z, z e 9

?: o conjunto de caracteres de entrada válidos inclui qualquer caractere

Exemplos
999999
Descrição — 6 caracteres numéricos

Exemplos de entradas válidas
123456
888888

Exemplos de entradas inválidas
ABCDEF tipo de caractere errado
1234567 longa demais
12345 curta demais

ZZZ999?
Descrição — 7 caracteres, os três primeiros são letras maiúsculas, os três 
seguintes são números e o último é qualquer caractere.

Exemplos de entradas válidas
BAT001%
BOX123a

Exemplos de entradas inválidas
BAT12b3 o sexto caractere deve ser um numeral
Bat123a o segundo e terceiro caracteres devem ser letras maiúsculas
BAT12345 longa demais
#<maxlength> — representa um valor de texto de comprimento variável sem 
comprimento mínimo, mas pode ter um comprimento máximo.

• Se maxlength for 0, não haverá limitação ao comprimento do valor de 
entrada.

• Se maxlength for maior que 0, o comprimento do valor de entrada deverá 
ser menor que ou igual a maxlength.

Maxlength não pode ser menor que 0.

Exemplos
A<6>
Descrição — sequência que pode conter 6 ou menos caracteres alfabéticos.

Exemplos de entradas válidas
A
ABCDEF

Exemplos de entradas inválidas
ABC123 os três últimos caracteres devem ser letras
ABCDEFG longa demais

?<0>
Descrição — qualquer valor de texto.

#<minlength, maxlength> — representa um valor de entrada de 
comprimento fixo ou variável, que pode ter um comprimento mínimo 
e máximo.

• Se minlength for 0, a sequência de entrada poderá ficar em branco.
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• Se minlength for maior que 0, o comprimento do valor de entrada deverá 
ser maior que ou igual a minlength.

• O minlength não pode ser menor que 0.

• Se minlength for igual a maxlength, o valor de entrada deverá ter o número 
especificado de caracteres.

Exemplos
X<2,10>
Descrição — valor de entrada contendo de 2 a 10 caracteres alfabéticos 
minúsculos ou numerais.

Exemplos de entradas válidas
Batch0001
1234abcABC
A1
Exemplos de entradas inválidas
Batch-001 “-” não é um caractere “X” válido
A curta demais
1234abcdABCD longa demais
AB Inc o espaço não é um caractere “X” válido

?<3,0>
Descrição — sequência contendo 3 ou mais caracteres de qualquer tipo.

Exemplos de entradas válidas
ABC
+%=
ABC Company
smith@ABC.com
Exemplos de entradas inválidas
A1 curta demais

A<4,4>
Descrição — sequência com exatamente 4 caracteres alfabéticos. Formato 
equivalente a AAAA.

9<0,3>
Descrição — sequência com 3 ou menos caracteres numéricos. A sequência 
pode ficar em branco. 

A<3,2>
Descrição — formato de entrada inválido, pois maxlength deve ser maior que 
ou igual a minlength, caso maxlength seja maior que 0.

Formatos de número de 
entrada

#
#(mín, máx)
#(mín, máx]
#[mín, máx}
#[mín, máx]

# — representa um dos seguintes tipos de número:

i : número inteiro positivo ou negativo, sem ponto decimal
n : qualquer número positivo ou negativo, podendo conter um ponto decimal.

A faixa de valores ou a precisão do número é limitada pelo sistema 
operacional.

A faixa de números válidos geralmente é:
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i : -2.147.483.648 a 2.147.483.647
n : 1,7 E ±308 (15 dígitos)

Os valores de mín e máx definem a faixa do valor numérico.

Os valores de mín e máx devem ser consistentes com seu tipo de número. 
Por exemplo, se o tipo de número for i, mín e máx deverão ser números 
inteiros válidos.

O caractere * pode ser usado no lugar de mín ou máx, e representa um valor 
infinito ou ilimitado.

O valor de máx deve ser maior que ou igual ao valor de mín.

( : o valor de entrada deve ser maior que mín.
) : o valor de entrada deve ser menor que máx.
[ : o valor de entrada deve ser maior que ou igual a mín.
] : o valor de entrada deve ser menor que ou igual a máx.

Exemplos

i
Descrição — qualquer número inteiro.

Exemplos de entradas válidas

123
-456

Exemplos de entradas inválidas
123.456 deve ser um valor inteiro. Valores decimais não são permitidos
-123, valores inteiros não podem ter separador decimal

n 
Descrição — qualquer número inteiro ou decimal.

Exemplos de entradas válidas
123
123,456
-123,

#(mín, máx) — especifica um valor maior que mín e menor que máx.

Exemplos
i(-100, 100)
Descrição — qualquer número inteiro maior que –100 e menor que 100.

Exemplos de entradas válidas
-99
0
99

Exemplos de entradas inválidas
-100 muito pequena; deve ser maior que –100
-99,9 deve ser um inteiro (não pode ser um decimal)
100 muito grande, deve ser menor que 100

#(mín, máx] — especifica um valor maior que mín e menor do que ou igual 
a máx.

Exemplos
i(-100, 100]
Descrição — qualquer número inteiro maior que –100 e menor que ou igual 
a 100
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Exemplos de entradas válidas
-99
0
100

Exemplos de entradas inválidas
-100 muito pequena; deve ser maior que –100
-99,9 deve ser um inteiro (não pode ser um decimal)
101 muito grande; deve ser menor que ou igual a 100

#[mín, máx) — especifica um valor maior que ou igual a mín e menor que 
máx.

Exemplos
n[-100, 100)
Descrição — qualquer número maior que ou igual a –100 e menor que 100.

Exemplos de entradas válidas
-100
-99,9
99,9999

Exemplos de entradas inválidas
-100,1 muito pequena; deve ser maior que –100
100 muito grande, deve ser menor que 100

#[mín, máx] — especifica um valor maior que ou igual a mín e menor que 
ou igual a máx.

Exemplos
n[-100, 100]
Descrição — qualquer número inteiro maior que ou igual a –100 e menor 
que ou igual a 100.

Exemplos de entradas válidas
-100
0
100

Exemplos de entradas inválidas
-100,1 muito pequena; deve ser maior que ou igual a -100
100,001 muito grande; deve ser menor que ou igual a 100

i[100, *)
Descrição — qualquer número inteiro maior que ou igual a 100

Exemplos de entradas válidas
100
1000

Exemplos de entradas inválidas
99 muito pequena; deve ser maior que ou igual a 100
100,5 valores inteiros não podem ter separador decimal

i(-1.0, +1.0)
Descrição — formato de entrada inválido, pois mín e máx não são valores 
inteiros, conforme definido pelo “i”.

n(+1,0, -1,0)
Descrição — formato de entrada inválido, pois máx é menor que mín.
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Formatos de entrada 
de hora

T<Formato_de_hora> 

formato_de_hora é uma expressão de sequência de texto do valor de data/
hora. A sintaxe pode ser um dos seguintes elementos ou uma combinação 
deles:

Os elementos de data/hora a seguir não podem ser repetidos no 
formato_de_hora. Por exemplo, se você tiver selecionado aaaa como formato 
de ano, não poderá usar aa nem outro aaaa no formato_de_hora. Essa 
limitação inclui:
aaaa e aa
dd e DDD
HH e hh
HH, TT, T, tt e t

Exemplos

T<aaaaMMdd>
Descrição — uma data completa.

Exemplos de entradas válidas
20051025
19000101

Exemplos de entradas inválidas
2005/10/25 caractere inesperado /
20051032 data inválida
20050229 data inválida (porque 2005 não foi um ano bissexto)
00990101 a data é anterior a 1000

T<MMdd>
Descrição — uma data sem ano especificado.

Exemplos de entradas válidas
1201
1231
0229 

Exemplos de entradas inválidas
0001 mês inválido

aaaa ano (1000-9999)
aa ano (00-99, 00-79 significa 2000-2079, 80-99 significa 1980-1999)
MM mês (01-12)
dd dia do mês (00-31, validar data quando ano e mês estão disponíveis)
DDD dia do ano (001-366, validar data quando ano e mês estão disponíveis)
HH hora (00-23)
hh hora (01-12)
mm minuto (00-59)
ss segundo (00-59)
TT AM/PM
T A/P
tt am/pm
t a/p
“texto” texto é uma sequência de texto fixa.
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0230 dia inválido de fevereiro, seja o ano bissexto ou não
ABCDEF texto inválido

T<HH“:”mm“:”ss>
Descrição — uma hora com separador : (dois-pontos). 

Exemplos de entradas válidas
23:59:59
00:00:00

Exemplos de entradas inválidas
99:59:00 hora inválida
120000 sem separador

T<hhmmsst>
Descrição — uma hora completa.

Exemplos de entradas válidas
010000a
120000p

Exemplos de entradas inválidas
010000A o A deve estar em letra minúscula
000000a hora inválida
1355101 a hora inválida deve ser 00-12 

T<HHmmssTT>
Descrição — este é um formato de entrada inválido porque HH representa 
00 a 23 horas e TT representa AM/PM, o que não é válido em uma sequência 
de hora no formato de 24 horas.

T<aaaaMMaaaa>
Descrição — este é um formato de entrada inválido para aaaa, que foi usado 
mais de uma vez em um formato_de_hora.

Formatos de entrada de 
sequência fixa

“texto”
Texto é qualquer sequência de texto fixa. Como o início e o fim da sequência 
de texto são definidos pelo caractere “ (aspa dupla), esse caractere não 
é permitido na sequência de texto. Geralmente se usa um formato de 
sequência de texto combinado com outros formatos de entrada.

Exemplos

999”-”99”-”999
Descrição — sequência fixa (para definir um número de previdência social dos 
EUA). 

“ID”
Descrição — sequência fixa.

Exemplos de entradas válidas
ID

Exemplos de entradas inválidas
XX não corresponde a texto no formato. A entrada deve ser: ID

“Texto”ABC””
Descrição — formato de entrada inválido, porque inclui dois caracteres “ a 
mais.
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Formatos de entrada 
combinados

Um formato de entrada pode consistir em vários formatos combinados. 
Para usar vários formatos para definir um formato de entrada, conecte 
as expressões de formato com ou sem um espaço em branco.

Nenhuma expressão de formato poderá vir em seguida de um formato de 
comprimento variável. Por exemplo: A<1,0>”-Comentário” não é válida porque 
A<1,0> pode ter qualquer comprimento. O formato: “Comentário-“A<1,0> 
é válido porque o formato de comprimento variável está no fim do formato de 
entrada combinado.

Veja a seguir formatos combinados válidos e inválidos.

Exemplos

“ID”999999
Descrição — formatos combinados: “ID” e 999999.

Exemplos de entradas válidas
ID123456

Exemplos de entradas inválidas
IDabcdef as letras abcdef devem ser números

id123456 as duas primeiras letras, id, não correspondem ao formato, 
que é ID

“DATE”T<yyyyMMdd>
Descrição — formatos combinados “DATE” e T<yyyyMMdd>.

T<“DATE”yyyyMMdd> é equivalente ao formato acima.

Exemplo de entrada válida

DATE20051025

Exemplos de entradas inválidas
n?<0>
Descrição — formato de entrada inválido para o número especificado. n é um 
comprimento variável e nenhum formato adicional pode vir em seguida.

A<2,3>”XX”
Descrição — formato de entrada inválido, pois A<2,3> especifica um 
comprimento variável e nenhum formato adicional pode vir em seguida.

A<3,3>”XX”
Descrição — formatos combinados: A<3,3> e “XX”.

Exemplo de entrada válida

XYZXX

Exemplos de entradas inválidas
XXXXXX X inesperado no fim da sequência de texto.

20051025 o texto DATE deve vir antes da data

DATE20051032 outubro não possui 32 dias

XXXXXXX muito extensa, um X a mais no fim da sequência
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Especificação de 
valor padrão de 
índice

A expressão de valor padrão é uma expressão de texto para definir o valor 
padrão de um determinado campo de índice. Na expressão de valor padrão, 
é necessário definir o valor padrão usando um ou mais códigos predefinidos 
(isto é, sistema, valor do código de barras/OCR/detecção de marcas) ou uma 
sequência fixa. Também é possível definir várias opções do valor padrão 
conectando códigos à palavra-chave OR. 

Marcas
<tagname>
<tagname:transformexpression> 

tagname é uma expressão de dados de OCR, detecção de marcas ou da 
zona do código de barras predefinida do sistema. As expressões de dados do 
sistema incluem data, hora, ID e nome da estação, nome do usuário 
e trabalho, caminho da estação de trabalho e lote, ID de documento e página 
e último valor.

transformexpression é usada para converter o formato do valor do sistema 
ou do código de barras/OCR. Por exemplo, a data é expressa como MMddaa, 
e a expressão de conversão pode alterar o formato para MM/dd/aaaa. 
Consulte a próxima seção para obter uma descrição da expressão de 
conversão.
Marque Entrada dupla (Double Entry) para permitir uma entrada de dados 
adicional no campo de índice. Para mais informações, consulte “Entrada dupla 
de dados”, mais adiante neste capítulo. Um valor padrão pode não ser 
inserido ao usar a Entrada dupla de dados (Double Data Entry); o Tipo de 
campo (Field Type) pode ser Valor único e o campo não pode ser Somente 
leitura (Read only) ou Oculto (Hidden).

OBSERVAÇÕES:

• O Tipo (Type) deverá ser um Valor único (Single Value).
• O campo de índice não pode ser somente leitura, portanto, Somente leitura 

(Read-only) fica desativado.
• O campo de índice não pode estar oculto, portanto, Oculto (Hidden) fica 

desativado.
• O valor padrão deve ficar vazio, portanto, Configurar valor padrão (Default 

Value Setup) fica desativado.
• Se alguma das configurações acima não estiver correta, a caixa de seleção 

Entrada dupla (Double Entry) será desmarcada e desativada.

Formatos de sequência 
fixa

“texto”
texto é uma sequência de texto fixa. O caractere delimitador de sequência “ 
(aspa dupla) não é permitido no formato. Geralmente se usa um formato de 
sequência de texto fixa combinado com outros formatos. 

Uso de várias marcas Um valor padrão pode incluir mais de uma expressão de marca, usadas em 
combinação. Por exemplo, talvez você queira que o valor padrão inclua 
a data, a hora e a ID da estação, separados por hífen. Para fazer isso, 
é preciso concatená-los.

Por exemplo:
<sys.date:ddMMaa>“-”<sys.time:hhmmss> “-” <sys.stationid>
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Uso da palavra-chave OR A palavra-chave OR também pode ser incluída na expressão do valor padrão. 
Isso pode ser útil quando a presença de um valor nem sempre é possível. 
Pode ser interessante definir o valor padrão com o valor de um código de 
barras que aparece no documento.

Por exemplo:
 <barcode.UPI ID Number>

Se não for encontrado nenhum código de barras no documento, o campo de 
índice ficará vazio. A palavra chave OR pode ser usada para fornecer um 
valor alternativo.

Por exemplo:
<barcode.UPI ID Number> OR “Código de barras não encontrado no 
documento:” <app.documentid>

É possível introduzir quantas expressões forem necessárias, usando OR para 
cada uma delas 

Opção de valor padrão #1 OR Opção de valor padrão #2 OR ... OR Opção de 
valor padrão #n

O sistema verificará a Opção de valor padrão # uma por uma da esquerda 
para a direita, e usará os primeiros dados válidos para inicializar os dados de 
índice.
Marcas disponíveis — a tela a seguir exibe as marcas de valor padrão 
disponíveis:

OBSERVAÇÃO: as zonas de código de barras/OCR/detecção de marcas 
serão exibidas no fim da lista de valores padrão.

Valor padrão usando 
LASTVALUE

Com lastvalue selecionado como valor padrão, o Capture Pro Software 
automaticamente utiliza o último valor atribuído a um campo de índice do 
documento anterior (no caso de índices de documentos) ou lote anterior 
(no caso de índices de lotes) sempre que um novo documento ou lote 
é criado. Isso é útil, por exemplo, em uma aplicação de registro de atrasos, 
em que você digitaliza pastas de documentos com a mesma data. Quando 
você começar a digitalizar para um lote novo, quando ainda não houver 
nenhum valor de índice atribuído, insira a data uma vez e ela permanecerá 
a mesma para todos os novos documentos posteriores, até que você a altere. 
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lastvalue também é muito útil para fazer indexação de código de barras, mas 
nem todos os documentos digitalizados terão um código de barras anexado. 
Por exemplo, a expressão de valor padrão:

<barcode.Patient ID> OU <app.lastvalue>

significa que, quando um novo documento é digitalizado, o valor do campo de 
índice é atribuído ao valor de “ID do paciente” da zona de código de barras 
<barcode.Patient ID>. Entretanto, se o documento não tiver um código de 
barras anexado, atribua o campo de índice ao valor do documento anterior 
OR <app.lastvalue>.

Expressões de 
conversão

Uma expressão de conversão é uma expressão de texto que formata ou 
converte os dados de um campo específico em um padrão ou valor de saída. 
Expressões de conversão são usadas para definir valores padrão e o formato 
de saída de um campo de índice. 

Especificação do valor padrão: quando um novo lote ou documento 
é criado, o campo de índice é preenchido com um valor baseado na 
especificação do valor padrão. A especificação do valor padrão é inserida na 
guia Índice (Index) e assume o formato <tagname> ou <tagname:transform 
expression>. A expressão de conversão é descrita abaixo.

Exemplos: 
<sys.date:ddMMaa>
<sys.stationid:[1,5]>

Formato de saída: quando há saída de um lote, os dados de índice do 
lote e de cada documento contido nele serão reformatados de acordo com 
o formato de saída. Por exemplo, um índice de data com valor MMddaa pode 
ser reformatado como: 
MM/dd/aaaa.

O formato de saída é inserido na guia Índice e assume o formato: 
expressão de conversão.

Exemplos:
ddMMaa
[1, 5]

A sintaxe pode ser um dos seguintes formatos ou uma combinação deles:

• Formatos de texto
• Formatos numéricos
• Formatos de hora
• Formatos de sequência fixa

Formatos de conversão 
de texto

[início]
[início, fim]
[índice, ‘delimitador’]
[início; ext]

Esses formatos são usados para extrair uma sequência secundária do valor 
de índice original.

[início] — extrai uma sequência secundária desde a posição de início até 
o fim do valor original.

• Se o início for um número positivo, a posição de início será contada a partir 
do começo do valor original.



A-61993_pt-br  Março de 2022 57

• Se o início for um número negativo, a posição de início será contada a partir 
do fim do valor original.

• Se o início for 0 ou *, a posição de início será o começo do valor original.

Exemplos
[5]
Descrição — obtém a sequência secundária desde o 5o caractere até o fim do 
valor original.

“ABCDEFGHIJKL”  “EFGHIJKL”

“1234567890”  “567890”

“1234”  “”

[*]
Descrição — obtém a sequência inteira.

“ABCEDFG”  “ABCDEFG”

“1234567”  “1234567”

[início, fim] — extrai uma sequência secundária do valor original, desde 
a posição de início até a posição de fim.

• Se o fim for um número positivo, a posição de fim será contada a partir do 
início do valor original.

• Se o fim for um número negativo, a posição de fim será contada a partir do 
fim do valor original.

• Se o fim for 0 ou *, a posição de fim será o final do valor original.

• Se a posição de início vier após a posição de fim, a sequência secundária 
terá ordem inversa ao valor original.

Exemplos
[1, 2]
Descrição — obtém a sequência secundária desde o 1o caractere até o 2o 
caractere do valor original.

“ABCDEFG”  “AB”

“123456”  “12”

[-4, -1]
Descrição — obtém a sequência secundária desde o 4o caractere até o último 
caractere do valor original.

“ABCDEFGHIJK”  “HIJK”

“1234567890”  “7890”

[*, 5]
Descrição — obtém a sequência secundária desde o 1o caractere até o 5o 
caractere do valor original.

“ABCDEFGHIJK”  “ABCDE”

[5,2]
Descrição — obtém a sequência secundária em ordem inversa, desde o 5o 
caractere até o 2o caractere do valor original.

“ABCDEFGHIJK”  “EDCB”

“1234567890”  “5432”
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[2, -2]
Descrição — obtém a sequência secundária desde o 2o caractere até o 2o 
caractere de trás para frente do valor original.

“ABCDEFGHIJ”  “BCDEFGHI”

“1234567890”  “23456789”

“AB”  “BA”

“A”  “A”

[índice, ‘delimitador’] — extrai o elemento na posição especificada por 
índice, onde cada elemento dos dados de índice é separado pelo caractere 
delimitador. O primeiro elemento é índice 1.

OBSERVAÇÃO: essa expressão de conversão é útil especialmente ao 
atribuir elementos de dados de um código de barras 
PDF417 a diferentes campos de índice. Sua utilidade 
também se verifica ao atribuir diferentes linhas de 
resultados de OCR de várias linhas a diferentes campos de 
índice. O delimitador produzido pelo OCR de várias linhas 
é o caractere circunflexo (^).

Exemplos
[2, ‘^’]
Descrição — obtém o 2o elemento do OCR de várias linhas, em que os 
elementos são separados pelo caractere “^”.

“John Smith^123 Main Street^Some City”  “123 Main Street”

[3, ‘*’]
Descrição — obtém o 3o elemento do código de barras PDF417, em que os 
elementos são separados pelo caractere “*”.

“John Smith*123 Main Street*Some City”  “Some City”

[início; ext] — extrai uma sequência secundária a partir da posição de início, 
contendo o número de caracteres em ext.

Exemplos
[2;3]
Descrição — obtém a sequência secundária a partir do 2o caractere, com 
extensão de 3 caracteres.

“ABCDEFGHIJ”  “BCD”

“1234567890”  “234”

“AB”  “B”

“A”  “”

Formatos de conversão 
numéricos

#<largura, largura_frac>
#<largura, largura_frac, preenchimento>
#<formatos_texto, largura, largura_frac>
#<formatos_texto, largura, largura_frac, preenchimento>
0width

# pode ser um dos caracteres a seguir para definir o tipo de número desejado.
n: número genérico
N: número genérico com sinal
p: número percentual
P: número percentual com sinal
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c: número monetário
C: número monetário com sinal

A faixa de valores ou a precisão do número é limitada pelo sistema 
operacional. A faixa de números válidos é 1,7E ±308 (15 dígitos).

#<largura, largura_frac> — formata um número que tem, no máximo, 
o número de caracteres largura e, no máximo, o número de caracteres 
largura_frac após o separador decimal.

largura define o número total de dígitos a serem incluídos na sequência de 
saída.

• Se a largura for um número positivo, o texto de saída será alinhado 
à direita, com o caractere de preenchimento (se houver) à esquerda.

• Se a largura for um número negativo, o texto de saída será alinhado 
à esquerda, com o caractere de preenchimento (se houver) à direita.

A largura_frac define o número de dígitos a ser exibido à direita do ponto 
decimal.

O número 0 é usado para indicar que não há separadores decimais.

O caractere * é usado para mostrar um padrão de 6 dígitos à direita do 
separador decimal.

Exemplos
n<20,2>
Descrição — um número genérico com largura máxima de 20 caracteres 
e 2 dígitos após o separador decimal. A sequência será alinhada à direita.

Exemplos
 “324.5”  “ 324.50”
“abcd”  “ 0.00”

p<-20, 2>
Descrição — um número expresso em porcentagem, com largura total de 
20 caracteres e dois dígitos após o separador decimal. A sequência será 
alinhada à esquerda.

Exemplos
 “0.12abc”  “12.00% “
“-43” ”-4300.00% “

c<20, 0>
Descrição — um número expresso em moeda, com largura total de 20 
caracteres e nenhum separador decimal. A sequência será alinhada à direita.

Exemplos
 “12345.6”  “ 12.346”
“-12345.6”  “ -12.346”

C<20, 2>
Descrição — um número expresso em moeda com sinal, com um total de 
20 caracteres e dois dígitos após o separador decimal. A sequência será 
alinhada à direita.

Exemplos
 “12345.6”  “ +12.345,60”
“-12345.6”  “ -12.345,60”
“abc”  “ +0.00”
“-0.001”  “ -0.00”
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“-0.00”  “ +0.00”

#<largura, largura_frac, preenchimento> — formata um número que será 
preenchido com o caractere de preenchimento até a largura especificada, 
incluindo o número de caracteres em largura_frac após o separador decimal. 

O preenchimento define o caractere para preencher o espaço, caso o texto 
formatado seja menor que a largura definida.

Exemplo
P<20, 3, ‘#’>
Descrição — um número expresso em porcentagem com sinal, com largura 
total de 20 caracteres, três dígitos após o separador decimal e preenchido 
com o caractere “#”.

Exemplos
 “0.12abc”  “############+12.0000%”
“-43”  “##########-4300.000%”

#<formatos_texto, largura, largura_frac> — formata um número extraído de 
uma sequência que usa formatos_texto.

formatos_texto especifica como extrair o número da sequência de índice 
original. Consulte a seção Formatos de saída.

Exemplo
N<[2], 20, 3>
Descrição — um número com sinal, com largura total de 20 caracteres e três 
dígitos após o separador decimal. O número será extraído a partir do 2o 
caractere da sequência original.

Exemplos
“A12345.6”  ” +12345.600”
“-12345.6”  “ +12345.600”
“TT9000”  “ +0.000”
“ — 9999”  “ –9999.000”

N<[2, ‘^’], 20, 3>
Descrição — um número com sinal, com um total de 20 caracteres e três 
dígitos após o separador decimal. O número será extraído a partir dos 
2 elementos da sequência, na qual os elementos são separados pelo 
caractere “^”.

Exemplo
“12345.6^45678.9”  “ +45678.900”

#<formatos_texto, largura, largura_frac, preenchimento> — formata um 
número extraído de uma sequência que usa formatos_texto e preenchimento 
com o caractere especificado.

Esse formato é uma extensão do formato #<formatos_texto, largura, 
largura_frac>, no qual a sequência de saída será preenchida com o caractere 
especificado.

0largura — usado para preencher um número com zeros até a largura 
mínima especificada.

Exemplos
 010 
Descrição — número preenchido com zeros com largura total de 10 
caracteres.
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Exemplos

“123”  “0000000123”
“0”  “0000000000”

03
Descrição — número preenchido com zeros com largura total de 3 caracteres.

Exemplo
“1”  “001”
“1234”  “1234”

Formatos de conversão 
de hora

#

# — pode ser um dos formatos a seguir ou qualquer combinação deles:

Ao usar formatos de hora, você deve especificar um formato de entrada de 
hora para definir o conteúdo da sequência a ser formatada para saída.

Exemplos
ddMMaaaa
Descrição — uma data no formato dia, mês e ano.

Exemplos
Formato de entrada: T<aaaaMMdd> para a sequência “20051026”  
“26102005”
Formato de entrada: T<aaaaMM> para a sequência “102005”  “102005”

aaaa ano (1900-2099)
aa ano (00-99)
a ano
MM mês (01-12)
M mês (1-12)
dd dia do mês (01-31)
d dia do mês (1-31)
D dia da semana (1: domingo, 2: Segunda-feira etc.)
DDD dia do ano (001-365)
HH hora (00-23)
H hora (0-23)
hh hora (01-12)
h hora (1-12)
mm minuto (00-59)
m minuto (0-59)
ss segundo (00-59)
s segundo (0-59)
TT AM/PM
T A/P
tt am/pm
t a/p
ww semana do ano (01-53)
w semana do ano (1-53)
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Formatos de sequência 
fixa

texto”

Texto é qualquer sequência de texto fixa. Como o início e o fim da sequência 
de texto são definidos pelo caractere “ (aspa dupla), esse caractere não 
é permitido na sequência de texto. Geralmente se usa um formato de 
sequência de texto combinado com outros formatos de entrada.

Exemplos
“ID-“[*]”-XX”
Descrição — sequência de texto fixa de saída de “ID”.

Exemplos 
“20051026” ==> “ID-20051026-XX”

Combinando formatos 
de conversão

Uma expressão de conversão pode ser composta por vários formatos 
combinados. Para usar vários formatos para definir uma expressão de 
conversão, basta conectar as expressões de formato com ou sem um espaço 
em branco.

Exemplos
“Receita”c<20, 2>
Descrição — combinação dos formatos “Receita” e c<20, 2>.

Exemplos
“123456” ==> “Receita 123.456,00”

aaaa“/”MM“/”dd“-”HH“:”mm“:”ss
Descrição — combinada com formatos: aaaa, “/”, MM, “/”, dd, “-”, HH, “:”, mm, 
“:” e ss.

Exemplos
“20051026080405PM” ==> “2005/10/26-20:04:05”
Formato de entrada: T<aaaaMMddhhmmssTT>

Formatos de saída Um formato de saída é uma expressão de texto que formata os dados de 
um campo de índice específico em um valor de saída. As expressões de 
conversão são usadas para definir o formato de saída de um campo de índice. 

Formato de saída: quando há saída de um lote, os dados de índice do 
lote e de cada documento contido nele serão reformatados de acordo com 
o formato de saída. Por exemplo, um índice de data com valor MMddaa pode 
ser reformatado como: MM/dd/aaaa.

A sintaxe pode ser um dos seguintes formatos ou uma combinação deles:

• Formatos de texto — consulte Expressão de conversão, Formatos de 
texto

• Formatos de número — consulte Expressão de conversão, Formatos de 
número

• Formatos de hora — consulte Expressão de conversão, Formatos de hora

• Formatos de sequência fixa — consulte Expressão de conversão, 
Formatos de sequência fixa

• Formatos combinados — consulte Expressão de conversão, Combinando 
formatos de conversão
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Guia índice — 
Pesquisa de banco 
de dados (Database 
Lookup)

A Pesquisa de banco de dados pode ser usada para preencher ou validar os 
campos de índice de documentos e lotes de fontes de dados compatíveis com 
ODBC (Open Database Connectivity). Um assistente de configuração é usado 
para especificar a fonte de dados, definir como a pesquisa será feita e quais 
dados serão usados para preencher os campos de índice ou validar seu 
conteúdo. A configuração de trabalho pode conter mais de uma Pesquisa 
(Lookup). Cada pesquisa pode ser em uma fonte de dados diferente e usada 
para preencher ou validar campos de índices selecionados. As pesquisas 
podem ocorrer durante a digitalização quando o valor de índice usado para 
a pesquisa foi obtido por um leitor de código de barras ou uma ação de OCR. 
Cada pesquisa ganha a forma: SELECIONE <coluna de tabela 1>, <coluna de 
tabela 2>, ... <coluna de tabela n> DE <fonte de dados> ONDE <coluna de 
tabela x> = <valor de campo de índice> ou selecione: ONDE <coluna de 
tabela x> = <valor de campo de índice> E <coluna de tabela y> = <valor de 
campo de índice>.

Configuração da 
pesquisa de banco de 
dados

Configurar pesquisa de banco de dados começa com a definição dos campos 
de índice de lotes e documentos que serão usados pela pesquisa. 
As pesquisas de banco de dados são configuradas para cada trabalho.

OBSERVAÇÃO: definir os campos de índice na Configuração do trabalho 
(Job Setup) não mudou desde as versões anteriores do 
Capture Pro Software.

Para adicionar ou editar uma nova pesquisa:

1. Clique em Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name). As definições para a configuração do trabalho serão 
exibidas.

3. Selecione a guia Índice (Index).

4. Selecione a guia Pesquisa de banco de dados (Database Lookup). 
A tabela Pesquisas (Lookups) será exibida com os seguintes campos: 
Nome (Name), Campo de índice de entrada (Input Index Field), Campo de 
índice de saída (Lote) (Output Index Field (Batch)) e Campo de índice de 
saída (Documento) (Output Index Field (Document)) para cada Pesquisa. 
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5. Clique em Adicionar (Add). O Assistente de pesquisa de banco de dados 
(Database Lookup Wizard) será exibido.

6. Digite o nome da pesquisa no campo Nome da pesquisa (Lookup name).

7. Clique em Procurar (Browse) para abrir a caixa de diálogo Selecionar 
fonte de dados (Select Data Source).

• Selecione uma Fonte de dados de arquivo (File Data Source) ou Fonte 
de dados do equipamento (Machine Data Source), ou clique em Novo 
(New) para criar uma nova fonte de dados. Dependendo do tipo de 
fonte de dados selecionada, informações adicionais serão solicitadas. 

• Clique em OK depois de ter digitado todas as informações necessárias.

• Após clicar em OK, a janela de Login no servidor SQL (SQL Server 
Login) é mostrada. Insira todas as credenciais e clique em OK.

8. Selecione a tabela ou o arquivo da lista suspensa Tabela do banco de 
dados (Database table) que contém os dados que serão usados para 
preencher ou validar os campos de índice.
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9. Clique em Avançar para definir como deseja fazer a pesquisa de dados. 

• Selecione Validar campos de índice nos resultados da pesquisa 
(Validate index fields from Lookup results) se quiser verificar se um ou 
mais valores de campo de índice correspondem aos dados de sua fonte 
de dados. Marque Criar um índice de documento para armazenar 
o resultado de validação (Create a document index to store the 
validation result) se você quiser armazenar os resultados da pesquisa 
em um campo de índice a ser usado para outro processamento, como 
Classificar por índice de documento.

• Selecione Preencher campos de índice a partir dos resultados da 
pesquisa (Populate index fields from Lookup results) se quiser 
preencher um ou mais campos de índice com dados da pesquisa.

10. Selecione os campos de índice a serem utilizados pela Pesquisa para 
localizar valores correspondentes no campo do banco de dados 
selecionado na lista suspensa do Campo de índice pesquisa (Lookup 
index field). Essa lista contém todos os campos de documentos e índices 
de lote definidos. Se um campo único índice for usado para a Pesquisa, 
ele deverá ficar na coluna à esquerda antes de “E”. Se dois Campos de 
índice de pesquisa forem fornecidos, somente os registros do banco de 
dados que contêm esses valores serão correspondidos. No momento da 
entrada dos dados do índice, se um valor não for conhecido, pode ser 
substituído por um asterisco (*). Para obter mais informações, consulte 
a seção “Uso da pesquisa de banco de dados” mais adiante neste 
capítulo. 

11. Selecione as colunas da tabela a serem pesquisadas para os valores 
correspondentes ao Campo de pesquisa selecionado na lista suspensa 
Coluna da tabela de pesquisa (Lookup table column). Essa lista contém 
todos os nomes de colunas da tabela de banco de dados selecionada.

12. Para cada campo do índice lote ou documento, que você deseja 
preencher ou validar, selecione a coluna do banco de dados que contém 
o banco de dados desejado. Clique na coluna à direita do nome do campo 
de índice e selecione a coluna do banco de dados na lista suspensa.
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13. Clique em Avançar para escolher as opções de pesquisa do banco 
de dados.

14. Selecione as opções de pesquisa desejadas:

• Desativar pesquisa (Disable Lookup): quando marcada, as pesquisas 
não serão realizadas durante a digitalização. Isso pode aprimorar 
o desempenho com bancos de dados grandes ou remotos. 
As pesquisas continuarão ocorrendo no modo Editar índice (Edit Index) 
e quando o lote for impresso.

• Exibir resultados de pesquisa múltipla se houver mais de um 
resultado (Display multiple lookup results if there is more than one 
result): quando desmarcada, a tabela Resultados de pesquisa múltipla 
(Multiple Lookup Results) não será exibida durante a digitalização. 
Os vários resultados de pesquisa serão resolvidos no modo Editar 
índice (Edit Index), permitindo que a digitalização continue sem 
interrupções.

• A Pesquisa substituirá o valor do índice existente (Lookup will 
overwrite existing index value): quando marcada, a Pesquisa sempre 
preencherá o campo de índice com o valor de pesquisa no banco de 
dados, desde que o banco de dados tenha o valor de entrada (ou seja, 
se não for vazio ou nulo). Se você quiser que os usuários possam 
inserir manualmente os dados em um campo de índice que a Pesquisa 
de banco de dados está preenchendo, esta opção deverá ser 
desmarcada.

OBSERVAÇÃO: a pesquisa de banco de dados nunca sobrescreverá 
dados depois da saída do lote. 

• Desativar Pesquisa durante impressão (Disable Lookup during 
Output): quando marcada, nenhuma Pesquisa (preencher ou validar) 
ocorrerá durante a impressão. Se estiver desmarcada, os campos em 
branco serão preenchidos e os registros ausentes ou múltiplos serão 
ignorados. Haverá falha na validação se nenhum registro 
correspondente for encontrado.

• Máximo de resultados múltiplos a serem exibidos (Maximum 
multiple results to display): quando vários resultados de pesquisa são 
encontrados, uma tabela com os resultados é exibida permitindo que 
você escolha o resultado correto. O valor inserido limita o comprimento 
da tabela.
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15. Clique em Avançar para testar a pesquisa.

16. Clique em Testar consulta (Test Query). A caixa de diálogo Testar 
(Test Query) consulta será exibida.

17. Digite um valor válido para o parâmetro usado para realizar a pesquisa. 
Se você deixar o valor em branco, os primeiros 25 registros na tabela de 
dados serão exibidos.

18. Clique em OK.

Uso da pesquisa de 
banco de dados

Depois de configurar um trabalho para fazer uma Pesquisa de banco de 
dados, é importante compreender quando a pesquisa será realizada. 
Os seguintes cenários são os mais comuns:

Durante a digitalização - 
preenchendo campos de 
índice

Quando a opção Desativar pesquisa (Disable Lookup) durante a captura 
não estiver marcada, as pesquisas ocorrerão imediatamente durante 
a digitalização.

A pesquisa só será realizada quando o campo de índice que está sendo 
usado para a pesquisa possuir um valor que for preenchido durante 
a digitalização (por exemplo, como resultado de uma leitura de zona de 
detecção de código de barras, OCR ou marca).
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Durante a digitalização - 
validando campos de índice

Quando a opção Desativar pesquisa (Disable Lookup) durante a captura não 
estiver marcada, as pesquisas configuradas apenas para validação do campo 
de índice também ocorrerão imediatamente durante a digitalização.

A Validação da pesquisa só será realizada quando o campo de índice que 
está sendo validado possuir um valor preenchido durante a digitalização 
(por exemplo, como resultado de uma leitura de zona de detecção de código 
de barras, OCR ou marca).

OBSERVAÇÃO: quando a opção Desativar pesquisa (Disable Lookup) não 
estiver desmarcada, as pesquisas de banco de dados 
sempre serão realizadas durante a digitalização. Mesmo se 
a opção de configuração de campo de índice Marcar campo 
durante a digitalização (Check field during scanning) estiver 
desativada, a validação da pesquisa de banco de dados 
ainda será realizada.

Modo Editar índice Depois que a digitalização tiver sido realizada e o usuário entrar no modo 
Índice (Índice > Editar campos de índice (Index>Edit Index Fields)), 
a pesquisa será sempre realizada em um documento quando este for 
acessado no modo Indexação.

Se o campo de índice que está sendo usado para a pesquisa já possuir um 
valor (por exemplo, como resultado de uma leitura de zona de detecção de 
código de barras, OCR ou marca), a pesquisa de um documento será 
realizada automaticamente ao navegar até ele.

Se os dados estiverem sendo digitados manualmente no campo de índice, 
a pesquisa será realizada quando o usuário deixar o campo de índice. 
Se a tecla Tab for usada para sair do campo de índice que acabou de ser 
digitado, os resultados do preenchimento de outros campos de índice serão 
exibidos para verificação. Se a tecla Enter ou uma das teclas de função do 
modo Indexação (por exemplo, F9, F10, F11) for usada para navegar para 
outro documento, a pesquisa será realizada e outros campos de índice serão 
preenchidos. Entretanto, você não verá os resultados da pesquisa, pois esse 
documento não estará mais sendo exibido no modo Indexação.

Se o campo de índice Pesquisa (Lookup index field) for preenchido usando 
“Arrastar e soltar o OCR” ou clicando no OCR, a Pesquisa será realizada 
imediatamente e os resultados do preenchimento dos outros campos de 
índice serão exibidos para verificação.

Se o valor que está sendo usado para a pesquisa for somente parcialmente 
conhecido, o asterisco “*” pode ser usado para substituir os caracteres 
desconhecidos. O asterisco deve ser o último caractere. Por exemplo, se 
o valor da pesquisa for um número de telefone mas se somente os primeiros 
quatro dígitos puderem ser lidos, o valor “557-3*” pode ser digitado. Todos os 
números de telefone que começam com “557-3xx....” serão obtidos do banco 
de dados e você pode selecionar o valor correto.



A-61993_pt-br  Março de 2022 69

Quando uma pesquisa é baseada em dois valores e somente um valor 
é conhecido, o asterisco pode ser usado no lugar do valor desconhecido. 
Por exemplo, a pesquisa é baseada no Sobrenome E Nome e o endereço 
será pesquisado. Se somente for conhecido o sobrenome, ele é digitado no 
campo do índice “Sobrenome” (Last Name) e um asterisco é digitado no 
campo do índice “Nome” (First Name). Se somente for encontrado um registro 
para o sobrenome digitado, o nome e o endereço serão preenchidos. 
Se forem encontrados vários registros para o sobrenome, a caixa de diálogo 
Múltiplos resultados (Multiple Results) será exibida e a entrada correta pode 
ser escolhida. 

Saída do lote A pesquisa de banco de dados apenas ocorrerá na saída se a opção 
Desativar pesquisa durante a saída (Disable Lookup on Output) estiver 
desmarcada. Quando você clica na ferramenta Saída (Output), como parte 
da validação do campo de índice, a pesquisa de banco de dados para 
preenchimento e validação de campos de índice é realizada imediatamente, 
antes que o lote seja colocado em fila para processamento de saída. Se uma 
pesquisa de banco de dados estiver preenchendo campos de índice, os erros 
serão ignorados. Se nenhum registro for encontrado ou se forem encontrados 
vários registros, o valor atual do campo de índice ficará inalterado ou em 
branco. Se uma pesquisa de banco de dados estiver validando campos de 
índice, ocorrerão erros se nenhum registro correspondente for encontrado. 
O lote não será enviado para saída e o erro deverá ser corrigido antes que 
o lote tenha a saída realizada com sucesso.

Se um lote tiver a saída realizada na tela Gerenciador de lotes (Batch 
Manager) ou se a saída for automaticamente realizada na Configuração do 
trabalho (Job Setup), a pesquisa de banco de dados será realizada 
imediatamente como parte do processamento de lote em segundo plano. 
Se a pesquisa falhar, o lote receberá o status de Erro de índice (Index Error).

Quando o lote for aberto para corrigir o erro, o documento cuja pesquisa 
falhou será exibido automaticamente e você poderá entrar no modo Índice 
para corrigir o problema de indexação e reenviar o lote para processamento 
de saída.
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Configuração de 
trabalho: guia Saída 
(Output)

A guia Saída (Output) é onde você configura as opções de saída de sua 
configuração de trabalho.

• Destino (Destination) — permite configurar o formato da saída, o local 
para onde enviar a saída e como indexá-la. As opções de Destino 
(Destination) são:

- Credenciais (Credentials): permite que você forneça credenciais de 
acesso do usuário para compartilhamentos de arquivos da rede de 
destino.

- Arquivo (1) (File (1)) e Arquivo (2) (File (2)): permite selecionar um 
formato de arquivo (TIFF, JPEG, PDF, PNG etc.) e inserir a saída 
(por exemplo: em preto-e-branco, colorido/tons de cinza).

- Sistema (1) (System (1)) e Sistema (2) (System (2)): permite que você 
selecione o Destino de saída do sistema (System Output Destination) 
para sua configuração de trabalho.

- E-mail: permite configurar o software para enviar a saída por e-mail 
automaticamente. 

- Imprimir (Print): permite configurar o software para imprimir a saída 
automaticamente.

• Opções avançadas (Advanced Options) — permitem aplicar à saída as 
opções de processamento de imagens do Capture Pro Software. 

• Chamar outro programa (Invoke Other Program) — permite usar outro 
aplicativo de software em sua saída. 

Credenciais Selecione Credenciais (Credentials) quando o local de saída de destino for 
um compartilhamento de rede para a qual o operador do Capture Pro pode 
não ter acesso. 
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• Adicionar (Add) — exibe a caixa de diálogo Configuração das credenciais 
(Credentials Setup). 

• Digite o nome do servidor e de compartilhamento no formato 
\\nome_servidor\nome_compartilhamento. O nome do servidor ou 
o endereço IP do servidor pode ser digitado.

• Remover (Remove) — remove as credenciais selecionadas.

• Propriedades (Properties) — exibe as propriedades das credenciais 
selecionadas. O nome do usuário e a senha podem ser alterados.

As credenciais não são compartilhadas entre configurações de trabalhos. 
Se duas configurações de trabalhos usarem o mesmo compartilhamento de 
rede, as credenciais precisam ser adicionadas para ambas as configurações 
dos trabalhos. Isso permite que diferentes configurações do trabalho acessem 
o mesmo compartilhamento de rede usando credenciais diferentes.

As credenciais serão sempre usadas mesmo se o usuário atual tiver acesso 
ao compartilhamento de rede.

As credenciais podem ser usadas saída de Arquivo (1) (File (1)), Arquivo (2) 
(File (2)), Sistema (1) (System (1)) e Sistema (2) (System (2)). O uso de 
credenciais é especialmente útil aquando do uso da Edição Capture Pro 
Network opcional - Servidor de saída remota. Por que o serviço de Saída 
remota não tem nenhum usuário, as credenciais são usadas para fornecer 
acesso a compartilhamentos externos.

Opções de destino: 
Arquivo (1) (File (1)) 
e Arquivo (2) (File (2)) 

Opção Arquivo (1) (File (1)) — selecione um formato de arquivo (TIFF, PDF, 
JPEG, PNG etc.) para a saída. Suas opções de formato dependem do tipo da 
saída:
• Tudo (All) (em preto e branco e em cores/escala de cinza)
• Preto e branco (Black and white)
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• Cor/escala de cinza (Color/grayscale) — quando esta opção 
é selecionada, uma opção de filtro pode ser escolhida para produzir apenas 
imagens coloridas ou em escala de cinza.

OBSERVAÇÃO: para obter uma descrição das caixas de diálogo de formato 
de arquivo, consulte a seção “Opções de configuração de 
Arquivo (1) e Arquivo (2)” neste capítulo. 

• Local (Location) — mostra o local da saída do Arquivo (1) (File (1)). Para 
alterar as configurações, clique em Configuração (Setup) para abrir a caixa 
de diálogo Configuração do local (Location Setup). Para obter mais 
informações sobre a caixa de diálogo Configuração do local, consulte a 
seção “Criação de fórmulas de nome de arquivo e local com a caixa de 
diálogo Configuração do local (Location Setup)” neste capítulo.

• Nome do arquivo (File Name) — mostra o nome de arquivo do Arquivo (1) 
(File (1)).

Opção Arquivo (2) (File (2)) — igual a Arquivo (1). Você pode escolher 
configurações diferentes para Arquivo (2) (File (2)) ou usar as mesmas de 
Arquivo (1) (File (1)).

Na opção Arquivo (1) (File (1)) ou Arquivo (2) (File (2)), você pode selecionar 
a opção Índice (Index). As seguintes opções de menu serão exibidas. 
• Arquivo de índice do lote (Batch Index file)
• Arquivo de índice do documento (Document Index file)
• Arquivo de índice da imagem (Image Index file)

Opções de configuração 
de Arquivo (1) e Arquivo 
(2) 

Quando você seleciona um formato de arquivo (por exemplo, TIFF, PDF, 
JPEG, PNG etc.) para a saída, suas opções de formato dependem de como 
o formato de arquivo é configurado.
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• Clique em Opções (Options) para o formato de arquivo que você quer 
configurar. 

Quando você selecionar o botão Opções (Options), uma caixa de diálogo 
com o formato de arquivo selecionado será exibida.

Seleção de PDF como o 
formato de arquivo 

Se você selecionar PDF como o formato de arquivo, a caixa de diálogo 
Configuração de PDF (PDF Setup) será exibida.

1. Selecione Uma página (Single Page) ou Várias páginas (Multi-Page) como 
a maneira de agrupar os arquivos de imagem na saída. Cada arquivo de 
imagem de entrada (digitalizado) será um arquivo de saída separado.

• Se você selecionar Uma página (Single Page), cada imagem que você 
digitalizar será um arquivo de imagem separado na saída. 
Consequentemente, se você digitalizar uma folha, terá dois arquivos de 
imagem separados na saída (um da frente e outro do verso). Se você 
estiver digitalizando em fluxo dual, obterá quatro arquivos de imagem 
na saída.

• Se você selecionar Várias páginas (Multi-Page), a lista suspensa 
Para cada (For each) ficará disponível.

- Para cada: Página (For each: Page) — cada imagem para cada 
página digitalizada se torna um arquivo. Quando você abrir o arquivo, 
haverá duas imagens, uma da frente e outra do verso. Se você 
digitalizar em fluxo dual, obterá quatro imagens.

- Para cada: Documento (For each: Document) — cada página 
digitalizada em um documento se tornará o conteúdo de um arquivo. 
Pode haver várias (ou muitas) imagens em um arquivo.

- Para cada: Lote (For each: Lote) — todas as imagens digitalizadas 
no lote se tornarão um arquivo de saída. Pode haver muitas imagens 
no arquivo de saída.
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2. Selecione um ou mais formatos PDF adicionais (Additional PDF 
formats): Exibição rápida da web (Fast Web View), Indicador de PDF 
(PDF BookMark), PDF grande (Long PDF) ou PDF-MRC (PDF-MRC). 

• Selecione Exibição rápida da web (Fast Web View) se quiser 
configurar o arquivo PDF para exibição mais rápida, caso os arquivos 
sejam maiores e tenham sido baixados do site. 

• Selecione Marcador de PDF (PDF BookMark) quando quiser marcar 
cada documento no arquivo PDF. Agrupar por Várias páginas (Multi-
Page) precisa ser selecionado para cada Lote (Batch). Especifique 
o valor de cada marcador de documento usando a guia Marcador 
de PDF (PDF BookMark) na guia Índice (Index). Os valores do sistema 
e/ou de índice podem ser usados para produzir valores de marcadores 
únicos.

• Selecione PDF grande (Long PDF) se você espera que as imagens 
sejam maiores que 500 cm (200 polegadas). Esta seleção afetará 
o desempenho. O PDF grande não está disponível para o formato de 
arquivo PDF-MRC.

• Se você selecionar PDF-MRC como um dos formatos de PDF 
adicionais, selecione a Qualidade da imagem (Image quality) desejada: 
JBIG2/Grupo4 (JBIG2/Group4), Rascunho (Draft), Boa (Good) ou 
Melhor (Better).

OBSERVAÇÃO: as opções PDF-MRC só estão disponíveis para 
o Capture Pro originalmente instalado na versão 5.5.1 
ou anterior. Elas continuarão disponíveis para uso 
mesmo após a atualização. Essas opções não 
estarão disponíveis se você originalmente instalou 
o Capture Pro versão 5.6 ou posterior.

OBSERVAÇÃO: em geral, JBIG2 produzirá tamanhos menores de 
arquivos com qualidade mais baixa do que o Grupo4. 
As opções JBIG2-Melhor (JBIG2-Better), Grupo4-
Rascunho (Group4-Draft), Grupo4-Boa (Group4-
Good) e Grupo4-Melhor (Group4-Better) não 
geram perdas.

• Se nenhuma seleção for feita, o formato será PDF.

3. Selecione uma opção de compatibilidade com o PDF se precisar que 
o PDF seja compatível com uma versão específica do Adobe Reader. 
Se você estiver criptografando um PDF com uma senha, selecionar uma 
versão mais recente do PDF fornecerá um algoritmo de criptografia mais 
forte. O formato PDF/UA foi adicionado recentemente para arquivos do 
tipo PDF e SPDF.



A-61993_pt-br  Março de 2022 75

4. Se você quiser criptografar o arquivo PDF, no campo Senha (Password), 
digite uma senha que será necessária para abrir e visualizar o arquivo 
PDF. Se você não quiser criptografar o arquivo, deixe o campo Senha 
(Password) em branco.

5. Quando terminar, clique em OK.

Seleção de TIFF como o 
formato de arquivo

Se você selecionar TIFF como seu formato de arquivo, a caixa de diálogo 
Configuração de TIFF (TIFF Setup) será exibida.

1. Selecione Uma página (Single Page) ou Várias páginas (Multi-Page) 
como a maneira de agrupar os arquivos de imagem na saída. Cada 
arquivo de imagem de entrada (digitalizado) será um arquivo de saída 
separado.

• Se você selecionar Uma página (Single Page), cada imagem que você 
digitalizar será um arquivo de imagem separado na saída. 
Consequentemente, se você digitalizar uma folha, terá dois arquivos de 
imagem separados na saída (um da frente e outro do verso). Se você 
estiver digitalizando em fluxo dual, obterá quatro arquivos de imagem 
na saída.

• Se você selecionar Várias páginas (Multi-Page), a lista suspensa Para 
cada (For each) ficará disponível.

- Para cada: Página (For each: Page) — cada imagem para cada 
página digitalizada se torna um arquivo. Quando você abrir o arquivo, 
haverá duas imagens, uma da frente e outra do verso. Se você 
digitalizar em fluxo dual, obterá quatro imagens.

- Para cada: Documento (For each: Document) — cada página 
digitalizada em um documento se tornará o conteúdo de um arquivo. 
Pode haver várias (ou muitas) imagens em um arquivo.

- Para cada: Lote (For each: Lote) — todas as imagens digitalizadas 
no lote se tornarão um arquivo de saída. Pode haver muitas imagens 
no arquivo de saída.

2. Se sua saída incluir imagens em preto e branco, a opção de compressão 
Preto e Branco (Black & White) estará disponível. Selecione Grupo-4 
(Group-4) ou (nenhum) (none) na lista suspensa.

3. Se sua saída incluir imagens coloridas ou em escalas de cinza, as opções 
de Compressão de colorida/escalas de cinza (Color/Grayscale 
compression) e Qualidade da cor (Color quality) estarão disponíveis.
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• Compressão de colorida/escalas de cinza (Color/Grayscale 
compression): selecione JPEG, JAPED (TIFF 6) ou (nenhuma) (none).

• Qualidade da cor (Color quality): selecione uma das seguintes 
configurações na lista suspensa: Igual à digitalização (Same as 
scanned), Rascunho (Draft), Bom (Good), Melhor (Better), Perfeito 
(Best) ou Superior. Igual à digitalizada (Same as scanned) é a opção 
recomendada.

4. Para verificar que uma saída de imagem do software Capture Pro 
permaneceu inalterada da imagem fonte capturada do documento, clique 
em Aplicar Assinatura digital (Apply Digital Signature). 

O software Verificador de imagem (Image Verifier) é gratuito e pode ser 
usado para verificar se uma imagem

assinada digitalmente não foi alterada em algum momento. Para ler sobre 
os benefícios da verificação de imagem e acessar o software Verificador 
de imagens (Image Verifier), entre em contato com o representante local 
da Kodak Alaris.

5. Quando terminar, clique em OK.

Seleção de PDF pesquisável 
como o formato de arquivo 

Se você selecionar PDF pesquisável (Searchable PDF) como seu formato de 
arquivo, a caixa de diálogo Configuração de PDF pesquisável (Searchable 
PDF Setup) será exibida.

1. Selecione Uma página (Single Page) ou Várias páginas (Multi-page) 
como a maneira de agrupar os arquivos de imagem na saída. Cada 
arquivo de imagem de entrada (digitalizado) será um arquivo de saída 
separado.
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• Se você selecionar Uma página (Single Page), cada imagem que você 
digitalizar será um arquivo de imagem separado na saída. 
Consequentemente, se você digitalizar uma folha, terá dois arquivos de 
imagem separados na saída (um da frente e outro do verso). Se você 
estiver digitalizando em fluxo dual, obterá quatro arquivos de imagem 
na saída.

• Se você selecionar Várias páginas (Multi-page), a lista suspensa Para 
cada (For each) ficará disponível.

- Para cada: Página (For each: Page) — cada imagem para cada 
página digitalizada se torna um arquivo. Quando você abrir o arquivo, 
haverá duas imagens, uma da frente e outra do verso. Se você 
digitalizar em fluxo dual, obterá quatro imagens.

- Para cada: Documento (For each: Document) — cada página 
digitalizada em um documento se tornará o conteúdo de um arquivo. 
Pode haver várias (ou muitas) imagens em um arquivo.

- Para cada: Lote (For each: Lote) — todas as imagens digitalizadas 
no lote se tornarão um arquivo de saída. Pode haver muitas imagens 
no arquivo de saída.

OBSERVAÇÃO: o limite de tamanho para PDFs pesquisáveis de 
várias páginas é de 500 páginas por documento. 
Os resultados reais podem variar de acordo com as 
configurações do sistema e do trabalho.

2. Selecione um ou mais formatos PDF: (PDF formats:) Exibição rápida 
da web (Fast Web View), Marcador de PDF (PDF BookMark) ou PDF-
MRC. 

• Selecione Exibição rápida da web (Fast Web View) se quiser 
configurar o arquivo PDF para exibição mais rápida, caso os arquivos 
sejam maiores e tenham sido baixados do site. 

• Selecione Marcador de PDF (PDF BookMark) quando quiser marcar 
cada documento no arquivo PDF. Agrupar por Várias páginas (Multi-
Page) precisa ser selecionado para cada Lote (Batch). Especifique 
o valor de cada marcador de documento usando a guia Marcador 
de PDF (PDF BookMark) na guia Índice (Index). Os valores do sistema 
e/ou de índice podem ser usados para produzir valores de marcadores 
únicos.

• Se você selecionar PDF-MRC como um dos formatos de PDF 
adicionais, selecione a Qualidade da imagem (Image quality) desejada: 
JBIG2/Grupo4 (JBIG2/Group4), Rascunho (Draft), Boa (Good) ou 
Melhor (Better).

OBSERVAÇÃO: em geral, JBIG2 produzirá tamanhos menores de 
arquivos com qualidade mais baixa do que o Grupo4. 
As opções JBIG2-Melhor (JBIG2-Better), Grupo4-
Rascunho (Group4-Draft), Grupo4-Boa (Group4-
Good) e Grupo4-Melhor (Group4-Better) não 
geram perdas.

• Se nenhuma seleção for feita, o formato será PDF.

3. Selecione uma opção de compatibilidade com o PDF se precisar que 
o PDF seja compatível com uma versão específica do Adobe Reader. 
Se você estiver criptografando um PDF com uma senha, selecionar 
uma versão mais recente do PDF fornecerá um algoritmo de criptografia 
mais forte.
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4. Se você quiser criptografar o arquivo PDF, no campo Senha (Password), 
digite uma senha que será necessária para abrir e visualizar o arquivo 
PDF. 

• Se você não quiser criptografar o arquivo, deixe o campo Senha 
(Password) em branco.

5. Selecione uma Configuração de OCR (OCR Setting) para ajustar as 
necessidades de velocidade e precisão. À medida que você move 
o seletor para a direita, ferramentas adicionais, como dicionários de 
idiomas e vários mecanismos de OCR, são utilizadas para melhorar 
a precisão.

6. Quando disponível, o OCR será executado para permitir a pesquisa por 
texto específico nos arquivos de saída. Selecione o idioma de OCR que 
seus documentos conterão para obter o máximo de precisão no 
reconhecimento de caracteres. Se você tiver um grupo de documentos 
diversos que podem conter vários idiomas, poderá selecionar um ou mais 
idiomas secundários.

7. Um dicionário personalizado pode ser utilizado para melhorar a precisão 
do reconhecimento de palavras únicas ou incomuns em um grupo de 
documentos. Clique em Procurar (Browse) para selecionar um dicionário 
personalizado. Consulte o Apêndice D, Uso de dicionários personalizados 
para obter mais informações.

8. Ao agrupar por várias páginas, selecione Todas (All) ou Imagens 
(Images) para selecionar imagens específicas a serem incluídas em um 
arquivo de saída.

• Se você selecionar Todas (All), todas as imagens nos grupos Página 
(Page), Documento (Document) e Lote (Batch) selecionados estarão no 
arquivo de saída.

• Se você selecionar Imagens (Images), somente as imagens 
especificadas nos grupos Página (Page), Documento (Document) ou 
Lote (Batch) selecionados estarão no arquivo de saída. Por exemplo, 
se você selecionar Várias páginas (Multi-Page), agrupar por 
Documento (Document) e especificar um Intervalo de saída (Output 
Range) de 1, 10, somente a primeira e décima imagens de cada 
documento estarão no arquivo de saída. Se um documento tiver menos 
de 10 imagens, somente a primeira imagem aparecerá no arquivo de 
saída.

9. Quando terminar, clique em OK.

Seleção de JPEG ou 
JPEG2000 como o formato de 
arquivo (se o tipo de saída for 
Cor/escala de cinza) 

Se você selecionar JPEG2000 como seu formato de arquivo, a caixa de 
diálogo Configuração de JPEG2000 (JPEG2000 Setup) será exibida.

1. Selecione a qualidade de cor Boa (Good), Melhor (Better) ou Superior 
(Best).
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OBSERVAÇÃO: se você selecionar JPEG como seu formato de arquivo, 
as opções de qualidade da cor opcionais estão 
disponíveis: Igual à digitalização (Same as scanned), 
Rascunho (Draft) e Superior. Igual à digitalizada 
(Same as scanned) é a opção recomendada.

2. Quando terminar, clique em OK.

Seleção de PNG como o 
formato de arquivo

Não há configuração necessária ao selecionar PNG como formato de arquivo. 
O formato de arquivo PNG é um formato sem perdas, de página única que 
não requer nenhuma configuração.

Seleção de Texto como o 
formato de arquivo

Se você selecionar Texto (Text) como formato de arquivo a ser processado na 
saída, a caixa de diálogo Configuração de texto (Text Setup) será exibida.

1. Selecione Uma página (Single Page) ou Várias páginas (Multi-Page) 
como a maneira de agrupar os arquivos de imagem na saída. Cada 
arquivo de imagem de entrada (digitalizado) será um arquivo de saída 
separado

• Se você selecionar Uma página (Single Page), cada imagem que você 
digitalizar será um arquivo de imagem separado na saída. 
Consequentemente, se você digitalizar uma folha, terá dois arquivos de 
imagem separados na saída (um da frente e outro do verso). Se você 
estiver digitalizando em fluxo dual, obterá quatro arquivos de imagem 
na saída.

• Se você selecionar Várias páginas (Multi-Page), a lista suspensa Para 
cada (For each) ficará disponível.

- Para cada: Página (For each: Page) — cada imagem para cada 
página digitalizada se torna um arquivo. Quando você abrir o arquivo, 
haverá duas imagens, uma da frente e outra do verso. Se você 
digitalizar em fluxo dual, obterá quatro imagens.
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- Para cada: Documento (For each: Document) — cada página 
digitalizada em um documento se tornará o conteúdo de um arquivo. 
Pode haver várias (ou muitas) imagens em um arquivo.

- Para cada: Lote (For each: Lote) — todas as imagens digitalizadas 
no lote se tornarão um arquivo de saída. Pode haver muitas imagens 
no arquivo de saída.

2. Selecione um dos seguintes formatos na lista suspensa: Somente texto 
(Text only), Texto formatado (Formatted text), Somente texto - 
Unicode (Text only – Unicode) ou Texto formatado - Unicode 
(Formatted text - Unicode).

3. Selecione uma Configuração de OCR (OCR Setting) para ajustar as 
necessidades de velocidade e precisão. À medida que você move 
o seletor para a direita, ferramentas adicionais, como dicionários de 
idiomas e vários mecanismos de OCR, são utilizadas para melhorar 
a precisão.

4. Quando disponível, o OCR será realizado para permitir a pesquisa por um 
texto específico nos arquivos de saída. Selecione o idioma do OCR a ser 
usado nos documentos digitalizados para um reconhecimento de 
caracteres mais preciso. Se você tiver um grupo de documentos diversos 
que podem conter vários idiomas, poderá selecionar um ou mais idiomas 
secundários.

5. Um dicionário personalizado pode ser utilizado para melhorar a precisão 
do reconhecimento de palavras únicas ou incomuns em um grupo de 
documentos. Clique em Procurar (Browse) para selecionar um dicionário 
personalizado. Consulte o Apêndice D, Uso de dicionários personalizados 
para obter mais informações.

Ao agrupar por várias páginas, selecione Todas (All) ou Imagens (Images) 
para selecionar imagens específicas a serem incluídas em um arquivo de 
saída.

• Se você selecionar Todas (All), todas as imagens nos grupos Página 
(Page), Documento (Document) e Lote (Batch) selecionados estarão no 
arquivo de saída.

• Se você selecionar Imagens (Images), somente as imagens 
especificadas nos grupos Página (Page), Documento (Document) ou 
Lote (Batch) selecionados estarão no arquivo de saída. Por exemplo, 
se você selecionar Várias páginas (Multi-Page), agrupar por 
Documento (Document) e especificar um Intervalo de saída (Output 
Range) de 1, 10, somente a primeira e décima imagens de cada 
documento estarão no arquivo de saída. Se um documento tiver menos 
de 10 imagens, somente a primeira imagem aparecerá no arquivo de 
saída.

6. Quando terminar, clique em OK.
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Seleção de RTF (sem 
formatação) como o formato 
de arquivo

Se você selecionar RTF (Não formatado) (RTF (Unformatted)) como seu 
formato de arquivo, a caixa de diálogo Configuração de RTF (não formatado) 
(RTF (Unformatted) Setup) será exibida.

1. Selecione Uma página (Single Page) ou Várias páginas (Multi-Page) 
como a maneira de agrupar os arquivos de imagem na saída. Cada 
arquivo de imagem de entrada (digitalizado) será um arquivo de saída 
separado.

• Se você selecionar Uma página (Single Page), cada imagem que você 
digitalizar será um arquivo de imagem separado na saída. 
Consequentemente, se você digitalizar uma folha, terá dois arquivos de 
imagem separados na saída (um para frente e outro do verso). Se você 
estiver digitalizando em fluxo dual, obterá quatro arquivos de imagem 
na saída.

• Se você selecionar Várias páginas (Multi-Page), a lista suspensa Para 
cada (For each) ficará disponível.

- Para cada: Página (For each: Page) — cada imagem para cada 
página digitalizada se torna um arquivo. Quando você abrir 
o arquivo, haverá duas imagens, uma da frente e outra do verso. 
Se você digitalizar em fluxo dual, obterá quatro imagens.

- Para cada: Documento (For each: Document) — cada página 
digitalizada em um documento se tornará o conteúdo de um 
arquivo. Pode haver várias (ou muitas) imagens em um arquivo.

- Para cada: Lote (For each: Lote) — todas as imagens 
digitalizadas no lote se tornarão um arquivo de saída. Pode haver 
muitas imagens no arquivo de saída.

2. Selecione uma Configuração de OCR (OCR Setting) para ajustar 
as necessidades de velocidade e precisão. À medida que você move 
o seletor para a direita, ferramentas adicionais, como dicionários de 
idiomas e vários mecanismos de OCR são utilizadas para melhorar 
a precisão.
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3. Quando disponível, o OCR será realizado para permitir a pesquisa por um 
texto específico nos arquivos de saída. Selecione o idioma do OCR a ser 
usado nos documentos digitalizados para um reconhecimento de 
caracteres mais preciso. Se você tiver um grupo de documentos diversos 
que podem conter vários idiomas, poderá selecionar um ou mais idiomas 
secundários.

4. Ao agrupar por várias páginas, selecione Todas (All) ou Imagens 
(Images) para selecionar imagens específicas a serem incluídas em um 
arquivo de saída.

• Se você selecionar Todas (All), todas as imagens nos grupos Página 
(Page), Documento (Document) e Lote (Batch) selecionados estarão no 
arquivo de saída.

• Se você selecionar Imagens (Images), somente as imagens 
especificadas nos grupos Página (Page), Documento (Document) ou 
Lote (Batch) selecionados estarão no arquivo de saída. Por exemplo, 
se você selecionar Várias páginas (Multi-Page), agrupar por 
Documento (Document) e especificar um Intervalo de saída 
(Output Range) de 1, 10, somente a primeira e décima imagens de 
cada documento estarão no arquivo de saída. Se um documento tiver 
menos de 10 imagens, somente a primeira imagem aparecerá no 
arquivo de saída.

5. Quando terminar, clique em OK.

Opções de índice de 
Arquivo (1) e Arquivo (2)

As opções de índice para os destinos de saída de Arquivo (1) e Arquivo (2) 
são configuradas na guia Saída (Output). 
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Você pode criar um Arquivo de índice do lote (Batch Index file), um Arquivo 
de índice do documento (Document Index file) e um Arquivo de índice da 
imagem (Image Index file).

OBSERVAÇÃO: se você quiser produzir um arquivo de índice sem saída de 
arquivo de imagem, selecione o tipo de arquivo de índice 
(Lote (Batch), Documento (Document), Imagem (Image)) e, 
depois, selecione os destinos (Arquivo(1) (File(1)), Arquivo(2) 
(File(2))) e desmarque todos os tipos de saída (Tudo (All), 
Preto e branco (Black & White), Cor/escala de cinza (Color/
Grayscale)). A etiqueta Arquivo(1)/Arquivo(2) (File(1)/File(2)) 
será alterada para Sem imagens (No images) a fim de 
indicar que apenas dados de índice serão produzidos.

Cada arquivo de índice (do lote, do documento e da imagem) fornece um 
botão Opções (Options), um botão Configurar (Setup) e um botão 
Conteúdo (Content).

Opções (Options) — exibe o tipo de arquivo de índice disponível:

• Capture Software 6.x — não há necessidade de configuração de 
propriedades. 

• Índice para banco de dados de ODBC (Index to ODBC Database) — 
envia estatísticas de índice de documentos e/ou do lote selecionado para 
um banco de dados compatível com ODBC.
- Arquivo de índice do lote (Batch index file): um registro do banco de 

dados por lote contendo as estatísticas do lote selecionado.
- Arquivo de índice do documento (Document index file): um registro do 

banco de dados por documento contendo as estatísticas do documento 
selecionado.
OBSERVAÇÃO: Esta opção não está disponível para o índice de 

imagens.

• Formato HVCS de 16 bits (HVCS 16-bit Format) — esta opção não 
está disponível para o Arquivo de índice do lote (Batch index file). 
O Formato HVCS de 16 bits permite definir o Número do cliente (Client 
number) (1-999) e o Número do aplicativo (Application number) (1-9).

• Texto (delimitado) (Text (delimited)) — permite selecionar o formato de 
arquivo de texto ASCII ou Unicode.

• XML — não há necessidade de configuração de propriedades.

• Imprimir capa (Print Cover) — adiciona uma página de capa ao arquivo na 
impressão.
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Configurar (Setup) — exibe a caixa de diálogo Configuração do local 
(Location Setup), que permite criar um arquivo de índice. Para obter mais 
informações sobre essa caixa de diálogo, consulte a seção “Criação de 
fórmulas de nome de arquivo e local com a caixa de diálogo Configuração do 
local (Location Setup)” adiante neste capítulo. 

Conteúdo (Content) — exibe a caixa de diálogo Configuração do conteúdo do 
índice (Index Content Setup) que permite definir o conteúdo do índice. Para 
obter mais informações sobre essa caixa de diálogo, consulte a seção “Uso da 
caixa de diálogo Configuração do conteúdo do índice (Index Content Setup)” 
neste capítulo.

Índice para banco de dados 
ODBC (Index to ODBC 
Database)

Use este Destino de saída do sistema (System Output Destination) se deseja 
salvar os dados de índice em uma origem de dados compatível com ODBC, 
como SQL Server e Microsoft Access. Na saída, os campos selecionados de 
índice de lote e documento serão usados para criar um novo registro para 
cada documento e serão gravados no banco de dados.

São fornecidos três campos de índice adicionais de documento que contêm 
o caminho para onde as imagens de documento foram armazenadas. Se você 
estiver armazenando todas as imagens em um só local, o campo Local da 
imagem – Tudo (Image Location – All) conterá o caminho das imagens de 
cada documento. Se você estiver armazenando imagens em preto e branco 
e coloridas/em escala de cinza em locais diferentes, os campos Local da 
imagem – Preto (Image Location – Black & White) e branco e Local da 
imagem – Cor/escala de cinza (Image Location – Color/Grayscale) conterão 
o caminho para os respectivos tipos de imagem. Esses campos podem ser 
usados em seu banco de dados para associar a imagem armazenada aos 
dados de índice do documento.

Arquivos de saída compatíveis/agrupamento (Supported Output files/
Grouping) — várias páginas (multi-page), por documento (by document), 
todos os tipos de imagem (all image types).

Canais compatíveis (Supported Channels) — Tudo (All), Preto e branco 
(Black and White), Cor/escala de cinza (Color/Grayscale).

1. Acesse o destino de saída do sistema do Banco de dados de ODBC 
(ODBC Database).
OBSERVAÇÃO: para ter suporte para o Microsoft Access 2016, 

é necessário instalar o MS Access Database Engine 
2010 Redistributable, disponível para download no site 
da Microsoft: https://www.microsoft.com/en-us/
download/details.aspx?id=13255

• Nome da origem dos dados (Data Source name): navegue para um 
existente ou crie um novo Arquivo (File) ou Origem de dados da 
máquina (Machine Data Source).

• Tabela do banco de dados (Database table): selecione o controle 
suspenso para exibir uma lista das tabelas disponíveis para a origem 
dos dados selecionados. Selecione a tabela onde deseja armazenar os 
dados do campo de índice.

2. Selecione os campos que deseja preencher.
Você notará que a coluna esquerda da grade de dados foi preenchida 
com os nomes do campo atual de lote e documento. Também há três 
campos de índice de documentos adicionais: Local da imagem – Tudo 
(Image Location – All), Local da imagem – Preto e branco (Image 
Location – Black & White) e Local da imagem – Cor/escala de cinza 
(Image Location – Color/Grayscale).
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3. Selecione um campo de índice que deseje mapear para a tabela do banco 
de dados, clicando na coluna direita da mesma linha do campo do índice.

4. Clique na seta para baixo para exibir uma lista dos campos disponíveis da 
tabela de dados e selecione um campo.

• Se você tiver marcado a caixa de seleção Tudo (All) na guia Saída, 
Sistema (1)/(2) (Output, System (1)/(2)), o campo Local da imagem – 
Tudo (Image Location – All) conterá o caminho do arquivo e o nome da 
imagem. O caminho do arquivo será criado anexando o caminho da 
raiz de saída com “\nome do lote” e “\Tudo”. O nome da imagem será 
o número de sequência do documento acrescentado de zeros para um 
comprimento de oito caracteres. A extensão do arquivo será 
determinada pelo tipo de imagem que selecionou para saída (tif, pdf, 
txt, etc.). Por exemplo: “C:\BatchesPro\Batch001\All\00000001.tif”.

• Se você tiver marcado a opção Preto e branco (Black & White), “\Tudo” 
no caminho do arquivo será substituído por “\PB”.

• Se tiver marcado a opção Cor/escala de cinza (Color / Grayscale), 
“\Tudo” no caminho do arquivo será substituído por “\CE”.

Vários registros por 
documento

Um documento pode conter vários itens em que cada item será salvo como 
um registro separado na base de dados. Por exemplo, o documento seguinte 
contém quatro itens.

Se você quiser salvar quatro registros para o banco de dados onde cada 
registro contém três campos, Descrição, Quantidade e Preço:

1. Crie um campo de índice para cada campo da base de dados que deve 
ser preenchido. Por exemplo, Descrição, Quantidade e Preço. Esses 
campos de índices serão usados para armazenar os dados para o grupo 
do primeiro item.

2. Crie campos de índices para os conjuntos de itens restantes. Os nomes 
dos campos de índice devem ser os mesmos que o grupo do primeiro item 
com um número anexo. Os números devem começar em 1 e devem ser 
sequenciais. Por exemplo:

Item do produto 2: “Descrição1”, “Quantidade1” e “Preço1”
Item do produto 3: “Descrição2”, “Quantidade2” e “Preço2”
Item do produto 4: “Descrição3”, “Quantidade3” e “Preço3”

Descrição Quantidade Preço
Item do produto 1 2 28,44
Item do produto 2 1 43,12
Item do produto 3 5 122,50
Item do produto 4 2 12,80
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3. Use o Assistente de pesquisa da base de dados (Database Lookup 
Wizard) para mapear os nomes dos índices do grupo do primeiro item 
para os nomes dos campos de base de dados. Somente os nomes dos 
campos de índices do grupo do primeiro item são usados no Assistente de 
pesquisa da base de dados (Database Lookup Wizard).

Arquivo de índice do lote 
(Batch Index file)

Para definir um Arquivo de índice do lote: 

1. Selecione Arquivo de índice do lote (Batch Index file).

2. Selecione o tipo de arquivo de índice desejado.

• Se você selecionar Texto (delimitado) (Text (delimited)), clique em 
Opções (Options), em ASCII ou Unicode e depois clique em OK.

3. Se desejar, clique em Configurar (Setup) para exibir a caixa de diálogo 
Configuração do local (Location Setup) para criar um caminho para seu 
arquivo de índice de lote de saída. Consulte a seção “Criação de fórmulas 
de nome de arquivo e local com a caixa de diálogo Configuração do local 
(Location Setup)” adiante neste capítulo.

4. Se desejar, clique em Conteúdo (Content) para exibir a caixa de diálogo 
Configuração do conteúdo (Content Setup) do índice e definir o conteúdo 
do índice. Por padrão, o arquivo do índice do lote terá apenas os índices 
de lotes definidos para este trabalho. Use o botão Conteúdo (Content) 
para adicionar ou remover valores de índice ou reorganizar os índices na 
saída. Consulte a seção “Uso da caixa de diálogo Configuração do 
conteúdo do índice (Index Content Setup)” neste capítulo.

5. Quando terminar, clique em OK.

Arquivo de índice do 
documento (Document Index 
file)

Para definir um Arquivo de índice do documento: 

1. Selecione Arquivo de índice do documento (Document Index file).

2. Selecione o tipo de arquivo de índice desejado.

• Se você selecionar Texto (delimitado) (Text (delimited)), clique em 
Opções (Options), em ASCII ou Unicode e depois clique em OK.

• Se você selecionar Formato HVCS de 16 bits (HVCS 16-bit Format), 
clique em Opções (Options) e insira o Número do cliente (Client 
number) (1-999) e o Número do aplicativo (Application number) (1-9), 
depois clique em OK.
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3. Se desejar, clique em Configurar (Setup) para exibir a caixa de diálogo 
Configuração do local (Location Setup) para criar um caminho para seu 
arquivo de índice de documento de saída. Consulte a seção “Criação de 
fórmulas de nome de arquivo e local com a caixa de diálogo Configuração 
do local (Location Setup)” adiante neste capítulo.

4. Se desejar, clique em Conteúdo (Content) para exibir a caixa de diálogo 
Configuração do conteúdo (Content Setup) do índice e definir o conteúdo 
do índice. Por padrão, o arquivo do índice do documento terá apenas os 
índices de documentos definidos para este trabalho. Use o botão 
Conteúdo (Content) para adicionar ou remover valores de índice ou 
reorganizar os índices na saída. Consulte a seção “Uso da caixa de 
diálogo Configuração do conteúdo do índice (Index Content Setup)” 
neste capítulo.

5. Quando terminar, clique em OK.

Arquivo de índice da imagem 
(Image Index file)

Para definir um Arquivo de índice da imagem: 

1. Selecione Arquivo de índice da imagem (Image Index file).

2. Selecione o tipo de arquivo de índice desejado.

• Se você selecionar Texto (delimitado) (Text (delimited)), clique em 
Opções (Options), em ASCII ou Unicode e depois clique em OK.

• Se você selecionar Formato HVCS de 16 bits (HVCS 16-bit Format), 
clique em Opções (Options) e insira o Número do cliente (Client 
number) (1-999) e o Número do aplicativo (Application number) (1-9), 
depois clique em OK.

3. Se desejar, clique em Configurar (Setup) para exibir a caixa de diálogo 
Configuração do local para criar um caminho para seu arquivo de índice 
de imagem de saída. Consulte a seção “Criação de fórmulas de nome de 
arquivo e local com a caixa de diálogo Configuração do local (Location 
Setup)” adiante neste capítulo.

4. Se desejar, clique em Conteúdo (Content) para exibir a caixa de diálogo 
Configuração do conteúdo (Content Setup) do índice e definir o conteúdo 
do índice. Por padrão, o arquivo do índice da imagem terá apenas os 
índices das imagens definidas para este trabalho. Use o botão Conteúdo 
(Content) para adicionar ou remover valores de índice ou reorganizar os 
índices na saída. Consulte a seção “Uso da caixa de diálogo Configuração 
do conteúdo do índice (Index Content Setup)” neste capítulo.

5. Quando terminar, clique em OK.

Criação de fórmulas de 
nome de arquivo e local 
com a caixa de diálogo 
Configuração do local 
(Location Setup)

A caixa de diálogo Configuração do local (Location Setup) fornece uma lista 
de valores predefinidos e valores de índice configurados anteriormente, que 
permite armazenar os arquivos de saída em pastas com denominação 
exclusiva para facilitar a classificação.

Quando você clicar na guia Configurar (Setup) na guia Saída (Output) - 
Destino\Arquivo1 (Destination\File1) ou Destino\Arquivo2 
(Destination\File2), a caixa de diálogo Configuração do local (Location Setup) 
será exibida. Use essa caixa de diálogo para criar uma fórmula a ser usada 
pelo Capture Pro Software na criação e armazenamento da saída.

• Para desenvolver fórmulas de locais, abra a guia Local (Location).

• Para criar fórmulas de nomes de arquivos, abra a guia Nome do arquivo 
(File name) (se exibida nessa caixa de diálogo). 
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Os procedimentos para a criação de fórmulas de nome de arquivo e de local 
são os mesmos.

OBSERVAÇÃO: as opções nas guias Localização - Nome do arquivo 
(Location - Filename) são diferentes, de acordo com o tipo 
de arquivo de índice (por exemplo, Lote, Documento ou 
Imagem). Nem todas as opções estão disponíveis com 
todos os tipos de arquivos de índice.

1. Selecione um valor predefinido na lista, no lado esquerdo desta caixa de 
diálogo. A fórmula que está em uso no momento está no campo Fórmula 
do nome do arquivo (Filename Formula), à direita da caixa de diálogo.

2. Clique em Adicionar item (Add Item) para adicionar o valor predefinido ao 
fim da fórmula. Ao especificar um nome de caminho, o limite será de até 
248 caracteres.
OBSERVAÇÕES:
• Se você clicar em Excluir item (Delete Item), o valor predefinido será 

excluído do fim da fórmula.
• Clicar em Excluir fórmula (Delete formula) excluirá a fórmula.

3. Se você quiser definir dígitos de números sequenciais e adicionar zeros 
à esquerda do número de sequência, marque Adicionar zeros 
à esquerda (Add leading zeros). Esta opção está disponível somente com 
valores numéricos.

4. Se você marcar Adicionar zeros à esquerda (Add leading zeros), use 
a caixa Extensão de número (Number Length) para indicar o número de 
dígitos (incluindo os zeros à esquerda) da sequência numérica.

5. Se você adicionar <Etiqueta lateral da imagem> ao campo Fórmula do 
nome do arquivo (Filename Formula), a caixa de texto Cores/Tons de 
cinza na frente (Front Color/Grayscale), Preto-e-branco na frente (Front 
Black & White), Cores/Tons de cinza no verso (Back Color/Grayscale) 
ou Preto-e-branco no verso (Back Black & White) ficará ativa. Se desejar, 
insira etiquetas de texto nesses campos.
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6. A área Tratamento de arquivo duplicado (Duplicate file handling) 
oferece duas opções. Selecione uma destas opções:

• Relatar um erro e cancelar o processamento da saída (Report an 
error and abort the output processing): gera uma mensagem de erro 
e para a saída do lote.

• Adicionar uma sequência numérica ao nome (Add a sequence 
number to the name): adiciona um número de sequência (como -001, -
002) e continua com a saída do lote.

• Sobrescrever o arquivo (Overwrite the file): sobrescreve qualquer 
arquivo existente na pasta de saída com nomes duplicados. Arquivos 
existentes na pasta de saída que não foram sobrescritos 
permanecerão.

7. Se você selecionar Número de sequência de página (Page Sequence 
Number) ou Sequência numérica de imagens (Image Sequence 
Number) o Recurso de redefinição (Reset Feature) ficará disponível. 
Defina o comportamento de sequência numérica para números de páginas 
e/ou imagens.

• Iniciar por 1 em todos os lotes (disponível apenas com Sequência 
numérica de páginas e Sequência numérica de imagens).

• Iniciar por 1 em todos os documentos (disponível apenas com 
Sequência numérica de imagens).

• Numeração de imagem contínua a partir de (disponível apenas com 
Sequência numérica de imagens).

8. Clique em OK para salvar a fórmula de saída.

OBSERVAÇÃO: Fórmulas de várias páginas (Multi-page formulas): se 
você selecionar a saída de várias páginas para formatos 
TIFF, PDF ou PDF pesquisável (Searchable PDF), não 
será possível adicionar Sequência numérica de páginas, 
Sequência numérica de imagens ou Etiqueta lateral da 
imagem à fórmula de local ou de nome do arquivo. Da 
mesma forma, se você escolher saída de várias páginas no 
nível do lote, não poderá nomear o arquivo de saída com 
mais informações detalhadas, a não ser informações no 
nível do lote.
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Uso da caixa de diálogo 
Configuração do 
conteúdo do índice 
(Index Content Setup)

1. Clique em Conteúdo (Content) para definir o conteúdo de índice do 
arquivo de índice de saída. A caixa de diálogo Configuração do conteúdo 
do índice (Index Content Setup) será exibida.

Se você estiver definindo o conteúdo do índice apenas para o tipo Índice de 
texto (delimitado), selecione uma entrada nos seguintes campos:

As opções a seguir se aplicam somente ao tipo Índice de texto (delimitado):

2. Selecione (guia) (“(tab)”) ou (espaço) (“(space)”) na lista suspensa 
Delimitador de campos (Field delimiter). Você também pode inserir 
manualmente outros caracteres, como o delimitador personalizado. 

3. Selecione (nenhum) (“(none)”), aspas simples (‘) (single quote (‘)) ou 
aspas duplas (“) (double quote (“)) na lista suspensa Delimitador de itens 
(Item delimiter).

4. Marque a opção Incluir registro de cabeçalho (Include header record) se 
quiser incluir informações de cabeçalho do arquivo de imagem no arquivo 
de índice de saída. 

Se você estiver definindo o conteúdo do índice como o tipo Índice de texto 
(delimitado) e o tipo Índice XML, aplique a opção a seguir: 

5. Selecione qualquer item na lista Índices disponíveis (Available Indexes) 
e clique em Adicionar (Add) para adicioná-lo à lista Índices atuais 
(Current Indexes).

OBSERVAÇÕES: 

• Clique em Remover (Remove) para excluir o item de índice selecionado da 
lista Índices atuais (Current Indexes). 

• Clique em Adicionar tudo (Add All) para mover todos os itens de índice da 
lista Índices disponíveis (Available Indexes) para a lista Índices atuais 
(Current Indexes). 

• Clique em Remover tudo (Remove All) para excluir todos os itens de índice 
da lista Índices atuais (Current Indexes). 

• Clique em Mover para cima/para baixo (Move Up/Move Down) para mover 
o item de índice selecionado uma posição para cima ou para baixo na lista 
Índices atuais (Current indexes). 

6. Quando terminar, clique em OK.
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Opções Sistema (1) 
e Sistema (2)

As opções Sistema (1) (System (1)) e Sistema (2) (System (2)) permitem 
selecionar um plug-in de saída de lote para a saída de um lote com a estrutura 
de arquivo obrigatória e o formato de arquivo de muitos dos mais conhecidos 
sistemas de gerenciamento de conteúdo empresarial (ECM, Enterprise 
Content Management).

Opção Sistema (1) (System (1)) — se esta opção for selecionada, marque 
a caixa de seleção Enviar para (Send to) e selecione um sistema (Destino de 
saída de sistema) na lista suspensa. 

Para alterar as configurações do sistema, clique em Configuração (Setup), 
e uma caixa de diálogo específica para o destino de saída do sistema 
selecionado será exibida. Para mais informações sobre essas caixas de 
diálogo, consulte o guia Destinos de saída de sistema (A-61638).

Para alterar o caminho raiz de saída, clique em Configuração (Setup), 
e a caixa de diálogo Configuração do local (Location Setup) será exibida. Para 
obter mais informações, consulte a seção “Criação de fórmulas de nome de 
arquivo e local com a caixa de diálogo Configuração do local (Location Setup)” 
anteriormente neste capítulo.

Selecione um formato de arquivo (TIFF, PDF, JPEG, PNG etc.) para sua saída. 
As opções de formato de arquivo dependem do tipo da saída Enviar para 
(Send to) selecionado por você. 

OBSERVAÇÃO: as opções Tudo (All), Preto-e-branco (Black & White) 
e Cores/Tons de cinza (Color/Grayscale) podem não 
estar disponíveis para o destino de saída de sistema 
selecionado por você. Nesse caso, clique no botão 
Configurar (Setup) para selecionar suas opções de 
configuração.

Opção Sistema (2) (System (2)) — se esta opção for selecionada, siga as 
mesmas instruções de Sistema (1) (System (1)).

Mais formatos de saída (More Output Formats) — fornece uma lista 
completa e links de destinos de saída dos sistemas da Kodak Capture Pro 
e de terceiros que estão disponíveis no site da Kodak Alaris.
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Configuração de opções 
de e-mail

A opção E-mail na guia Saída (Output) permite configurar o software para 
enviar os lotes de saída automaticamente por e-mail, com ou sem os dados 
de índice.

1. Abra a caixa de diálogo Configuração de trabalho (Job Setup) e clique na 
guia Saída (Output).

2. Clique na opção E-mail. A caixa de diálogo Destino\E-mail: 
(Destination\E-mail:) será exibida.

3. Selecione o aplicativo de e-mail a partir do qual os e-mails serão enviados 
na lista suspensa Aplicativo de e-mail padrão (Default e-mail application).

4. No campo Título padrão do e-mail (Default title of e-mail), insira as 
informações que devem aparecer na linha de assunto do e-mail. Para 
selecionar um valor predefinido para a linha do assunto (por exemplo: 
data, nome etc.), clique em Configurar (Setup). Será exibida a caixa de 
diálogo Configurar valor do campo de texto (Text Field Value Setup) de 
Título padrão do e-mail (Default Title of e-mail), na qual você pode 
selecionar outros itens a serem adicionados ao título do e-mail. 

• Na lista Valores predefinidos (Predefined values), selecione o valor que 
você deseja adicionar ao título do e-mail. Para adicionar cada um, 
clique em Adicionar item (Add Item).

• Clique em OK quando terminar.
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OBSERVAÇÃO: se quiser excluir o último valor, clique em Excluir 
item (Delete Item). Para excluir a fórmula inteira, 
clique em Excluir fórmula (Delete Formula).

5. Insira o tamanho máximo permitido para um anexo de e-mail (em MB) no 
campo Tamanho máximo dos anexos (Max size of attachments).

6. Marque Interativo (Interactive) se quiser confirmar antes do envio do e-mail.

OBSERVAÇÃO: se você estiver usando versões mais antigas do Outlook 
Express como seu cliente de e-mail, talvez seja preciso 
marcar essa opção. Caso contrário, o e-mail não será 
enviado.

7. Insira um ou mais endereços de e-mail nos campos Para (To), cc e cco 
(bcc) conforme aplicável. O endereço ou os endereços de e-mail devem 
ficar entre aspas (por exemplo: “John_Smith@aol.com”).

8. Se desejar, clique em Configurar (Setup) para adicionar valores 
predefinidos aos nomes dos destinatários dos e-mails. 

9. Se estiver incluindo um anexo, você poderá inserir o nome do anexo e/ou 
clicar em Configurar (Setup) para selecionar valores predefinidos. 
O nome do anexo deve ficar entre aspas (por exemplo: “Arquivo do 
paciente”).

10. Marque Incluir dados de índice de documentos associados (Include 
associated document index data) se quiser que os dados sejam exibidos 
automaticamente no campo Corpo do e-mail (E-mail body). Para alterar 
esses dados, clique em Configurar (Setup) para exibir a caixa de diálogo 
Configurar campo de texto do corpo do e-mail (E-mail Body Text Field 
Value Setup).

• Insira o texto que você quiser que apareça no e-mail. As informações 
inseridas devem estar entre aspas (“ ”). Você pode também selecionar 
qualquer valor na lista Valores predefinidos (Predefined values) e clicar 
em Adicionar item (Add Item). 

• Clique em OK quando terminar.

11. Marque Salvar imagens em disco (Save images to disk) se quiser salvar os 
arquivos de imagem de saída no disco rígido além de enviá-los por e-mail.

12. Clique em OK quando terminar.
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OBSERVAÇÃO: se você marcar Imagem (Image) na opção de e-mail do 
lado esquerdo da guia Saída (Output), poderá marcar as 
opções de destino (TIFF, PDF, JPEG, PNG etc.) de acordo 
com o tipo da saída. 

Configuração de opções 
de impressão

A opção Imprimir (Print) permite imprimir sua saída.

1. Clique em Imprimir (Print) em Configuração do trabalho (Job Setup), guia 
Saída (Output).

2. Selecione a impressora desejada na caixa da lista suspensa Nome da 
impressora (Printer name).

3. Se desejar alterar as propriedades da impressora, clique em 
Propriedades (Properties). As propriedades da impressora selecionada 
serão exibidas.

4. Altere as propriedades da impressora conforme desejado e clique em OK.
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5. Selecione o Número de cópias (Number of copies) que você quer imprimir 
na lista suspensa e clique em OK.

Uso do assistente de 
configuração do índice 
de SharePoint

A Configuração de índice do SharePoint (SharePoint Index Setup) fornece 
uma maneira rápida e fácil de configurar uma definição de trabalho do Capture 
Pro Software para usar com seu site SharePoint existente.

O assistente de configuração o guiará na conexão a seu site SharePoint, 
criando campos de índice para preencher colunas SharePoint e definindo 
caminhos de armazenamento para imagens.

O assistente fica informado dos tipos de dados do SharePoint e recomendará 
formatos de campo de índice para garantir captura de dados devidamente 
formatados e “no intervalo”. No caso das colunas do tipo “escolha”, 
o assistente preencherá uma lista suspensa com os valores de dados 
aceitáveis. 

O Assistente de configuração do índice do SharePoint o guiará através de 
quatro etapas:

Etapa 1: Configuração do 
SharePoint: criar, editar e 
selecionar uma conexão do 
SharePoint

1. Selecione uma conexão para o site SharePoint onde deseja colocar 
a imagens e dados do lote. Uma conexão especifica o Nome do host (Host 
name), Nome do site (Site name) e as Credenciais (Credentials) 
requeridos para acessar o site. Você pode fornecer um nome significativo 
para a conexão para uso futuro.

Se não forem definidas nenhumas conexões, a caixa de diálogo Criar um 
SharePoint (Create a SharePoint) será exibida.

1. Digite um nome (name) para a conexão. Você usará este nome para 
referir-se a este site específico do SharePoint.

2. Selecione Usar login e senha do Windows (Use Windows login and 
password) se você for acessar o site do SharePoint com sua ID de login 
e senha do Windows. 

3. Selecione Usar conta do SharePoint (Use SharePoint account) e insira 
sua ID do Login do usuário (User Login) e Senha (Password) para usar as 
credenciais da conta do SharePoint para acessar o site do SharePoint.
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4. Digite o Nome do host (Host name). Por exemplo: https://my-SharePoint-
host.

5. Digite o Nome do site (Site name). Se o nome e as credenciais do host 
estiverem corretos, você pode clicar em Buscar (Browse) para selecionar 
os sites disponíveis.

OBSERVAÇÕES:

• Antes de navegar em um site do SharePoint, certifique-se de ter permissão 
para acessar todos os subsites. Para verificar acesso, primeiro navegue 
para //<server>/_vti_bin/Lists.asmx. Se aparecerem erros, verifique 
a configuração e as permissões do site do SharePoint.

• Para acessar uma conta on-line do Office 365 do SharePoint, verifique 
o SharePoint on-line. 

• Para acessar uma conta do Office 365 do SharePoint on-line, você primeiro 
deve instalar os componentes SDK do cliente SharePoint Server 2013 e do 
Windows Identity Foundation. Os dois componentes estão disponíveis no 
Microsoft Download Center.

• Para determinar o nome do host, use um navegador da web para navegar 
em seu site O365. Na barra de endereços do navegador, verifique o URL. 
O nome do host é normalmente a primeira parte do URL e termina antes de 
/_layouts/...

Etapa 2. Criação de campos 
do índice de documentos 
baseado em suas colunas de 
SharePoint existentes

Após selecionar uma das listas do SharePoint disponíveis em seu site do 
SharePoint e selecionar o Tipo de documento (Document Type), as colunas 
do SharePoint serão exibidas.

O Tipo de coluna (Column Type) será mostrado e a caixa de seleção 
Requerida (Required) será marcada se a coluna for requerida por sua lista 
SharePoint.
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Por padrão, a caixa de seleção Criar índice (Create Index) será marcada para 
todos os tipos de colunas que possam ser preenchidas pelos campos de 
índice criados e configurados automaticamente. Se não deseja preencher 
uma coluna específica, ou se não precisa que um novo campo do índice 
preencha uma coluna específica, desmarque a caixa de seleção Criar índice 
(Create Index). Se deseja criar um campo do índice para uma coluna de 
SharePoint que não esteja marcada, marque a caixa de seleção Criar índice 
(Create Index) e, então, clique em Editar (Edit) para configurar o campo do 
índice. Posteriormente, você pode especificar os dados que serão 
armazenados em uma coluna.

Como exemplo de quando desmarcar a caixa de seleção Criar índice (Create 
Index), imagine que Nome completo (Full Name) da coluna de SharePoint 
deve conter o nome das pessoas no formato “sobrenome, nome”. Serão 
usados dois campos do índice existente, “Nome” e “Sobrenome”, para 
preencher esta coluna. O mapeamento destes dois campos de índice será 
efetuado mais tarde. Por agora, desmarque a caixa de seleção Criar índice 
(Create Index) para a coluna Nome completo (Full Name) pois o campo do 
índice “Nome completo” não é necessário.

Um Formato de entrada (Input Format) será recomendado para cada novo 
campo do índice baseado nos requisitos dos dados da coluna de SharePoint. 
Você precisa alterar o formato recomendado a menos que deseje restringir 
ainda mais o intervalo ou o tipo de dados.

Um Valor padrão (Default Value) será mostrado se ele tiver sido especificado 
em SharePoint para a coluna. Você pode alterar um valor existente ou 
adicionar um valor padrão se ele não for mostrado selecionando a lista 
suspensa. Uma lista dos valores predefinidos, incluindo todos os códigos de 
barras, OCR ou zonas de detecção de marcas definidos será exibida. Se 
precisar de um valor padrão mais complexo, selecione Editar (Edit). Você 
pode definir o valor padrão usando um ou mais códigos predefinidos ou 
sequências fixas.

A coluna Status indicará se há problemas na criação de um campo do índice. 
Selecionar uma linha com a indicação exibirá uma mensagem de status na 
área abaixo do botão Editar (Edit). Este símbolo indica que um campo do 
índice não será criado para esta coluna SharePoint. Na maioria dos casos, 
isso acontece porque o tipo de coluna pode não ser criado automaticamente 
pelo aplicativo. Por exemplo, o tipo de coluna ‘calculado’ requer referências 
para outras colunas de SharePoint que não são conhecidas pelo aplicativo. 
Você pode criar um campo do índice para esta coluna marcando Criar índice 
(Create Index).

Selecionar uma linha com a indicação  exibirá uma mensagem de status 
na área abaixo do botão Editar (Edit). A mensagem de status descreverá o 
problema e como ele poderá ser resolvido. Esse símbolo indica que há um 
problema na criação do campo do índice que precisa ser resolvido antes de 
continuar. Você pode desmarcar a caixa de seleção Criar índice (Create 
Index) se o campo do índice não for preciso. 

Para adicionar ou editar outros parâmetros do campo do índice como, por 
exemplo, Formato de saída (Output format), Substituir caracteres (Substitute 
Characters) e Lista (List) (para o campos do índice de lista suspensa) 
selecione a linha para o campo do índice apropriado e clique Editar (Edit).
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Etapa 3. Configuração do 
SharePoint: Seleção de 
valores para preencher 
colunas do SharePoint

Agora que criou campos de índice, você pode usar estes campos do índice 
junto com os valores do sistema (Nome do trabalho, Nome do lote, data, hora 
etc.), OCR, códigos de barras e valores de zona de detecção de marcas, ou 
combinações destes valores, para preencher suas colunas do SharePoint.

As colunas de SharePoint que requerem um valor são mostradas no topo. 
Por padrão, o campo do índice criado na Etapa 2 é usado para preencher 
a coluna. Para selecionar um valor diferente, escolha a coluna SharePoint 
e selecione o ícone de alteração. Você pode selecionar um ou mais itens 
a partir da lista, incluindo sequências de texto fixas entre aspas duplas. 
Por exemplo “Criado: ”<DATA_DDMMAA>.

Qualquer coluna do SharePoint que não estava incluída na Etapa 2 (caixa de 
seleção Criar índice (Create Index) não marcada) não mostrará um valor 
padrão. Isso é porque não foi criado nenhum campo de índice para esta 
coluna. Você ainda pode definir um valor para esta coluna usando outros 
campos de índice, valores do sistema, OCR, código de barras ou valores de 
zona de detecção de marcas ou uma combinação destes valores.

OBSERVAÇÃO: a coluna Nome do SharePoint (SharePoint Name) definirá 
o nome do arquivo armazenado em SharePoint. A etapa 
4 descreve como agrupar imagens.

Se agrupar por Múltiplas páginas (Multi-Page) para cada documento, cada 
documento precisa ter um nome único. Por exemplo, Nome (Name) pode ser 
<DOCUMENTO_NUMEROSEQUENCIA>.

Se você agrupar por Página simples (Single page), cada imagem precisa ter 
um nome único o que significa que a coluna Nome (Name) precisa conter um 
valor que será único para cada imagem. Por exemplo, Nome (Name) pode ser 
<IMAGEM_NUMEROSEQUENCIA_DOCUMENTO>.
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Etapa 4. Configuração do 
SharePoint: Definição de 
opções e caminhos de 
armazenamento

A última etapa é especificar o formato das imagens e onde você deseja 
armazenar as imagens no SharePoint.

A Pasta inicial (Starting Folder) é o caminho para uma pasta existente no site 
atual do SharePoint. Os caminhos de imagem especificados para Tudo (All), 
Preto e branco (Black & White) e Colorido/tons de cinza (Color/Grayscale) 
serão iniciados nesta pasta. Selecione Configuração (Setup) para ver as 
pastas disponíveis.

Se você possui imagens em preto e branco e colorido/tons de cinza e todas 
elas precisam ser armazenadas no mesmo local e mesmo formato de 
imagem, marque a caixa de seleção Todas (All).

Selecione o tipo de arquivo (Texto, TIFF, PDF, JPEG etc.) para sua saída. 
Selecione Opções (Options) para configurar o formato do arquivo 
selecionado. Para obter uma descrição das caixas de diálogo de formato de 
arquivo, consulte a seção “Opções de configuração de Arquivo (1) e Arquivo 
(2)” na Configuração de trabalho: Guia saída mais adiante neste capítulo.

Você pode especificar um local de pasta para a imagem na caixa abaixo de 
tipo de arquivo. Selecione Configuração (Setup) para criar o local da pasta 
a partir de valores disponíveis do índice do sistema e de campo.

OBSERVAÇÃO: os botões de instalação permitem especificar o caminho 
e o nome da pasta para armazenar imagens (documentos 
do SharePoint). Cada documento deve ter um caminho 
e nome exclusivos ou o documento pode ser substituído. 
Se você tiver configurado a opção de versões, poderá 
ocorrer um erro de duplicação de nome do arquivo. Verifique 
se o Nome (Name) do SharePoint que você escolheu na 
Etapa 3 é compatível com a seleção de caminho 
e agrupamento das imagens.

Se você tiver apenas imagens em preto e branco ou coloridas/tons de cinza 
ou quiser tipos de arquivos diferentes para as imagens em preto e branco 
e coloridas/tons de cinza, marque as caixas de seleção Preto e branco 
(Black & White) e Colorido/tons de cinza (Color/Grayscale).
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Para fazer check-in de documentos em uma biblioteca de documentos do 
SharePoint com opção de versões ativada, marque a caixa de seleção 
Check-in após upload (Check in after uploading). Se sua lista do SharePoint 
não tiver a opção de versões ativada, um aviso será exibido e a caixa 
desmarcada. Você pode fazer check-in de documentos com um número de 
versão principal (1.0) ou com um número de versão inferior (0.1). Se o seu 
SharePoint não estiver configurado para numeração de versão inferior, um 
aviso será exibido e o número da versão principal será selecionado.

OBSERVAÇÃO: quando o controle de versão do SharePoint é ativado, você 
também pode precisar configurar o SharePoint para Exigir 
o check-out (Require check out).

Ao fazer o check-in, você pode incluir um Comentário de check-in (Check In 
Comment). O comentário pode ser uma mensagem fixa ou clique em 
Configuração (Setup) para escrever um comentário usando os valores do 
sistema e do índice. Por exemplo: <NOME_ESTAÇÃO>“ : ” 
<NOME_USUÁRIO>.

O índice predefinido chamado Número da sequência de imagem (lote) 
(Image Sequence number (batch)) poderá começar em um número específico 
se você marcar a caixa de seleção Numeração contínua de imagem a partir 
de (Continuous image numbering from) e fornecer um valor inicial.

OBSERVAÇÕES:

• Marcar a caixa de seleção Número contínuo da imagem de (Continuous 
image number from) não altera o valor inicial do número de sequência da 
imagem (documento).

• Antes de iniciar o assistente, é recomendado que crie qualquer código de 
barras, OCR ou zonas de detecção de marcas que deseje incluir na saída 
para SharePoint.

Inicie o Assistente de configuração de índice do SharePoint:

• Selecione Arquivo > Configuração de trabalho (File>Job Setup) e, 
depois, selecione o botão Assistente de configuração de índice do 
SharePoint (SharePoint Index Setup Wizard) na parte inferior da caixa de 
diálogo Configuração de trabalho (Job Setup).

Autenticação 
moderna do 
SharePoint

Essa opção permite habilitar a Autenticação moderna (Modern Authentication) 
do SharePoint Online no Assistente de configuração de índice do SharePoint.

OBSERVAÇÃO: essa opção não estará disponível se a opção Usar login 
e senha do Windows (Use Windows login and password) 
estiver selecionada. 

Para criar uma conexão do SharePoint Online:

1. Clique no botão que ativa Usar conta do SharePoint (Use SharePoint 
account) e selecione a opção SharePoint Online.

2. Selecione a opção Autenticação moderna (Modern Authentication), que 
iniciará um processo on-line de autenticação de dois fatores para 
completar a configuração do SharePoint.
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3. Na mensagem pop-up de login, insira o nome de usuário da sua conta do 
SharePoint Online.

4. Quando o nome de usuário for validado, insira a senha da sua conta do 
SharePoint Online para concluir a primeira etapa de login.
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5. Insira o código de verificação enviado para seu celular para concluir 
a segunda etapa de login.

6. Após concluir o login no SharePoint Online, uma mensagem informando 
que a conexão está funcionando será exibida ao clicar em “Testar 
conexão”.

Caso tenha ocorrido alguma falha no login, uma mensagem de erro será 
exibida.

7. Após o login no SharePoint Online, uma janela será exibida mostrando 
a opção de manter a conta do SharePoint conectada, clicando em Sim 
(Yes), ou desconectar após o encerramento da seção, clicando em Não 
(No). Se você clicar em Sim (Yes), a janela de login não será exibida 
quando tentativas futuras de conexão ao SharePoint forem realizadas.

OBSERVAÇÃO: caso você selecione a saída de lotes, o mesmo processo de 
autenticação de dois fatores será iniciado para estabelecer 
a conexão. Após o login, os arquivos serão enviados para 
sua conta do SharePoint Online.

Opções avançadas Quando você seleciona Opções avançadas (Advanced Options), as 
seguintes opções ficam disponíveis: 
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Exclusão automática (Auto-Deletion) — exclui uma imagem da frente ou do 
verso da página quando o tamanho da imagem é inferior aos valores 
especificados na caixa de diálogo Exclusão automática (Auto-Deletion).

Orientação automática (Auto-Orientation) — analisa o conteúdo de seus 
documentos e orienta cada documento para que possa ser lido corretamente. 

Suavização de cor de segundo plano (Background Color Smoothing) — 
usar essa opção para documentos ou formas com uma cor de plano de fundo 
ajudará a produzir imagens com uma cor de plano de fundo uniforme.

Preenchimento de bordas da imagem (Image Edge Fill) — preenche bordas 
pretas ou brancas indesejadas de uma imagem, gerando uma imagem mais 
limpa.

Marcação da imagem (Image Stamping) — marca o número da imagem na 
frente e/ou no verso de cada página. 

Girar (Rotate) — gira todas as imagens em lote 0, 90, 180 ou 270 graus, 
conforme selecionado.

Emendar (Stitch) — mescla todas as imagens de um documento em um único 
arquivo de saída. As imagens devem ser da mesma largura e todas, menos 
a última imagem, devem ser do mesmo tamanho.

Dividir (Split) — converte a imagem de frente e verso em várias imagens. 
As imagens devem ser do mesmo tipo (coloridas/em tons de cinza ou em 
preto-e-branco).

Para acessar as opções de processamento de imagem:

1. Clique em Processamento de imagem (Image Processing) em Opções 
avançadas (Advanced Options) na guia Saída (Output). 

2. Selecione a opção de processamento de imagem desejada e configure-a. 

OBSERVAÇÃO: as seções a seguir fornecem informações detalhadas sobre 
cada opção.
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Exclusão automática A opção Exclusão automática (Auto-Deletion) permite definir opções para 
excluir automaticamente uma imagem sem conteúdo ou páginas com excesso 
de informação (por exemplo: o verso de um formulário com muitas 
explicações). As configurações de exclusão automática são especificadas 
independentemente para imagens de frente e verso. 

Se você estiver digitalizando tipos de imagens em cores, escala de cinza 
e preto e branco, as configurações de exclusão automática também serão 
definidas independentemente. Portanto, você pode optar por excluir somente 
o tipo de imagem selecionado.

Ao usar a opção Exclusão automática (Auto-Deletion), recomenda-se 
digitalizar alguns documentos representativos que você considera em branco 
ou quase em branco usando a opção Teste (Test). Os resultados da opção 
Teste (Test) ajudarão a determinar se você deve definir os valores da exclusão 
automática usando a opção Tamanho da imagem (em bytes) é (Image size 
(byte) is) ou Conteúdo da imagem (em %) (Image content (%)). 

• Tamanho da imagem (em bytes) é (Image size (byte) is) Superior 
a (Above) — selecione essa opção para excluir páginas com excesso de 
informações. Por exemplo, se estiver digitalizando documentos com 
conteúdo semelhante (como formulários de seguro) na frente e no verso da 
página, e se a frente da página tiver algum conteúdo que você deseja 
manter, mas o verso tiver instruções sobre como fazer uma reclamação 
(que você não precisa manter), digite o número de bytes que você quer que 
o Capture Pro Software exclua qualquer arquivo de imagem que exceder 
esse número. Qualquer imagem com tamanho superior a esse valor será 
considerada grande demais e será excluída. 

• Tamanho da imagem (em bytes) é (Image size (byte) is) Inferior a (Below) 
— selecione esta opção se quiser excluir páginas com pouco ou nenhum 
conteúdo. Digite o número de bytes que o Capture Pro Software 
considerará como um arquivo de imagem em branco. Qualquer imagem 
com tamanho inferior a esse valor será considerada em branco e será 
excluída.
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• Conteúdo da imagem (em %) é (Image content (%) is) Superior a (Above) 
— esta opção é semelhante a Tamanho da imagem (em bytes) 
é Superior a, exceto pelo fato de que você deve digitar o valor percentual 
que fará com que o Capture Pro Software considere que a imagem tem 
conteúdo em excesso. Qualquer imagem maior do que esse valor será 
excluída. 

• Conteúdo da imagem (em %) é (Image content (%) is) Inferior a (Below) 
— esta opção é semelhante a Tamanho da imagem (em bytes) é Inferior 
a, exceto pelo fato de que você deve digitar o valor percentual que fará com 
que a imagem seja considerada em branco ou com pouco conteúdo pelo 
Capture Pro Software. Qualquer imagem com tamanho inferior a esse valor 
será considerada em branco e será excluída. Use essa configuração 
quando houver páginas em branco. 

OBSERVAÇÕES:

• Ao selecionar a opção Tamanho da imagem (em bytes) (Image size 
(byte)), outros fatores como resolução, compactação etc. afetarão 
o tamanho da imagem. 

• A opção Conteúdo da imagem (em %) (Image content (%)) apenas verifica 
a porcentagem de informações na imagem e, portanto, é uma opção mais 
consistente e confiável a ser usada quando as imagens tiverem diferentes 
tamanhos, resoluções, compactações etc.

Nunca (Never) — se você nunca quiser excluir imagens, clique em Nunca 
(Never).

Manter imagens em branco (Keep blank images) — quando está opção está 
ativada (selecionada), as imagens em branco ficam destacadas e não são 
excluídas.

Para marcar imagens como “em branco”, clique em Marcar como “em 
branco” (Mark as blank) no menu Ferramentas (Tools) 

ou clique com o botão direito do mouse nas imagens desejadas e selecione 
Marcar como “em branco” (Mark as blank). 

Essa opção fica disponível somente quando há imagens selecionadas. 
As imagens serão marcadas com um contorno vermelho no Visualizador de 
imagens (Image Viewer).

OBSERVAÇÕES:

• Os arquivos de índice de imagens serão preenchidos com o código 
“<IMG_MARKBLANK>” quando a opção Imagem marcada como “em 
branco” (Image marked as blank) for adicionada à coluna Índices atuais: 
(Current indexes:) na caixa de diálogo Configuração do conteúdo do 
índice (Index Content Setup). 

• Se a imagem estiver marcada como “em branco”, <IMG_MARKBLANK> = 
1, caso contrário, o valor = 0.

Orientação automática 
(Auto-orientation) 

Essa opção analisa o conteúdo de seus documentos e orienta cada 
documento para que possa ser lido corretamente. 
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A orientação automática não funciona com todos os conjuntos de caracteres. 
Recomenda-se que alguns documentos de teste sejam digitalizados para 
garantir que o documento será orientado corretamente.

• Você pode selecionar Ativar orientação automática na frente 
(Enable auto-orientation on front) ou Ativar orientação automática no 
verso (Enable auto-orientation on back).

OBSERVAÇÃO: a orientação automática será realizada durante 
o processo de criação de saída.

Suavização da cor do fundo Use esta opção com documentos ou formulários de fundo colorido para gerar 
imagens com cor de fundo mais uniforme. 

As opções de suavização podem ser aplicadas na frente e/ou verso de uma 
página.

Antes da suavização da 
cor do fundo

Após a Suavização da cor 
do fundo
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Você pode selecionar um dos tipos de suavização:

Nenhum (None) — nenhuma suavização será aplicada ao fundo. A imagem 
não será alterada.

Automático (Automatic) — a(s) cor(es) de fundo será(ão) selecionada(s) 
e suavizada(s) automaticamente.

Trocar por branco (Change to White) — identifica até três cores de fundo 
e as substitui por branco. Se você selecionar essa opção, a caixa suspensa 
Aplicar a (Apply to) estará disponível para você selecionar:

• Predominante (Predominant): somente a cor de fundo mais comum será 
modificada para branco.

• Neutro (Neutral): somente a(s) cor(es) de fundo neutra(s) será(ão) 
modificada(s) para branco.

• Todos (All): a(s) cor(es) de fundo será(ão) modificada(s) para branco.

Intensidade (Aggressiveness) — controla a quantidade de variação que pode 
ser corrigida na(s) cor(es) de fundo. Selecione um valor de 1 a 20.

Visualizar (Preview) — abre a caixa de diálogo Visualização da suavização 
da cor do fundo (Background Color Smoothing Preview), que permite 
comparar a imagem original com a alterada e mudar as configurações.

Preenchimento da borda da 
imagem (Image Edge Fill)

Esta opção permite que você preencha e limpe as bordas de uma imagem 
digitalizada cobrindo a área em Preto (Black) ou Branco (White) (conforme 
selecionado). Essa opção pode ser aplicada à frente e ao verso de uma 
imagem.

Você pode usar essa opção para corrigir páginas com imagens irregulares ou 
perfurações.

Original: perfuração de 3 furos 
sem preenchimento de bordas 

da imagem

Imagem com 37 centésimos 
de polegada: preenche 
metade da perfuração. 

O valor não é suficiente.

Imagem com 62 centésimos 
de polegada: preenche toda a 
perfuração e mantém todo o 
texto. O valor é suficiente.

Imagem com 150 centésimos 
de polegada: preenche toda 

a perfuração E parte do texto. 
O valor é alto demais. 
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•  Selecione um valor nas áreas Superior (Top), Esquerda/Direita (Left/
Right) e/ou Inferior (Bottom) de cada lado da imagem digitalizada para ser 
preenchido em centésimos de polegada (1/100) ou selecione Igual em 
todos os lados (All sides match) para preenchimento homogêneo 
em todos os lados.

OBSERVAÇÃO: ao usar Preenchimento de bordas da imagem (Image Edge 
Fill), tenha cuidado para não inserir um valor muito alto, pois 
isso pode provocar o preenchimento de dados da imagem 
que você não quer preencher. 

Marcação da imagem A Marcação da imagem (Image stamping) insere informações como hora, data 
vários números em sequência e nome do lote ou trabalho na imagem 
digitalizada. A caixa de diálogo Marcação de imagem (Image stamping) 
permite inserir essas informações em vários locais da frente ou do verso da 
página. A frente e o verso da página podem ser configurados separadamente. 

Frente/verso (Front/Back): Sequência de registro (Stamp string) — clique 
em Configuração (Setup) para exibir a caixa de diálogo Configuração da 
sequência de registro (Stamp String Setup). Você poderá combinar um ou 
mais itens da lista para criar uma fórmula de sequência de registro. Para obter 
mais informações, consulte “Criação de fórmulas de nome de arquivo e local 
com a caixa de diálogo Configuração do local (Location Setup)” na seção 
“Opções de configuração de Arquivo (1) e Arquivo (2)”, anteriormente neste 
capítulo. 

Local (Location): Superior (Top) ou Inferior (Bottom) — coloca o registro na 
parte superior ou inferior da imagem, conforme selecionado. 

Local (Location): Esquerdo (Left), Central (Middle) ou Direito (Right) — 
coloca o registro à esquerda, no meio ou à direita da imagem, conforme 
selecionado.

Margem (Margin) — selecione um tamanho de margem em centésimos de 
polegada (1/100) para indicar a que distância da margem Superior (Top), 
Inferior (Bottom), Esquerda (Left) ou Direita (Right) o registro deve ser 
colocado.
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Tamanho da fonte (Font size) — selecione o tamanho da fonte do registro: 16 
ou 18 pontos.

Negrito (Bold) — marque esta caixa de seleção para impressão em negrito.

Copiar de frente para trás (Copy front to back) — marque essa caixa de 
seleção se quiser que os mesmos valores que você configurar do verso sejam 
aplicados à frente.

Configuração de uma 
sequência de registro

Para configurar uma sequência de registro de imagem, faça o seguinte:

1. Clique em Configuração (Setup) na seção Frente (Front) ou Verso 
(Back). A caixa de diálogo Configuração da sequência de registro (Stamp 
String Setup) será exibida.

2. Selecione os itens na lista de fórmulas disponível para incluí-los na 
sequência de registro. Para cada item selecionado, clique em Adicionar 
item (Add Item).

OBSERVAÇÕES:

• Os campos Adicionar zeros à esquerda (Add leading zeros) e Extensão 
de número (Number length) ficam disponíveis quando você seleciona 
o seguinte: ID do documento (Document ID), Sequência numérica 
de páginas (Page Sequence Number), Sequência numérica de 
imagens (Image Sequence Number), Endereço de imagem Nível 1 
(Image Address Level 1), Endereço de imagem Nível 2 (Image 
Address Level 2) ou Endereço de imagem Nível 3 (Image Address 
Level 3). Ao selecionar Sequência numérica de páginas (Page 
Sequence Number) ou Sequência numérica de imagens (Image 
Sequence Number) você também poderá especificar quando e com 
que valor elas deverão ser redefinidas.

• Para remover um item da fórmula de sequência de registro, clique em 
Excluir item (Delete Item).

• Para remover um item da fórmula de sequência de registro, clique em 
Excluir fórmula (Delete Formula).

3. Ao concluir a definição da sequência de registro, clique em OK.
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4. Para definir o local da sequência de registro, especifique 
o posicionamento do registro de uma imagem em um dos lados da página. 
A Margem (Margin) define o tamanho da borda entre o texto e a(s) 
borda(s) da página adjacente: na borda direita ou esquerda, 
horizontalmente, e na borda superior ou inferior, verticalmente. Se Centro 
(Middle) for selecionado, a margem só será aplicada à dimensão vertical.

5. Selecione o tamanho desejado da fonte: 16 ou 18.

6. Se desejar negrito, clique em Negrito (Bold).

7. Selecione Copiar de frente para trás (Copy front to back) para duplicar 
a mesma sequência de registro especificada na frente e no verso da 
página de rosto. Do contrário, prossiga para a sequência de registro do 
verso.

8. Quando terminar, clique em OK.

OBSERVAÇÃO: o Capture Pro Software não tenta encaixar o texto na região 
da marcação da imagem. Se um registro de imagem for 
maior que o espaço designado, o excesso de texto ficará 
truncado. É difícil estimar o tamanho do registro da imagem; 
depende da complexidade da fórmula, do tamanho da fonte, 
das margens e da própria sequência. Um teste de 
digitalização é recomendado para verificar se a sequência 
especificada caberá na região da marcação.

Girar (Rotate) Esta opção permite selecionar a rotação desejada: 0, 90, 180 ou 270 graus. 
O grau de rotação se aplica a todas as imagens do lote.

Emendar (Stitch) Permite mesclar todas as imagens do documento em um único arquivo 
contínuo. 
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OBSERVAÇÃO: para usar isso corretamente, todas as imagens devem ter 
a mesma largura e comprimento. Uma configuração de 
página pode ser usada para alterar a largura da imagem. 
Todas as imagens, exceto a última, devem ter o mesmo 
comprimento.

Dividir (Split) Com esta opção selecionada é possível converter a imagem de frente e verso 
em várias imagens(até 6). As imagens devem ser do mesmo tipo (coloridas/
em tons de cinza ou em preto-e-branco). 

Dividir página ou imagem (Split Page or Image) — marque esta caixa de 
seleção para ativar a opção Dividir (Split).

Número resultante de imagens (Number of resultant images) — na lista 
suspensa, escolha de 2 a 6 imagens que você deseja dividir.
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Dividir a imagem se a largura estiver entre (Split image if width is between) 
— use as duas listas suspensas para selecionar o intervalo de larguras da 
página ou imagem. Se a largura da página estiver dentro desse intervalo, ela 
será dividida. Se a frente ou o verso estiver fora do intervalo, nenhum dos dois 
lados será dividido.

Frente e/ou Verso — marque a caixa de seleção Frente (Front) e/ou a Verso 
(Back) para ativar a divisão. Um gráfico será exibido mostrando a seleção. 
Por exemplo, se você marcar as duas caixas de seleção, os dois ícones de 
livro serão exibidos com um “X” vermelho em cada página:

OBSERVAÇÃO: ao usar um scanner somente simples, selecione apenas 
Frente (Front). Selecionar Frente (Front) e Verso (Back) 
fará com que nenhuma divisão seja realizada. 

Ordem de saída (Output order) — a ordem das páginas será exibida nesse 
campo. Clique em cada segmento de imagem na ordem em que você deseja 
que as imagens sejam enviadas. Quando você clica no segmento de imagem, 
o “X” vermelho desaparece.

Os segmentos de imagem que ainda estiverem marcados com um “X” 
vermelho serão excluídos e não serão enviados para a saída. Essa opção 
pode ser útil para a última página de um panfleto que seja sempre em branco.

Redefinir ordem (Reset Order) — as ordens especificadas originalmente 
serão excluídas e você poderá reordenar as imagens.
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Opção Chamar outro 
programa (Invoke 
Other Program)

A opção Chamar outro programa (Invoke Other Program), na guia Saída 
(Output), permite usar um aplicativo que não seja o Capture Pro Software para 
alterar a saída. Marque a caixa de seleção para ativar essa opção.

Nome do programa (Program Name) — digite o nome do aplicativo. 
Se necessário, clique em Procurar (Browse) para procurar o aplicativo.

Parâmetros (Parameters) — os parâmetros podem ser qualquer combinação 
entre sequências literais de textos e valores variáveis, determinados durante 
a produção do lote. Os valores variáveis são definidos clicando em 
Selecionar (Select).

Sequências de textos literais podem ser inseridas na caixa de texto 
Parâmetros (Parameters) ou na janela Fórmula de parâmetro (Parameter 
formula) da caixa de diálogo Configuração de parâmetro (Parameter Setup). 
As sequências literais devem ser separadas por espaços. As sequências 
literais que incluem espaços devem estar entre aspas. 

Para adicionar um parâmetro variável:

1. Clique em Selecionar (Select) para exibir a caixa de diálogo Configuração 
de parâmetro (Parameter Setup) e definir os parâmetros variáveis.
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2. Selecione o parâmetro a ser adicionado na lista de Parâmetros 
disponíveis (Available parameters). 

3. Clique em Adicionar item (Add Item).

OBSERVAÇÕES:

• Você pode clicar em Excluir item (Delete Item) para excluir um parâmetro 
da fórmula, ou excluir uma fórmula completa clicando em Excluir fórmula 
(Delete Formula). 

• Você também poderá inserir sequências literais na caixa de diálogo 
Fórmula de parâmetro (Parameter Formula). Os parâmetros variáveis são 
adicionados à fórmula entre as <> marcas (ex.: <BATCH_NAME>). 

Quando o lote for produzido, o valor real será substituído e transmitido como 
um parâmetro.

Por exemplo, a fórmula de parâmetro <BATCH_NAME> um dois “três quatro” 
produz os quatro parâmetros a seguir:

/BATCH_NAME=Batch99999
um
dois
três quatro

Omitir identificadores “/tagname=” nos parâmetros (Omit “/tagname=” 
identifiers on parameters) — por padrão, os parâmetros são transmitidos para 
o aplicativo chamado precedidos por uma sequência no formato /tagname=, 
onde tagname identifica o tipo de parâmetro (ex.: /BATCH_NAME=Batch001). 
Ao selecionar essa opção, esse identificador será omitido e o programa terá 
que saber o número e a sequência dos parâmetros transmitidos para 
interpretá-los corretamente.

Por exemplo, se Omitir identificadores “/tagname=” nos parâmetros 
(Omit “/tagname=” identifiers on parameters) foi selecionado, a fórmula: 
<BATCH_NAME> um dois “três quatro” deverá produzir os seguintes 
parâmetros:

Batch99999
um
dois
três quatro

Criar arquivo de saída e enviar caminho como parâmetro (Create output 
file and send its path as parameter) — a seleção dessa opção gera um arquivo 
XML contendo os parâmetros. O caminho para esse arquivo será transmitido 
ao programa chamado como o único parâmetro. 
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Local (Location) — clique em Configuração (Setup) para especificar 
a fórmula do caminho e o nome para o arquivo de saída. 

No arquivo XML, as literais das sequências estarão em um elemento 
PARAM_LIST, contendo um elemento PARAM para cada literal.

Os parâmetros variáveis ficarão contidos em elementos que identificam o tipo 
de parâmetro (como <BATCH_NAME>).

Um arquivo de esquema KCCustomApplication.xsd (consulte o Apêndice D) 
pode ser utilizado para validar arquivos XML resultantes, além de servirem de 
referência durante o desenvolvimento do código. 

Por exemplo, o local e a fórmula do nome do arquivo 
<EXPORT_PATH>"\"<BATCH_NAME>"\" e Parameters.XML geram 
o parâmetro C:\BatchesPro\Batch001033841\Parameters.XML.

O arquivo Parameters.XML tinha o seguinte conteúdo:

<?xml version="1.0" encoding="UTF-8" standalone="no" ?> 
<KCCustomApplication xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:noNamespaceSchemaLocation="KCCustomApplication.xsd">

<PARAM_LIST>
 <PARAM>um</PARAM> 
 <PARAM>dois</PARAM> 
 <PARAM>três quatro</PARAM> 
 </PARAM_LIST>
 <BATCH_NAME>Batch001033841</BATCH_NAME> 

</KCCustomApplication>
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Saída remota 
(somente Network 
Edition)

A opção Saída remota (Remote Output) permite transferir lotes para um 
servidor de Saída remota para processamento. Isso é mais útil para trabalhos 
de processamento intensivo que podem abrandar as operações de captura, 
como trabalhos que produzem arquivos PDF pesquisáveis. A configuração de 
servidor de Saída remota está contida em um mapa de servidor que 
é configurado como parte da instalação do Capture Pro Software (consulte 
o Guia do administrador para obter detalhes sobre o Network Edition).

Um ou mais servidores de Saída remota opcionais pode estar presente em 
uma configuração de Edição de rede.

Uma configuração de trabalho pode ser configurada para enviar sempre lotes 
para um servidor de saída particular (Seleção manual) ou distribuir trabalhos 
servidores de saída em um estilo “fatias de tempo” (Seleção automática).

• Se a opção Seleção automática (Auto Select) for selecionada, os lotes 
serão atribuídos em rotação para os servidores de saída disponíveis. Não 
ocorrerá nenhum equilíbrio de carga.

• Se a opção Seleção manual (Auto Select) for selecionada e o servidor 
estiver “inativo”, será retornado um erro para o aplicativo e o usuário terá 
que selecionar manualmente outro servidor ou alterar a configuração do 
trabalho para Seleção automática (Auto Select). 

Quando selecionar os servidores de Saída remota, é importante lembrar que 
os servidores precisam ser configurados corretamente para processarem 
todos os trabalhos enviados para eles. A configuração do servidor não está 
dentro do escopo da instalação da Network Edition. Por exemplo, se um 
trabalho usar a opção Invocar outro programa (Invoke Other Program), 
o programa invocado precisa ser instalado e configurado no servidor de saída. 
Isso aplica-se a todos os tipos de saída, incluindo aqueles que assentam em 
bancos de dados externos ou outros Destinos de saída do sistema.
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Configuração de 
trabalho: 
Configurações 
específicas de 
scanner

Nem todos os scanners têm configurações específicas. Esta seção aplica-se 
somente a scanners que possuem recursos de impressão, correção, lote 
e endereçamento de imagens. Se seu scanner exigir configurações 
específicas, a opção KODAK Scanner: iXXX será exibida no lado esquerdo 
da guia Capturar (Capture). 

Opções do scanner 
(Scanner Options)

Os scanners Kodak Séries i3000/S3000/i4000/i5000/i1800 e Kodak S2085f 
e i2900 incluem a caixa Opções de scanner (Scanner Options), a qual permite 
acesso à Fonte de Dados TWAIN, configuração de mensagens e outras 
opções (por exemplo, impressão, endereçamento de imagens, lote, 
correção etc.) 

OBSERVAÇÃO: opções de impressão, endereçamento de imagens, lote 
e correção são descritos em detalhes no Guia de 
Configuração de Digitalização do scanner. Para obter uma 
cópia do Guia de configuração da digitalização, acesse: 
www.alarisworld.com/go/support e selecione seu scanner.

Opções do scanner (Scanner Options)

Configuração de mensagem (Message Configuration) — exibe a caixa de 
diálogo Configuração de mensagem (Message Configuration). Essa caixa de 
diálogo permite especificar um texto personalizado a ser incluído na 
sequência de impressão. São permitidos no máximo 20 caracteres. Você pode 
ter até seis mensagens exclusivas por sequência. A opção Impressora da 
Fonte de dados TWAIN deve ser ativada e configurada antes de você 
configurar mensagens personalizadas no Capture Pro Software. Consulte 
a próxima seção para procedimentos sobre como personalizar a sequência de 
impressão.

O novo lote começa com o contador em (New batch starts with counter 
equal to) — digite o número com o qual deseja iniciar um novo lote.

Personalização de texto para 
uma sequência de impressão

OBSERVAÇÃO: a configuração da impressora definida no Capture Pro 
Software substituirá qualquer configuração da impressora 
definida na fonte de dados TWAIN.

Quando você clicar neste ícone, a fonte de dados TWAIN será exibida, 
permitindo configurar a impressora, o endereço da imagem e as 
opções de correção, lote e afins. Para obter informações 
e procedimentos sobre o uso da fonte de dados TWAIN, consulte 
a ajuda on-line da fonte de dados TWAIN.
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1. Clique em Configuração de mensagem (Message Configuration). 
A caixa de diálogo Configuração de mensagem (Message Configuration) 
será exibida.

2. Clique em Configurar (Setup) para cada mensagem que desejar 
configurar. A caixa de diálogo Configuração de mensagem (Message 
Setup) será exibida. 

3. Selecione um valor na lista Valores predefinidos (Predefined values) 
e clique em Adicionar item (Add Item).

4. Clique em OK quando terminar.

OBSERVAÇÃO: clique em Excluir item (Delete Item) para remover o último 
valor da fórmula ou em Excluir fórmula (Delete Formula) 
para excluir a fórmula inteira.
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Scanners Kodak Séries 
i5850 e i1850S

Além das opções de scanner anteriormente descritas, os scanners Kodak 
Série i5850 e Kodak i1850S fornecem as seguintes opções.

Opções de endereço de imagem (Image Address Options)

• Excluir páginas de Nível 3 (Delete level 3 pages): este contador está 
associado à parte numérica do nome do lote. Sempre que uma página do 
Nível 3 for digitalizada, o Capture Pro Software criará automaticamente um 
novo lote e descartará a página do Nível 3. 

• Excluir páginas de Nível 2 (Delete level 2 pages): este contador está 
associado ao número do documento do lote atual. Sempre que uma página 
do Nível 2 for digitalizada, o Capture Pro Software criará automaticamente 
um novo documento. 

• Definir endereço da imagem em novo lote (Set image address on new 
batch): define o valor do endereço da imagem quando um novo lote é criado 
manualmente no Capture Pro Software. Esta opção não afeta o endereço 
da imagem quando os lotes são criados automaticamente no Capture Pro 
Software (por exemplo, separação de páginas em branco, separação de 
códigos de barras). Por padrão, o valor de endereço da imagem de um 
novo lote será o seguinte: 

- Campo fixo (Fixed field): o valor-padrão, conforme definido nesta caixa 
de diálogo.

- Nível 3 (Level 3): a parte numérica do nome do lote do Capture Pro 
Software (por exemplo, o valor 19, se o nome do lote for Lote019). 

- Nível 2 (Level 2): Número do documento do Capture Pro Software 
referente ao primeiro documento no lote. 

- Nível 1 (Level 1): 0 se o formato de endereço de imagem for Nível 2 ou 
Nível 3. 
1 se o formato de endereço de imagem for Nível 1. 
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• Definir endereço da imagem na inicialização do scanner (Set image 
address on scanner start): sincroniza nova e automaticamente o endereço 
da imagem do scanner com o lote de digitalização atual no Capture Pro 
Software sempre que o scanner é iniciado. O valor do endereço da imagem 
é definido como o valor que o endereço da imagem deve ter na próxima 
página digitalizada. Essa opção só está disponível quando a opção Definir 
endereço de imagem em novo lote (Set image address on new batch) 
está ativada.

Quando o endereço da imagem do scanner for sincronizado novamente, 
os campos de endereço de imagem serão definidos da seguinte forma: 

- Campo fixo (Fixed field): não será alterado quanto o valor atual do 
scanner. 

- Nível 3 (Level 3): a parte do número do lote do nome de lote do Capture 
Pro Software. 

- Nível 2 (Level 2): o número do documento do Capture Pro Software atual.
- Nível 1 (Level 1): o número de páginas no documento atual, se o formato 

de endereço de imagem for nível 2 ou nível 3. O número de páginas do 
documento atual + 1, se o formato de endereço de imagem for Nível 1.
OBSERVAÇÃO: Em casos de digitalizações simultâneas, a opção 

Definir endereço de imagem ao iniciar o scanner 
(Set image address at scanner start) não 
é recomendável. Isso ocorre porque o número de 
páginas do documento atual não é mantido 
corretamente pelo Capture Pro Software durante 
a digitalização simultânea. Como resultado, a parte do 
Nível 1 do endereço da imagem pode facilmente perder 
a sincronia.

Valor de campo fixo (Fixed field value) — este é um campo de texto ASCII 
estático, que não aumenta nem muda durante a digitalização. Digite o texto no 
campo ou clique em Configuração (Setup), que exibe a caixa de diálogo 
Configuração de valor do campo fixo (Fixed Field Value Configuration). 

OK — salva suas configurações e fecha a caixa de diálogo Configuração de 
trabalho.
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3 Configuração de correção

Sobre os códigos 
de correção 

O Capture Pro Software permite que você separe páginas e documentos no 
seu scanner com páginas que contêm códigos de correção. Ele também 
permite que você crie anexos para seus documentos. Para usar separadores 
de código de correção, é necessário configurar seu trabalho para reconhecer 
códigos de correção.

O Capture Pro Software suporta três tipos de código de correção: 

Você pode definir o método de separação para cada código de correção. Isto 
é útil para trabalhos existentes nos quais códigos de Correção 2 foram usados 
como páginas de separador de documentos em vez de códigos de Correção 
T. Você também pode definir um código de correção para criar um anexo. Para 
novos trabalhos e por questões de compatibilidade, é recomendável que você 
use os códigos de correção da forma como eles foram desenvolvidos.

• Para obter informações sobre a leitura de códigos de correção durante 
a digitalização em cores ou em tons de cinza, consulte “Uso de 
separadores na digitalização em cores”, no capítulo 4.

• Para obter informações sobre como usar códigos de correção em scanners 
Kodak Séries i800 e i1800, consulte “Configuração de trabalho: 
Configurações específicas de scanner”. Quando a leitura do código de 
correção estiver ativada em um scanner Kodak série i800/i1800, não será 
permitida a leitura do código de correção com o Capture Pro Software. 
De modo inverso, quando a leitura do código de correção estiver ativada 
com o Capture Pro Software, a leitura do código de correção não será 
permitida em scanners Kodak série i800/i1800.

Tipo de correção Função Correção 
mantida?

Correção 2 Separa páginas em documentos sim
Correção 3 Separa documentos em lotes não
Correção T 
(programável)

Separa páginas em documentos
Separa documentos em lotes
Cria um anexo 

não
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Configuração de 
códigos de correção
Separação de códigos de 
correção 2, 3 ou T 

As configurações de separação Correção 2 (Patch 2), Correção 3 (Patch 3) 
e Correção T (Patch T) na guia Captura (Capture) da caixa de diálogo 
Configuração do trabalho (Job Setup) permitem configurar o Capture Pro 
Software para reconhecer códigos de correção como separadores entre lotes 
ou documentos no scanner. Cada correção possui sua janela de separação, 
mas os comandos são os mesmos nas três janelas. Você pode configurar 
o sistema para que ele reconheça todos os três códigos de correção ou 
apenas alguns deles.

OBSERVAÇÕES: 

• Se as caixas de seleção Detectar correção (Detect patch) estiverem 
desativadas nas três janelas Código de correção (Patch Code), o leitor de 
correção ficará desativado.

• Se você selecionou Detectar correção (Detect patch) em qualquer uma 
das caixas de diálogo Separação por correção (Separation by Patch), 
o Capture Pro Software verifica cada página para ver o tipo de código de 
correção selecionado.

Detectar correção (Detect patch) — quando esta caixa de seleção está 
marcada, ela ativa a opção Detectar correção (Detect patch).

• Ou procurar em imagens com rotação de 180 graus (Alternatively search 
on 180 rotated images) — se uma leitura de código de correção falhar, essa 
opção girará a imagem e procurará o código de correção novamente. 
Essa opção ajuda a impedir uma falha na leitura do código de correção em 
virtude de uma página ter sido digitalizada de cabeça para baixo.

OBSERVAÇÃO: o software sempre procura códigos de correção nas 
primeiras 4 pol. (10 cm) da parte superior da imagem após 
rotação, enquadramento e corte (se houver). Se uma 
correção for vertical, a imagem deverá ser girada com 
a opção Rotação de software (Software rotation) definida 
na caixa de diálogo Configuração de página (Page Setup). 
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• Ou procurar no verso (Alternatively search on back) — se uma leitura de 
código de correção falhar, essa opção procurará a correção no verso do 
documento. Se o software detectar um código de correção na frente, ele 
não procurará um código de correção no verso.

O que fazer se um código de correção for detectado (What to do if patch 
code is detected) — selecione uma destas opções:

• Separação de lotes (Batch separation): cria um novo lote com um código 
de correção.

- A Correção 3 (Patch 3) normalmente é usada para criar um novo lote.
- Geralmente, a página que contém um código de correção para separação 

de lotes não deve ter nenhum conteúdo. Portanto, o software descarta 
a página de código de correção; a próxima página digitalizada torna-se 
a primeira página do primeiro documento no lote.

• Separação de documentos (Document separation): cria um novo 
documento com um código de correção.

- A Correção 2 (Patch 2) normalmente é usada para criar um novo documento 
e manter a imagem da página que contém o código de correção.

- A Correção T (Patch T) normalmente é usada para criar um novo documento 
e excluir a imagem da página que contém o código de correção.

• Criar anexo (Create attachment): cria um anexo com um código de correção.

• Excluir página (Delete page): exclui a página que contém o código de 
correção que iniciou o novo documento ou anexo. Essa opção é importante 
quando você usa inserções para fins de separação de documentos que não 
contenham nenhuma outra informação.

• Girar documento com base na correção (Rotate document based on 
patch): gira a imagem que contém o código de correção para que ele fique 
localizado na horizontal, na parte superior da página. Todas as imagens do 
documento serão giradas. Essa opção só funciona quando a opção Ou 
procurar em imagens com rotação de 180 graus (Alternatively search on 
180 rotated images) está ativada. 

- A opção Girar documento com base na correção (Rotate document 
based on patch) não funciona quando a página de separação com código 
de correção é descartada. 

OK — fecha a caixa de diálogo e salva suas configurações.

Criação de um anexo 
com um código de 
correção

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Na lista suspensa Nome do trabalho (Job Name), selecione o trabalho que 
exige separação com código de correção.

3. Abra a guia Captura (Capture) e selecione Separação > Código de 
correção (Separation > Patch Code). 

4. Selecione o tipo de correção a ser definido: Correção 2 (Patch 2), 
Correção 3 (Patch 3) ou Correção T (Patch T). A janela Código de 
correção (Patch Code) será exibida.

5. Clique em Detectar correção (Detect patch).

6. Em O que fazer se um código de correção for selecionado (What to do 
if a patch code is selected), selecione Criar anexo (Create Attachment).
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7. Marque todas as outras opções desejadas na janela Código de correção 
(Patch Code). 

8. Clique em OK. 

Separação de lotes ou 
documentos com 
códigos de correção

O Capture Pro Software pode reconhecer códigos de correção como 
separadores entre lotes ou documentos no scanner. 

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Na lista suspensa Nome do trabalho (Job Name), selecione o trabalho que 
exige separação com código de correção.

3. Abra a guia Captura (Capture) e selecione Separação > Por código de 
correção (Separation > By Patch Code). 

4. Selecione o tipo de correção a ser definido: Correção 2 (Patch 2), 
Correção 3 (Patch 3) ou Correção T (Patch T). A janela Código de 
correção (Patch Code) será exibida. Você pode selecionar tantos tipos de 
códigos de correção quantos forem necessários.

5. Clique em Detectar correção (Detect patch).

6. Se desejar, marque uma das seguintes opções ou ambas: Ou procurar 
em imagens com rotação de 180 graus (Alternatively search on 
180 rotated images) e/ou Ou procurar no verso (Alternatively search 
on back). 

7. Em O que fazer se um código de correção for selecionado (What to do 
if a patch code is selected), selecione Separação de documentos 
(Document Separation) ou Separação de lotes (Batch Separation).

8. Marque outras opções que desejar. 

9. Clique em OK. 
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4 Configuração do código de barras, OCR e detecção de marcas

Visão geral Para usar códigos de barras, as zonas de OCR ou de detecção de marcas 
para indexação na configuração de seu trabalho, faça o seguinte:

• Selecione a configuração de página que será usada na digitalização para 
este tipo de trabalho.

• Edite a configuração do trabalho.

• Digitalize uma página para usar como modelo na definição do seu código 
de barras, OCR ou zona de detecção de marcas.

• Defina onde a zona do código de barras, OCR ou detecção de marcas se 
localizará na imagem do modelo.

• Especifique como um valor correto de código de barras, OCR ou zona de 
detecção de marcas será reconhecido.

• Defina as páginas onde você quer aplicar as zonas.

Além disso, para usar códigos de barras ou zonas de OCR para separação na 
configuração do trabalho você precisa fazer o seguinte:

• Configurar as ações relacionadas a essa zona de código de barras ou OCR 
(por exemplo, criar um novo lote, criar um novo documento no lote atual ou 
preencher um ou mais campos de índice).

Este capítulo explica essas etapas, com exceção do preenchimento dos 
campos de índice. Veja informações sobre o preenchimento de campos de 
índice no Capítulo 2, Configuração do trabalho.

Uso de códigos de 
barras

O código de barras é um método para codificar dados em um código legível 
por máquina, consistindo em uma organização paralela de elementos claros 
e escuros. Os elementos claros são os “espaços” e os escuros são as 
“barras”. As barras e espaços são largos ou estreitos. A combinação de barras 
e espaços largos e estreitos é um código de barras. Cada código de barras 
começa com um caractere de “início” e termina com um caractere de 
“interrupção”. A indústria usa códigos de barras para oferecer entrada de 
dados mais precisa e eficiente do que a possível com o uso de entrada de 
dados manual.

A configuração de código de barras permite definir:
• o nome do código de barras
• a máscara de dados ou sintaxe
• o local físico onde encontrar o código de barras (em uma zona ou em 

qualquer lugar da imagem)
• o tipo do código de barras (largura, altura, qualidade e nível de segurança)
• o nível onde você pode encontrar o código de barras (lote, documento ou 

página)

• fonte para capturar o código de barras

Siga estas dicas para maximizar o desempenho do Capture Pro Software:
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• Escolha o nome da Configuração de página a ser usada para a digitalização 
antes de definir uma zona de código de barras.

• Verifique se todas as superfícies de vidro do transporte (as guias de vidro 
ou o vidro que fica sobre a área da câmera) do scanner estão limpas. 
Superfícies sujas provocam taxas de leitura insatisfatórias.

• Use uma resolução mais alta para obter taxas de leitura melhores 
(300 x 200 dpi).

• Verifique o posicionamento da zona em torno do código de barras; ela pode 
afetar o nível de segurança de um código de barras. Deixe pelo menos 
meio centímetro de espaço ao redor do código de barras para garantir que 
todo ele esteja dentro da zona. Mova a zona em torno do código de barras 
até atingir a taxa de confiança mais alta possível.

• A especificação mínima de altura do código de barras é de 40 pixels. 
A 200 dpi, 40 pixels são 5 milímetros; a 300 dpi, 40 pixels são 3,4 milímetros. 
No caso de códigos de barras com menos de 40 pixels de altura, 
especifique a altura do código de barras na caixa de diálogo Configuração 
de zona de código de barras (Bar Code Zone Setup).

• Verifique se o tipo e a orientação selecionados para o código de barras 
estão corretos na caixa de diálogo Configuração de zona de código de 
barras (Bar Code Zone Setup).

• Se os códigos de barras estiverem em documentos com planos de fundo 
coloridos, talvez seja necessário reduzir o valor do limite na caixa de 
diálogo Configuração de zona de código de barras (Bar Code Zone Setup) 
para melhorar as taxas de leitura.

• Se possível, use códigos de barras de média ou baixa densidade. Códigos 
de barras de alta densidade podem exigir um valor de limite mais baixo na 
caixa de diálogo Configuração de zona de código de barras (Bar Code Zone 
Setup).

• Para alcançar taxas de leitura melhores em códigos de barras mais difíceis, 
reduza o nível de Qualidade (Quality) na caixa de diálogo Configuração de 
zona de código de barras (Bar Code Zone Setup).

• Se usar zonas de código de barras do tipo Qualquer lugar (Anywhere), use 
um PC com um processador de 2,8 GHz ou superior. Isso garantirá 
a capacidade do Capture Pro Software de digitalizar na velocidade nominal 
do scanner quando a leitura de código de barras estiver ativada.

Janela Código de 
barras, OCR e 
detecção de marcas 
(Bar Code, OCR & 
Mark Detection)

A janela Código de barras, OCR e detecção de marcas (Bar Code, OCR & 
Mark Detection) permite digitalizar e manipular uma imagem, e criar uma zona 
de código de barras, OCR ou de detecção de marcas.

Para acessar a janela Código de barras, OCR e detecção de marcas 
(Bar Code, OCR & Mark Detection):

1. Abra a caixa de diálogo Configuração do trabalho (Job Setup).
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2. Clique em Código de barras, OCR e detecção de marcas (Bar Code, 
OCR & Mark Detection) na guia Capturar (Capture).

OBSERVAÇÃO: configurar oito ou mais zonas de código de barras para um 
trabalho pode reduzir a velocidade da digitalização.

Imagem (Image) — se desejar, selecione uma imagem preexistente na lista 
suspensa. A lista suspensa Imagem (Image) contém todas as imagens que 
foram digitalizadas para a configuração do código de barras. É necessário que 
você tenha, no mínimo, uma imagem nessa lista antes de definir uma zona de 
detecção de código de barras, OCR ou marca.

OBSERVAÇÃO: em configurações de trabalho típicas usando zonas código 
de barras, de OCR ou de detecção de marcas, basta uma 
única imagem. Várias imagens são necessárias para 
configurações de trabalho que têm folhas de cabeçalho em 
lote e documento, cada uma contendo informações de 
código de barras, OCR ou de detecção de marcas. 

Zonas (Zones) — exibe o nome de uma zona de código de barras, de OCR ou 
de detecção de marcas. Quando você clicar em uma das zonas listadas, 
a imagem na área de exibição onde a zona está localizada será realçada. 
Qualquer zona de código de barras, OCR ou de detecção de marcas que você 
definir será exibida na imagem atual, mesmo se você tiver definido essas 
zonas usando uma imagem diferente.

Ícones

Iniciar/Digitalizar (Start/Scan) — abre a caixa de diálogo 
Digitalizar imagem (Scan Image), que permite inserir o nome de 
uma imagem e digitalizar uma imagem que contenha códigos de 
barras ou segmentos de texto de OCR ou áreas de marcas.
OBSERVAÇÃO: o software Capture Pro usará a configuração 

de página que estiver selecionada no 
momento quando Iniciar/Digitalizar (Start/
Scan) for selecionado.
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Demarcar região (Draw region) — permite que você trace um 
retângulo em torno de um código de barras, segmento de texto 
de OCR ou área de marcas na imagem digitalizada e, depois, 
exibe a caixa de diálogo Configuração de zona de código de 
barras, a caixa de diálogo Configuração de zona de OCR 
(Bar Code Zone Setup, OCR Zone) ou a caixa de diálogo 
Configuração de zona de detecção de marcas (Mark Detection 
Zone Setup).
Ampliar (Magnify) — amplia uma parte da imagem. Para 
ampliar qualquer área da imagem, posicione a ferramenta 
Ampliar (Magnify) sobre a área e mantenha o botão do mouse 
pressionado.
Panorama (Pan) — permite que você mova a imagem em torno 
do visualizador quando ela for maior do que a janela Código de 
barras, OCR e detecção de marcas (Bar Code, OCR & Mark 
Detection).
Mais zoom (Zoom in) — amplia a imagem.

Menos zoom (Zoom out) — reduz a imagem.

Ajustar janela (Fit window) — altera a exibição da imagem de 
forma que ela caiba na janela Código de barras, OCR e 
detecção de marcas.
Tamanho real (Actual size) — exibe a imagem em seu tamanho 
real. Um pixel digitalizado é igual a um pixel na janela Código de 
barras, OCR e detecção de marcas.
Testar zona selecionada do código de barras, OCR ou 
detecção de marcas (Test selected bar code, OCR or Mark 
Detection zone) — abre a caixa de diálogo Valores do código de 
barras, de OCR e de detecção de marcas (Bar Code, OCR and 
Mark Detection Values), que permite visualizar os resultados 
dos testes em uma zona selecionada.
Testar todas as zonas selecionadas do código de barras, 
OCR ou detecção de marcas (Test all selected bar code, OCR 
or Mark Detection zones) — abre a caixa de diálogo Valores do 
código de barras, de OCR e de detecção de marcas (Bar Code, 
OCR and Mark Detection Values), que permite visualizar os 
resultados dos testes em todas as zonas selecionadas.
Criar código de barras (Create barcode) — permite que você 
crie uma zona de código de barras a partir da imagem exibida 
na janela Código de barras, OCR e detecção de marcas 
(Bar Code, OCR & Mark Detection).
Criar zona de OCR (Create OCR zone) — permite que você 
crie uma zona de OCR a partir da imagem exibida na janela 
Código de barras, OCR e detecção de marcas (Bar Code, 
OCR & Mark Detection).
Criar zona de detecção de marcas (Create mark detection 
zone) — permite que você crie uma zona de detecção de 
marcas a partir da imagem exibida na janela Código de barras, 
OCR e detecção de marcas (Code, OCR & Mark Detection).
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OK — fecha a caixa de diálogo e salva suas configurações.

Menu contextual das 
janelas Código de 
barras, OCR e 
detecção de marcas 
(Bar Code, OCR & 
Mark Detection)

Quando você clicar com o botão direito do mouse em uma imagem na janela 
Código de barras, OCR e detecção de marcas (Bar Code, OCR & Mark 
Detection), um menu contextual será exibido. Se nenhuma zona de código de 
barras, OCR ou de detecção de marcas estiver selecionada, um menu mais 
limitado será exibido.

Recortar (Cut) — remove a zona selecionada do código de barras, OCR ou 
de detecção de marcas. Se desejar, você pode colar este código de barras, 
OCR ou detecção de marcas em outra localização na mesma imagem, 
clicando com o botão direito do mouse na zona e arrastando para a nova 
localização.

Propriedades da zona (Zone properties) — abre a caixa de 
diálogo Configuração de zona de código de barras (Bar Code 
Zone Setup), Configuração de zona de OCR (OCR Zone Setup) 
ou Configuração da zona de detecção de marcas (Mark 
Detection Zone Setup), que permite visualizar as propriedades 
das zonas selecionadas de código de barras, de OCR ou de 
detecção de marcas.
Selecionar páginas a aplicar a todas as zonas (Select pages 
to apply for all zones) — abre a caixa de diálogo Configuração 
de páginas da zona (Zone Pages Setup), que permite selecionar 
as páginas a serem aplicadas às zonas definidas de OCR, 
código de barras ou detecção de marcas. Para mais 
informações, consulte “Caixa de diálogo Configuração das 
zonas das páginas (Zone Pages Setup)”, mais adiante neste 
capítulo.
Excluir zona selecionada (Delete selected zone) — permite 
que você exclua uma zona do código de barras, OCR ou de 
detecção de marcas. Uma caixa de confirmação será exibida 
para verificar sua opção.
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Copiar (Copy) — copia o código de barras, OCR de detecção de marcas 
selecionado. Copiar também é útil quando várias zonas de código de barras, 
OCR ou detecção de marcas de propriedades exatamente iguais (exceto pelo 
local) são necessárias. Após definir a primeira zona, use a opção Colar 
(Paste) para duplicá-la. Após criar as zonas duplicadas, mova cada uma delas 
clicando com o botão esquerdo do mouse na zona e arrastando-a para 
a localização desejada. 

Colar (Paste) — cola uma zona de código de barras, de OCR ou de detecção 
de marcas copiada ou recortada na imagem atual. A opção Colar (Paste) 
aparecerá nesse menu apenas se você tiver copiado uma imagem ou 
sequência de texto para a área de transferência. Ao colar uma zona de código 
de barras, de OCR ou de detecção de marcas, as coordenadas da zona 
referentes àquela salva são usadas para determinar o local da zona. 
Se a zona colada estiver no local incorreto, você poderá clicar com o botão 
esquerdo do mouse na zona e movê-la para a localização desejada.

Colar é útil junto com Copiar, quando você copia as propriedades da zona de 
código de barras para outra imagem que contenha códigos de barras no 
trabalho.

Testar zona (Test Zone) e Testar todas as zonas (Test All Zones) — tenta ler 
a zona selecionada de código de barras, OCR ou detecção de marcas ou 
todas as zonas de acordo com um valor. A caixa de diálogo Valores do código 
de barras, de OCR ou de detecção de marcas (Bar Code, OCR and Mark 
Detection Values) será exibida. 

Essa caixa fornece as seguintes informações:

• Etiqueta (Label) indica o nome atribuído à zona de código de barras, OCR 
ou detecção de marcas na caixa de diálogo Zona do código de barras 
(OCR/detecção de marcas) (Bar Code (OCR/Mark Detection) Zone).

• Tipo (Type) indica o tipo de código de barras encontrado na zona. 
Se a zona for de OCR, o Tipo (Type) será OCR. Se a zona for uma zona 
de detecção de marcas, o Tipo (Type) será Detecção de marcas 
(Mark Detection).

• Nível de segurança (Confidence level) (em um percentual) do valor do 
código de barras encontrado.

• Orientação (Orientation) da zona do código de barras, de OCR ou de 
detecção de marcas.
0° representa uma zona de código de barras, OCR ou detecção de marcas 
na horizontal, com o lado direito para cima.
90° representa uma zona de código de barras, OCR ou detecção de marcas 
na vertical, com o topo para a esquerda.
180° representa uma zona de código de barras, OCR ou detecção de 
marcas na horizontal, de cabeça para baixo.
270° representa uma zona de código de barras, OCR ou detecção de 
marcas na vertical, com o topo para a direita.

• Valor (Value) da zona de código de barras, OCR ou detecção de marcas.
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• As coordenadas Zona X (Zone X) e Zona Y (Zone Y) do canto superior 
esquerdo da zona de código de barras, de OCR ou de detecção de marcas. 
As coordenadas são em centésimos (1/100) de polegada e representam 
a distância da zona do canto superior esquerdo da imagem.

• Largura da zona (Zone Width) e Altura da zona (Zone Height) do código 
de barras, de OCR ou de detecção de marcas em centésimos (1/100) de 
polegada.

OBSERVAÇÃO: se um valor de código de barras, OCR ou detecção de 
marcas não puder ser encontrado para uma zona, esta ainda 
será incluída na lista de valores com apenas as coordenadas 
de etiqueta e zona exibidas.

Propriedades da zona (Zone Properties) — permite que você defina as 
propriedades da zona de código de barras, de OCR ou de detecção de 
marcas selecionada. A caixa de diálogo Zona do código de barras (OCR/
Detecção de marcas) (Bar Code (OCR/Mark Detection) Zone) será exibida. 
Consulte “Caixa de diálogo Configuração de zona de código de barras (Bar 
Code Zone Setup)”, “Caixa de diálogo Configuração de zona de OCR (OCR 
Zone Setup)” ou “Caixa de diálogo Configuração da zona de detecção de 
marcas (Mark Detection Zone Setup)” posteriormente neste capítulo para 
obter mais informações.

Propriedades gerais (General Properties) — permite que você defina as 
propriedades que se aplicarão a todas as zonas do código de barras, de OCR 
e da detecção de marcas. Isso é útil quando você usa folhas de cabeçalho de 
código de barras para a separação e indexação de documentos que tenham 
menos conteúdo do que o restante das páginas do documento. Essa opção 
pode aumentar o desempenho da digitalização para o aplicativo de código de 
barras/detecção de marcas/OCR. 

Quando você selecionar essa opção, a caixa de diálogo Propriedades gerais 
de código de barras e OCR (General Bar Code and OCR Properties) será 
exibida. 

1. Selecione a caixa de seleção Extrair códigos de barras/OCR de 
imagens que tenham (Extract bar codes/OCR from images between) 
para ativar essa opção. 

2. Insira um valor no campo bytes mínimos (minimum bytes) (o padrão 
é 1.000 bytes) e bytes máximos (maximum bytes) (o padrão é 100.000 
bytes). Os valores digitados nestes campos limitam as imagens das quais 
códigos de barras, texto de OCR ou de detecção de marcas serão lidos 
a somente aqueles cujo tamanho esteja entre esses valores.

3. Clique em OK.

Renomear imagem (Rename Image) — solicita que você renomeie a imagem 
exibida no momento. Ao nomear ou renomear uma imagem, escolha um 
nome de imagem que seja exclusivo do Capture Pro Software. Não 
é necessária uma extensão de arquivo.

OBSERVAÇÃO: caracteres especiais como: “ ? * . < > \ / não são permitidos 
no nome da imagem.
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Excluir imagem (Delete Image) — remove a imagem atual do trabalho. Antes 
que sua imagem seja excluída, uma caixa de confirmação será exibida para 
verificar sua opção. Se outras imagens permanecerem na lista de imagens, a 
imagem que antecede a excluída será exibida em seu lugar. 

As definições da zona do código de barras, de OCR e de detecção de marcas 
não são afetadas quando você exclui uma imagem, desde que tenha outras 
imagens na lista de imagens. Entretanto, se a imagem a ser excluída for a 
última da lista, a seguinte mensagem será exibida: Esta é a última imagem. 
Excluindo esta imagem também são excluídas todas as zonas do código 
de barras, de OCR e de detecção de marcas. Deseja excluir esta 
imagem? (Deleting this image also deletes all bar code, OCR or mark 
detection zones. Do you want to delete this image?)

Se você clicar em Sim (Yes), todas as suas definições da zona do código de 
barras, de OCR ou de detecção de marcas para o trabalho também serão 
excluídas. Lembre-se de que deve haver uma imagem na lista de imagens 
para que as zonas do código de barras, de OCR ou de detecção de marcas 
possam ser definidas. Se você excluir a última imagem, também excluirá 
todas as zonas do código de barras, OCR e de detecção de marcas.

Excluir zona (Delete Zone) — exclui a zona selecionada do código de barras, 
de OCR ou de detecção de marcas. Uma caixa de confirmação será exibida 
antes que a zona seja excluída.

Excluir todas as zonas (Delete All Zones) — exclui todas as zonas do código 
de barras, de OCR e de detecção de marcas definidas para este trabalho. 
Uma caixa de confirmação será exibida antes que as zonas sejam excluídas. 

Digitalização de uma 
imagem para a 
configuração do 
código de barras

O Capture Pro Software permite que você separe páginas e documentos no 
seu scanner com páginas que contêm códigos de barras. Ele também permite 
que você crie anexos para seus documentos usando esses separadores de 
códigos de barras. 

Para usar códigos de barras como separadores, é necessário:

• Digitalizar uma imagem com os códigos de barras para o Capture Pro 
Software.

• Traçar e selecionar as zonas de códigos de barras. 

• Configurar o trabalho para separação por zona de código de barras.

O Capture Pro Software permite que você digitalize imagens de códigos de 
barras diretamente na janela Código de barras (Bar Code) para exibição, 
definição e edição.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).
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3. Abra a guia Captura (Capture) e selecione Separação > Por zonas do 
código de barras (Separation > By Bar Code Zones). A janela Código de 
barras (Bar Code) será exibida.

4. Selecione o botão verde Iniciar/Digitalizar (Start/Scan). A caixa de 
diálogo Digitalizar imagem (Scan Image) será exibida.

5. Posicione o documento original no alimentador e clique em Iniciar/
Digitalizar (Start/Scan). A imagem será exibida na caixa de diálogo. 
Digitalize a imagem da maneira mais reta possível. Seu scanner usará os 
parâmetros de configuração de página atual do Capture Pro Software.

OBSERVAÇÕES: 
• Quaisquer configurações de rotação automática, corte automático 

e correção de distorção serão também aplicadas à imagem digitalizada 
antes de sua exibição.
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• Se a imagem estiver aceitável, digite um nome para ela no campo Nome 
da imagem (Image name). O nome da imagem não deve conter nenhum 
destes caracteres: : “? * . < > \ / . 

• Para descartar a imagem, clique em Cancelar (Cancel).

6. Clique em OK para salvar a imagem. 

OBSERVAÇÕES:

• Antes de definir um código de barras, é necessário salvar pelo menos uma 
imagem na lista suspensa Imagem (Image).

• Você também pode transferir uma imagem do Visualizador de imagens 
(Image Viewer) para a janela Código de barras (Bar Code). Consulte 
“Transferência de uma imagem para a janela Código de barras (Bar Code)” 
a seguir neste mesmo capítulo.

Criação e seleção de 
uma zona de código de 
barras

Antes de usar uma imagem de código de barras para indexar ou separar 
documentos ou lotes, é necessário criar e selecionar uma zona de código de 
barras. As zonas de código de barras são criadas para indicar onde procurar 
um código de barras que satisfaça suas propriedades de zona de código de 
barras.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).

3. Abra a guia Captura (Capture) e selecione Separação > Por zonas do 
código de barras (Separation > By Bar Code Zones). A janela Código de 
barras (Bar Code) será exibida.

4. Selecione uma imagem na lista suspensa Imagem (Image). Se você 
precisar digitalizar a imagem, clique no ícone verde Iniciar/Digitalizar 
(Start/Scan) na janela Código de barras (Bar Code). 

OBSERVAÇÕES:

• Posicione o cursor do mouse no canto superior esquerdo da área da 
imagem onde você deseja definir a localização dessa zona de código de 
barras.

• As zonas de código de barras estão relacionadas a um trabalho 
específico, e não a uma determinada imagem. Portanto, quando você 
cria uma nova imagem, o Capture Pro Software exibe as zonas que você 
definiu usando imagens anteriores.

• Ao traçar a localização de uma zona de código de barras, deixe uma 
borda de aproximadamente 6 mm ao redor do código de barras. Essa 
borda geralmente é necessária para a leitura correta do código de 
barras. As zonas de código de barras podem se sobrepor.

5. Mantenha pressionado o botão esquerdo do mouse e arraste o cursor 
para traçar um retângulo ao redor da área do código de barras. Os códigos 
de barras definidos com a posição Zona (Zone) selecionada na caixa de 
diálogo Configuração de zona de código de barras (Bar Code Zone Setup) 
ficarão em uma caixa vermelha, enquanto os definidos com Qualquer 
lugar (Anywhere) ficarão em uma caixa azul. Depois que você traçar 
o retângulo, a caixa de diálogo Configuração de zona de código de barras 
(Bar Code Zone Setup) será exibida. 

6. No campo Nome da zona (Zone name), insira um nome para a nova zona 
de código de barras. É necessário criar um nome para salvar a zona.
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7. Depois de digitar as outras configurações, clique em OK para fechar 
a caixa de diálogo e voltar à janela Código de barras (Bar Code). Consulte 
“Caixa de diálogo Configuração de zona de código de barras (Bar Code 
Zone Setup)” para ver descrições de campo.

8. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). 

Caixa de diálogo 
Configuração de zona de 
código de barras (Bar 
Code Zone Setup)

Use esta caixa de diálogo para nomear sua zona de código de barras e 
descrever como reconhecer um código de barras válido para essa zona, além 
de especificar qualquer separação de código de barras.

Nome da zona (Zone name) — insira o nome da sua nova zona de código de 
barras. Esse nome identifica o código de barras e aparece na configuração do 
índice como BC_[nomedazona] na lista de valores padrão. A Etiqueta (Label) 
do código de barras (na caixa de diálogo Código de barras e Valores OCR 
(Barcode and OCR Values)) não define ou identifica um campo de índice do 
Capture Pro Software.

Face: (Side:) Frente (Front) ou Verso (Back) — selecione se o código de 
barras deve ficar localizado na frente ou no verso de uma imagem.

Manter os códigos de barras com a máscara (Keep bar codes with mask) 
— use essa opção quando uma ou mais zonas de código de barras do tipo 
Qualquer lugar (Anywhere) forem definidas. O valor do código de barras 
somente será mantido para a zona definida quando ela for compatível com 
a máscara especificada no campo Manter os códigos de barras com a 
máscara (Keep bar codes with mask). Isso assegura que os valores dos 
códigos de barras sejam lidos em uma página atribuída à zona de código de 
barras correta.
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Essa opção também é útil quando mais de uma zona de código de barras 
estiver no mesmo local físico em uma página, mas tiver valores e significados 
diferentes (por exemplo: uma zona definida para uma folha de cabeçalho de 
lote versus uma zona definida para uma folha de cabeçalho de documento). 
Para ser compatível com uma máscara especificada, cada caractere do valor 
do código de barras deve corresponder à sintaxe da máscara referente 
à posição desse caractere na máscara. 

Por exemplo, uma máscara de A<8> manterá um valor de código de barras de 
até no máximo oito caracteres alfabéticos:

Valor do código de barras mantido?
CIRURGIA Sim
ADMISSÃO Não

Se aplicável, insira o valor da máscara.

Comprimento mínimo (Minimum length) — insira um número para 
o comprimento mínimo do valor do código de barras. Por padrão, essa opção 
é definida como o comprimento do valor do código de barras testado. Se um 
valor não for encontrado ou o valor for igual ou maior do que seis caracteres, 
o padrão será definido como “6”. É recomendado que o parâmetro de 
comprimento mínimo seja definido como seis caracteres ou menos para 
permitir que o Capture Pro Software mantenha valores de código de barras 
em casos de uma leitura parcial.

Se a opção Leitura parcial (Partial Reading) não for necessária ou não 
estiver ativada, as configurações de máscara e comprimento mínimo poderão 
ser usadas em conjunto para restringir ainda mais os valores de código de 
barras mantidos. 
Por exemplo:
Máscara: 9(10)
Bytes mínimos: 6

mantém valores de código de barras entre seis e dez dígitos, enquanto

Máscara: 9(10)
Comprimento mínimo: 10

mantém os valores de código de barras somente se eles tiverem 
exatamente dez dígitos. 

Largura do código de barras e Altura do código de barras (Bar code width 
e Bar code height) — se o código de barras tiver um comprimento ou altura 
fixo, insira esses valores em centésimos (1/100) de polegada. Uma entrada 
em um desses campos ou em ambos aumenta o desempenho da leitura de 
código de barras. Se uma das dimensões for variável, insira 0. O valor 
padrão é 0.

As dimensões do código de barras pode variar, dependendo do valor de 
inclinação. Portanto, é recomendado que você insira esses valores somente 
quando tiver certeza das dimensões do código de barras.

OBSERVAÇÃO: é necessário especificar a altura do código de barras para os 
códigos cuja altura for menor do que 40 pixels (por exemplo: 
em 200 dpi, 40 pixels são 0,508 cm).

Ao especificar a largura e/ou altura de um código de barras, a tolerância 
é ±10% (por exemplo, se você especificar 0,508 cm para a altura do código de 
barras, qualquer código de barras entre 0,457 cm e 0,558 cm será detectado). 
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Tipo (Type) — você também pode selecionar tipos de código de barras 
adicionais que serão considerados válidos para essa zona. Embora não seja 
comum que mais de um tipo de código de barras seja encontrado em uma 
zona, é possível selecionar vários tipos. Para mais informações sobre tipos de 
códigos de barra, consulte “Tipos de código de barras”, posteriormente neste 
capítulo. 

Quanto mais tipos de código de barras você selecionar, mais lenta será 
a digitalização. 

Quando você traça um local de código de barras, o Capture Pro Software 
procura todos os tipos de código de barras nesse local. Quando encontra, 
o software define o Tipo de código de barras como o que foi encontrado. 
Caso contrário, não é selecionado um tipo de código de barras. Existem duas 
exceções:

• No caso de códigos de barras dos tipos Código 39 estendido e Código 39 
HIBC, o Capture Pro Software pode definir o tipo de código de barras como 
Código 39. Por isso, talvez você precise selecionar manualmente Código 
39 estendido (Code 39 Extended) e Código 39 HIBC (Code 39 HIBC).

• No caso de códigos de barra MSIPH, o Capture Pro Software pode definir 
o tipo de código de barras como MSI. Por isso, talvez você precise 
selecionar manualmente MSIPH.

Caixa de diálogo Zona do 
código de barras (Bar code 
zone) (continuação)

Verificar checksum (Verify checksum) — marque essa caixa se o código de 
barras contiver um caractere de checksum. Caracteres de checksum ajudam 
a assegurar a precisão da leitura de código de barras. Nem todos os tipos de 
códigos de barras suportam a verificação de checksum. Os seguintes tipos de 
código de barras suportam opcionalmente a verificação de checksum:

Código 3 de 9
CODABAR
Intercalado 2 de 5

Alguns tipos de códigos de barras como PDF417, UPC e EAN têm uma rotina 
de checksum incorporada que não pode ser desativada.

Se você desativar o recurso Verificar checksum (Verify checksum) para 
códigos de barras que contêm uma checksum, o valor dela (geralmente 
o último caractere do código de barras) será exibido no valor do código de 
barras; caso contrário, o dígito de verificação permanecerá oculto.

Se a verificação de checksum falhar durante a digitalização, um valor de 
código de barras não será gerado, fazendo com que as auditorias de campo 
de índice do Capture Pro Software falhem. Alguns tipos de código de barras, 
como o Código 128, possuem caracteres de checksum obrigatórios. O código 
está sempre presente e deve estar correto para o valor ser lido. Outros 
códigos, como o Código 39, possuem caracteres de checksum opcionais que 
adicionam um código extra quando estão presentes. 

Para ler símbolos de Código 128 inválidos, você pode selecionar a opção 
Mínimo de caracteres parcialmente lidos (Minimum partial read characters). 
Essa opção fará com que os caracteres de dados sejam informados mesmo 
se a checksum falhar. A checksum inválida não será retornada. Quando 
o código de barras possuir uma checksum opcional, ela não será validada 
pelo software. Ela operará de acordo com a especificação do código de 
barras. 
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A seleção da opção Mínimo de caracteres parcialmente lidos (Minimum 
partial read characters) para um código de barras com uma checksum 
opcional retornará o que for encontrado, independentemente de estar correto 
ou não. Haverá ocasiões em que o código de barras retornará o resultado 
correto, mas a checksum propriamente dita falhará. Como a checksum está 
implícita, ela não retornará e nem poderá ser diretamente testada.

Mínimo de caracteres parcialmente lidos (Minimum partial read characters) 
— marque essa caixa de seleção quando desejar que o Capture Pro Software 
gere um valor de código de barras, mesmo se o código de barras estiver 
incompleto. Se essa opção estiver selecionada, insira o número mínimo de 
caracteres que serão permitidos para uma leitura parcial. Isso é útil para 
códigos de barras que são usados apenas para separação de documentos ou 
lotes, em que o valor absoluto é menos crítico.

Para fins de indexação, recomenda-se que as máscaras de campo e os 
comprimentos mínimos sejam definidos. O Capture Pro Software não 
produzirá nenhum valor de código de barras se ele estiver incompleto 
e o campo Mínimo de caracteres parcialmente lidos (Minimum partial read 
characters) estiver desativado.

OBSERVAÇÃO: a opção Mínimo de caracteres parcialmente lidos 
(Minimum partial read characters) não deve ser usada 
quando o recurso Verificar checksum (Verify checksum) 
estiver ativado, pois isso pode fazer com que um valor de 
código de barras seja gerado quando a verificação de 
checksum falhar. 

Filtrar (Filtering) — ao ler códigos de barras produzidos por máquinas de fax 
ou outros dispositivos que possam ter eliminação de pixel de CCD, o uso de 
filtros pode melhorar a taxa de leitura caso haja pixels faltando nas barras. 
Selecionar Filtro1 (Filter1) preencherá um espaço em uma barra de 1 pixel. 
Filtro2 (Filter2) preencherá um espaço de 2 pixels etc.

Processar código de barras por (Process bar code by) — quando definido 
como Auto, o código de barras será lido no scanner, se possível. Se 
o scanner atingir o número máximo de códigos de barras ou o código de 
barras não for suportado no scanner, o código de barras será lido pelo 
Capture Pro. Quando definido como Capture Pro, o código de barras será lido 
no software.

Vantagens da leitura de códigos de barras no scanner (Auto):
• Rápido — os códigos de barras rápidos são lidos na velocidade máxima do 

scanner.
• Resolução — os códigos de barras são detectados na resolução de 

imagem máxima (1200 dpi). O processamento e compressão de imagem 
podem degradar bordas em alguns modelos de scanner.

Desvantagens da leitura de códigos de barras no scanner (Auto):
• O scanner pode ler menos códigos de barras por imagem do que o Capture 

Pro
• O scanner lê menos tipos de códigos de barras do que o Capture Pro.

OBSERVAÇÃO: se você escolher a opção Ler todos os códigos de barras 
(Read all bar codes), Processar código de barras por 
(Process bar code by) deve ser definido como Capture Pro. 
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Caixa de diálogo Zona do 
código de barras (Bar code 
zone) (continuação)

Orientação (Orientation) — selecione uma opção de orientação na lista 
suspensa. Se todos os seus códigos de barras compartilharem a mesma 
orientação (por exemplo, tudo na horizontal ou tudo na vertical), 
é recomendado que você indique a orientação específica; isso aumentará 
o desempenho da leitura do código de barras e da digitalização.

Se os seus códigos de barras estiverem proeminentemente na mesma 
orientação (por exemplo, horizontal), mas você tiver um código de barras 
ocasionalmente na direção oposta (por exemplo, vertical), é recomendado 
que você use a orientação “e” apropriada (por exemplo, Horizontal 
e Vertical). 

Quando a zona de código de barras é criada pela primeira vez, o Capture Pro 
Software define automaticamente a orientação como a do código de barras, 
se esta for encontrada. O padrão é Horizontal. 

Segurança (Confidence) — insira um número de taxa de segurança para 
restringir o que o Capture Pro Software considera como sendo leitura bem-
sucedida do código de barras. Por exemplo, quanto maior o valor digitado, 
menor será a chance de erro de leitura do código de barras.

Qualidade (Quality) — selecione uma configuração de qualidade entre 
Mínima (Worst) e Superior (Best). Os códigos de barra de qualidade mais 
alta são impressos por uma impressora a laser ou são pré-impressos por uma 
impressora de ressalto. Os códigos de barras com qualidade mais baixa são 
impressos por uma impressora a jato de tinta ou matricial. 

Dependendo da qualidade dos códigos de barras que estão sendo 
digitalizados, defina apropriadamente o nível de Qualidade. Quanto mais alta 
for a configuração de qualidade, mais rápida será a leitura do código de 
barras.

Posição (Position) — selecione Qualquer lugar (Anywhere) ou Zona (Zone). 

• Qualquer lugar (Anywhere): ao criar uma zona para um código de barras 
em Qualquer lugar, trace um local ao redor do código de barras em algum 
lugar da página e selecione a opção Qualquer lugar (Anywhere). 
Essa situação geralmente ocorre quando códigos de barras podem ser 
encontrados em locais imprevisíveis nos documentos. Ao procurar códigos 
de barras do tipo Qualquer lugar, o Capture Pro Software pesquisa 
a imagem de cima para baixo em busca de códigos de barras horizontais 
e verticais. Essa ordem de pesquisa é importante para entender se você 
tem mais de um código de barras do tipo Qualquer lugar em uma página 
ou zona. 

• Zona (Zone): aumenta o desempenho de leitura do código de barras e da 
digitalização, e é a configuração padrão. 

- Ou procurar em imagens com rotação de 180 graus (Alternatively 
search on 180° rotated images) — só pode ser usada quando a opção 
Zona (Zone) está ativada. Quando a leitura do código de barras não for 
bem-sucedida, o Capture Pro Software também procurará a zona após 
girar a imagem 180 graus. Isso deixa a leitura e a digitalização do código 
de barras mais lentas, mas impede a falha na leitura do código em virtude 
de a página ter sido digitalizada de cabeça para baixo. A imagem não 
é permanentemente girada, a menos que a opção Girar com base no 
código de barras (Rotate based on bar code) esteja selecionada. 

• Ou procurar no verso (Alternatively search on the reverse side) — 
a ativação dessa opção aumenta a precisão na separação e indexação de 
documentos/lotes quando páginas são acidentalmente invertidas antes de 
serem digitalizadas.
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• Girar com base no código de barras (Rotate based on bar code) — 
O Capture Pro Software pode determinar se um código de barras gira 180 
graus e girará a página do código de barras 180 graus para exibi-la na 
orientação correta. Essa opção é usada para separação de documentos. 
Todas as páginas dele serão giradas da mesma forma que a página 
principal, que contém a zona de código de barras. Se necessário, somente 
uma zona de código de barras deve ter a opção Girar com base no código 
de barras (Rotate based on bar code) ativada. 

OBSERVAÇÃO: Rotação do lote (Batch rotation) não é suportada no 
Capture Pro Software.

Ler todos os códigos de barra (Read all bar codes): quando esta opção está 
selecionada e a Posição (Position) for Qualquer lugar (Anywhere), todos os 
códigos de barras na página serão lidos. Os valores do código de barras 
serão separados pelo caractere ^. A ordem dos valores será a ordem pela 
qual os códigos de barras foram encontrados quando da pesquisa da 
esquerda para a direita e de cima para baixo na página.

OBSERVAÇÃO: se você escolher a opção Ler todos os códigos de barras 
(Read all bar codes), Processar código de barras por 
(Process bar code by) deve ser definido como Capture Pro. 

Separação (Separation) — as seguintes opções estão disponíveis:

• Criar novo lote (Create a new batch) — todas as imagens após 
a separação vão para um novo documento em um novo lote.

• Criar novo documento (Create a new document) — todas as imagens 
após a separação vão para um novo documento no lote atual.

• A página seguinte permanece no documento atual (Next page stays in 
current document) — a página seguinte após a separação permanece no 
documento atual.

• Só separar quando houver mudança no valor (Only separate when 
change in value) — o software separa por documento ou lote somente se 
um valor for alterado.

• Sem separação (No separation) — selecione Nível de lote (Batch level) ou 
Nível de documento (Document level) para as zonas de código de barras:

- O código de barras está situado em: (Bar code is located on:) Nível 
de lote (Batch level): códigos de barras que estão localizados no nível de 
lote ou que separam lotes estão disponíveis para indexação de lote ou 
documento. Códigos de barras de nível de lote são lidos apenas quando 
estão presentes em uma página de Cabeçalho de lote. Uma página de 
Cabeçalho de lote existe sempre que a separação de lote é definida 
através de códigos de correção ou códigos de barras (no mínimo uma 
zona de código de barras no trabalho está configurada para separação 
de lote). 

- O código de barras está situado em: (Bar code is located on:) Nível 
de documento (Document level): códigos de barras que estão localizados 
no nível de documento ou que separam documentos estão disponíveis para 
indexação de documento. Não estão disponíveis para indexação de lote.

• Excluir página (Delete Page) — selecione essa opção para excluir 
a página contendo o código de barras que iniciou o novo documento. 
Isso é importante quando suplementos que não contêm informações 
significativas são usados para separação de documentos. O código de 
barras, no entanto, ainda fica disponível para indexação de nível de 
documento.
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Caixa de diálogo 
Configuração das zonas 
das páginas (Zone Pages 
Setup)

Por padrão, as zonas do código de barras (OCR, detecção de marca) só 
serão aplicadas na primeira página de um documento. Para ler o código de 
barras (texto extraído ou verificação de marcas) em páginas adicionais, use 
a caixa de diálogo Configuração das páginas de zonas (Zone Page Setup) 
para selecionar uma página específica ou um intervalo de páginas. A caixa de 
diálogo Configuração das páginas de zonas (Zone Page Setup) é exibida ao 
selecionar Selecionar páginas para aplicação (Select pages to apply for all 
zones) para todos os ícones de zonas localizados no canto direito inferior da 
caixa de diálogo Configuração do código de barras, OCR e detecção de 
marcas (Bar Code, OCR and Mark Detection Setup). A caixa de diálogo 
Configuração das páginas de zonas (Zone Pages Setup) permite que você 
selecione separadamente uma ou mais páginas em que o código de barras, 
o OCR e as zonas de detecção de marca definidos serão aplicados. 

Páginas para ler zonas OCR (Pages to read OCR zones) — usadas para 
selecionar a página ou páginas para aplicar todas as zonas do OCR definidas. 
Várias páginas podem ser inseridas ao separar os números das páginas com 
vírgulas “,”. Por exemplo, “3-8”. Para cada uma das zonas OCR definidas, 
a página ou páginas especificadas serão verificadas para texto válido. 
Se texto válido for encontrado na zona, a leitura do texto será atribuída para 
ela. Qualquer texto válido na zona na página seguinte vai substituir qualquer 
texto anterior que tenha sido lido.

Se um documento tiver menos páginas do que a página inserida, o valor da 
zona permanecerá vazio. Por exemplo, se um documento tiver 6 páginas e as 
páginas para leitura forem definidas em “8, 11-15”, o valor da zona 
permanecerá vazio mesmo se as 6 primeiras páginas contiverem texto válido 
na zona. 

Se você precisa sempre ler o valor na zona da última página do documento 
e o documento pode conter um número variável de páginas, o asterisco “*” 
pode ser usado para ler cada página do documento. O valor lido na última 
página será o valor final atribuído para a zona.

OBSERVAÇÃO: se o valor na última página não for legível ou válido, um valor 
válido em uma página anterior será atribuído para a zona.

Se Páginas para ler o código de barras (Pages to read Bar Code) estiver 
vazio, nenhuma das zonas do OCR será lida.
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Páginas para ler o código de barras (Pages to read Bar code) — usadas 
para selecionar a página ou páginas para aplicar todas as zonas do código de 
barras definidas. Várias páginas podem ser inseridas ao separar os números 
das páginas com vírgulas ‘,’. Por exemplo, “1,2,5,6”. Um intervalo de páginas 
pode ser inserido ao digitar o número da primeira página, um traço “-”, 
e o número da última página. Por exemplo, “3-8”. Para cada uma das zonas 
do código de barras definidas, a página ou páginas especificadas serão 
verificadas para um código de barras válido. Se um código de barras válido for 
encontrado na zona, a leitura do valor do código de barras será atribuída para 
a zona. Um código de barras válido na zona na página seguinte vai substituir 
quaisquer valores de código de barras anteriores que tenham sido lidos.

Se um documento tiver menos páginas do que a página inserida, o valor da 
zona permanecerá vazio. Por exemplo, se um documento tiver 6 páginas e as 
páginas para leitura forem definidas em “8, 11-15”, o valor da zona 
permanecerá vazio mesmo se as 6 primeiras páginas contêm um ou mais 
código de barras válidos.

Se você precisa sempre ler o valor na zona da última página do documento 
e o documento pode conter um número variável de páginas, o asterisco “*” 
pode ser usado para ler cada página do documento. O valor lido na última 
página será o valor final atribuído para a zona. 

OBSERVAÇÃO: se o valor na última página não for legível ou válido, um valor 
válido em uma página anterior será atribuído para a zona.

Se o campo Páginas para ler o código de barras (Pages to read Bar Code) 
estiver vazio, nenhuma das zonas do código de barras será lida.

Páginas para ler zonas de OMR (reconhecimento de marca óptica) 
(Pages to read OMR (Optical Mark Recognition) zones) — especificar várias 
páginas para aplicar zonas de detecção de marcas raramente é prático. 
Se as zonas de detecção de marca forem definidas como “Sem moldura” 
(No Frame), a última página especificada no intervalo da página irá determinar 
o valor da zona de detecção da marca. Até zonas de detecção da marca 
definidas como contendo uma “Moldura” (Frame) podem produzir 
resultados ruins.

Separação de 
documentos com zonas 
de código de barras

O Capture Pro Software permite que você separe documentos com zonas de 
código de barras em um lote:

1. Selecione Arquivo > Configuração do trabalho (File > Job Setup) 
e selecione um trabalho e um lote. 

2. Abra a guia Captura (Capture) e selecione Separação > Por zonas do 
código de barras (Separation > By Bar Code Zones). A janela Separação 
por zona de código de barras (Separation by Bar Code Zone) será exibida.

3. Selecione uma zona de código de barras ou defina uma nova. 

4. Clique com o botão direito do mouse para exibir o menu contextual 
e clique em Propriedades da zona (Zone Properties). A caixa de diálogo 
Configuração de zona de código de barras (Bar Code Zone Setup) será 
exibida.

5. Em Separação (Separation), selecione Criar novo documento 
(Create a new document).

6. Marque a opção Excluir página (Delete page) se desejar excluir a página 
que contém o código de barras que iniciou o novo documento.
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7. Preencha o campo Manter os códigos de barras com a máscara (Keep bar 
codes with mask) e/ou o campo Comprimento mínimo (Minimum length) 
para restringir a separação do documento a um determinado valor de 
código de barras ou máscara.

8. Selecione Girar com base no código de barras (Rotate based on bar 
code) se quiser girar todas as páginas do documento na mesma 
orientação do código de barras da página de Cabeçalho do documento. 
Girar o documento com base no código de barras não funcionará se 
a página separadora de código de barras for excluída.

Por exemplo: 

Máscara = “ER”9(8)“-”999 Comprimento mínimo = 14: Apenas valores de 
código de barras com um comprimento de 14 caracteres, começando com 
a sequência “ER” seguida de oito caracteres numéricos, um hífen e três 
caracteres numéricos iniciam um novo documento. 
Por exemplo, o código de barras do número do paciente na folha de rosto 
de uma pasta inicia um novo documento. O número do paciente, nesse 
caso, também pode ser usado como um índice de documentos. Se um 
código de barras da mesma zona criar um lote com um valor, e um 
documento com outro, duas zonas devem ser arrastadas uma por cima 
da outra. 

9. Depois de digitar as outras configurações, clique em OK para fechar 
a caixa de diálogo e voltar à janela Separação por código de barras.

10. Clique em OK para salvar suas configurações e sair da caixa de diálogo 
Configuração do trabalho (Job Setup). 

Separação de lotes com 
zonas de código de 
barras

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do código de barras (Separation > 
By Bar Code Zone). A janela Separação por zona de código de barras 
(Separation by Bar Code Zone) será exibida.

4. Selecione uma zona de código de barras ou defina uma nova.

5. Clique com o botão direito do mouse para exibir o menu contextual 
e clique em Propriedades da zona (Zone Properties). A caixa de diálogo 
Configuração de zona de código de barras (Bar Code Zone Setup) será 
exibida.

6. Em Separação (Separation), selecione Criar novo lote (Create a new 
batch).

7. Clique em OK para sair da caixa de diálogo e voltar à janela Separação 
por código de barras (Separation by Bar Code).

8. Clique em OK para salvar suas configurações e sair da caixa de diálogo 
Configuração do trabalho (Job Setup).

OBSERVAÇÕES:
• Zonas de código de barras a serem usadas para indexação no nível de lote 

são lidas apenas quando estão presentes em uma página de Cabeçalho 
de lote.
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• Uma página de Cabeçalho de lote existe sempre que a separação de lote 
é definida através de códigos de correção, códigos de barras ou zonas de 
OCR (no mínimo uma zona no trabalho está configurada para separação 
de lote).

Edição de uma zona 
de código de barras

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).

3. Abra a guia Captura (Capture) e selecione Separação > Por zonas do 
código de barras (Separation > By Bar Code Zones). A janela Separação 
por zona de código de barras (Separation by Bar Code Zone) será exibida.

4. Clique na zona de código de barras que você deseja alterar ou clique no 
nome da zona de código de barras na lista à direita da janela Separação 
por zona de código de barras (Separation by Bar Code Zone). 

5. Clique com o botão direito do mouse para exibir o menu contextual 
e clique em Propriedades da zona (Zone Properties). A caixa de diálogo 
Configuração de zona de código de barras (Bar Code Zone Setup) será 
exibida.

6. Depois de alterar suas configurações, clique em OK para fechar a caixa 
de diálogo.

7. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). 

8. Após editar uma zona de código de barras, teste o código de barras para 
saber se ele ainda está legível. 

Exclusão de uma 
zona de código de 
barras

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).

3. Abra a guia Captura (Capture) e selecione Separação > Por zonas do 
código de barras (Separation > By Bar Code Zones). A janela Separação 
por zona de código de barras (Separation by Bar Code Zone) será exibida.

4. Clique na zona de código de barras que deseja excluir. Você também pode 
clicar no nome da zona de código de barras na lista à esquerda da janela 
Código de barras (Bar Code). A zona será realçada.

5. Clique em Delete (Excluir). 

6. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). 
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Transferência de uma 
imagem para a janela 
Código de barras 
(Bar Code)

O Capture Pro Software permite transferir uma imagem que contém códigos 
de barras do Visualizador de imagens (Image Viewer) para a janela Código de 
barras (Bar Code) para criar zonas de código de barras. 

1. Na janela principal, digitalize a imagem que contém o código de barras.

2. Clique com o botão direito do mouse na imagem que você deseja 
transferir do Visualizador de imagens (Image Viewer).

3. Selecione Copiar imagem na configuração de trabalho (Copy Image to 
Job Setup). A caixa de diálogo Copiar imagem na configuração do 
trabalho (Copy Image to Job Setup) será exibida.

4. Digite o nome da nova imagem no campo Salvar imagem como 
(Save image as).

5. Clique em OK. Agora você pode exibir a imagem na janela Código de 
barras e usá-la para criar uma zona de código de barras.

Pode também digitalizar imagens de códigos de barras diretamente na 
janela Código de barras (Bar Code). Consulte “Digitalização de uma imagem 
para a configuração do código de barras” anteriormente neste capítulo.

Definição do 
intervalo do tamanho 
da imagem de código 
de barras

Quando você define zonas de código de barras, cada página que digitalizar 
será verificada para determinar se contém esses códigos. Essa verificação 
pode deixar a digitalização mais lenta. Se as suas páginas de código de 
barras sempre têm aproximadamente a mesma quantidade de bytes, e se 
essa quantidade é diferente das demais páginas que você digitaliza, você 
pode indicar ao software que somente imagens em um determinado intervalo 
de tamanho (quantidade de bytes) precisam ser verificadas em busca de 
códigos de barras. Essa configuração pode aumentar o desempenho da 
digitalização.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do código de barras (Separation > 
By Bar Code Zones). A janela Separação por zona de código de barras 
(Separation by Bar Code Zone) será exibida.

4. Selecione uma imagem e clique com o botão direito do mouse em uma 
zona de código de barras. A caixa de diálogo Propriedades gerais de 
código de barras e OCR (General Bar Code and OCR Zone Properties) 
será exibida.
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OBSERVAÇÃO: se não houver uma zona de códigos de barra, essa opção 
não estará disponível até essa zona ser definida.

5. Marque a caixa de seleção Extrair códigos de barra/OCR de imagens 
entre (Extract bar codes/OCR from images between) e defina um intervalo 
para o tamanho mínimo e máximo de bytes.

6. Depois de efetuar suas configurações, clique em OK para fechar a caixa 
de diálogo e voltar à janela Código de barras (Bar Code).

7. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). O novo intervalo de imagens foi 
salvo.

8. Depois de editar uma zona de código de barras, teste-a para verificar se 
ela ainda está legível. 

OBSERVAÇÃO: quando digitalizar imagens coloridas/em tons de cinza 
e em preto-e-branco, especifique o intervalo da imagem 
em preto-e-branco.

Criação de um anexo 
com zonas de código 
de barras

1. Selecione Arquivo > Configuração do trabalho (File > Job Setup), 
selecione um trabalho e abra a guia Captura (Capture). 

2. Selecione Separação > Por zonas do código de barras (Separation > 
By Bar Code Zones). A janela Código de barras (Bar Code) será exibida.

3. Selecione uma zona de código de barras ou defina uma nova. 

4. Clique com o botão direito do mouse para exibir o menu contextual 
e clique em Propriedades da zona (Zone Properties). A caixa de diálogo 
Configuração de zona de código de barras (Bar Code Zone Setup) será 
exibida.

5. Em Separação (Separation), selecione A página seguinte permanece 
no documento atual (Next page stays in current document). Essa opção 
só é válida para uma página de anexo. Se houver necessidade de vários 
anexos, um código de barras de anexo deverá ser aplicado a cada um 
deles. O código de barras na página de anexo não está disponível para 
indexação.

6. Marque a opção Excluir página (Delete page) para excluir a página 
(frente e verso) que contém o código de barras e para usar a página 
seguinte como anexo. Isso é útil quando se aplicam inserções que indicam 
se a página seguinte é um anexo. Qualquer rotação será aplicada 
à página seguinte.

7. Preencha o campo Manter os códigos de barras com a máscara (Keep bar 
codes with mask) e/ou o campo Comprimento mínimo (Minimum length) 
caso queira restringir os anexos a um determinado valor ou máscara para 
o código de barras.

8. Marque a caixa de seleção Girar com base no código de barras (Rotate 
based on bar code) caso queira girar o anexo (frente e verso) na mesma 
orientação do código de barras da página.

9. Clique em OK para salvar suas configurações e fechar a caixa de diálogo.
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Teste de zonas de 
código de barras 

Quando você define uma nova zona de código de barras de uma imagem, 
o Capture Pro Software automaticamente verifica a zona para ver se ela está 
legível. Porém, se você editar a zona de código de barras ou alterar suas 
propriedades posteriormente, ela pode deixar de ser legível. Você pode testar 
as zonas de código de barras manualmente para verificar se o Capture Pro 
Software ainda consegue lê-las.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do código de barras (Separation > 
By Bar Code Zones). A janela Código de barras (Bar Code) será exibida.

4. Clique no ícone Testar todas as zonas do código de barras, de OCR 
e de detecção de marcas (Test All Bar Code, OCR & Mark Detection 
Zones) para testar todos os códigos de barras ou clique no ícone Testar 
zonas selecionadas do código de barras, de OCR e de detecção de 
marcas (Test Selected Bar Code, OCR & Mark Detection Zones) para 
testar uma zona de código de barras individualmente. A caixa de diálogo 
Valores do código de barras, de OCR ou de detecção de marcas 
(Bar Code, OCR & Mark Detection Values) será exibida.

5. Depois de exibir os valores nessa caixa, clique em OK para voltar à janela 
Código de barras (Bar Code).

6. Clique em OK para salvar suas configurações e sair da caixa de diálogo 
Configuração do trabalho (Job Setup). Agora todas as zonas de código de 
barras foram testadas. Se as configurações de código de barras forem 
alteradas, teste as zonas novamente.

Tipos de código de 
barras

O Capture Pro Software suporta os seguintes tipos de código de barras:
• 2 de 5 de companhias aéreas
• Aztec
• Código de barras 32
• CODABAR
• Código 128
• Código 2 de 5 — excluem-se mutuamente com 2 de 5 intercalado
• Código 3 de 9
• Código 39 (sem parada início)
• Código 39 estendido
• Código 93
• Data Matrix
• EAN 13
• EAN 8
• Código de barras de correio inteligente
• Intercalado de 2 de 5 — excluem-se mutuamente com Código 2 de 5 
• PDF 417 — um tipo de código de barras bidimensional de alta densidade, 

que pode conter até 1250 bytes de informações em alguns centímetros 
quadrados. Com esse tipo de densidade, todos os dados de índice de um 
documento podem estar contidos em um único código de barras.

• Planet (código do correio norte-americano)
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• PostNet (postal): não pode ser selecionado com nenhum outro tipo de 
código de barras 

• QR Code
• Código UCC 128
• UPC-A
• UPC-E

Sintaxe especial para 
códigos de barras 
bidimensionais

Ao usar códigos de barras bidimensionais, um único código de barras pode 
conter todos os dados de índice de um documento ou lote. Para facilitar 
a indexação com códigos de barras bidimensionais, uma sintaxe especial de 
divisão de sequência foi adicionada: 

<barcode.zonename:[start;length]>
<barcode.zonename:[start;end]>
<barcode.zonename:[# of data elements, delimiter (in single quotes)]>

O delimitador pode ser o próprio símbolo de caractere ou seu valor numérico 
decimal ASCII (para símbolos que não podem ser impressos ou digitados). 
O delimitador deve estar entre aspas duplas (“ ”). 

Por exemplo, se um código de barras PDF417 contiver os dados: 
12345678*NURSERY*11/19/1962, os seguintes valores poderão ser usados 
como padrão para os três campos de índice dos dados: 

Uso de zonas de OCR O OCR (reconhecimento óptico de caracteres) é a tradução mecânica ou 
eletrônica de imagens de texto datilografado ou impresso (geralmente 
capturadas por um scanner) em texto editável em computador.

A configuração de OCR permite definir:

• o nome da zona de OCR
• o local físico onde você encontra o texto (localização da zona na imagem)
• o nível onde você pode encontrar o texto (nível do lote ou documento)

Use a função Configuração do código de barras, de OCR e de detecção de 
marcas (Bar Code, OCR and Mark Detection Setup) na guia Capturar 
(Capture) da caixa de diálogo Configuração do trabalho (Job Setup) para 
configurar o leitor de código de barras para ler um ou mais códigos de barras 
ou parâmetros de OCR para uma ou mais zonas de OCR.

A configuração de separação por zona de OCR na guia Captura (Capture) da 
caixa de diálogo Configuração do trabalho (Job Setup) permite que você 
digitalize uma imagem na janela Separação por zona de OCR (Separation by 
OCR Zone) e defina zonas e propriedades específicas de zonas de OCR. 

Valor padrão Valor real
<BC.PDF417:[1, ‘*’]> 12345678
Retorna o primeiro elemento da sequência do código de barras delimitada 
por um asterisco.
<BC.PDF417:[2, ‘42’]> NURSERY
Retorna o segundo elemento da sequência do código de barras delimitada 
por um asterisco (42 é o valor decimal ASCII para o asterisco).
<BC.PDF417:[3, ‘*’]> 19/11/1962
Retorna o terceiro elemento da sequência do código de barras delimitada 
por um asterisco.
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OBSERVAÇÃO: os componentes da janela Separação por código de barras 
e por zona de OCR (Separation by Bar Code and Separation 
by OCR Zone), os ícones e o menu contextual são descritos 
com detalhe nas seções “Janela Código de barras, OCR 
e detecção de marcas (Bar Code, OCR & Mark Detection)” 
e “Menu contextual das janelas Código de barras, OCR 
e detecção de marcas (Bar Code, OCR & Mark Detection)”, 
apresentadas anteriormente neste capítulo.

A indexação do OCR usa léxicos de idiomas locais e permite a leitura de texto 
alfanumérico em alta velocidade (1000 caracteres/segundo). Ela é zonal 
(semelhante à leitura de código de barras) e é processada durante 
a digitalização. 

O Capture Pro Software oferece suporte às seguintes informações de texto 
para OCR:

- Ligações (caracteres “unidos”)
- Caracteres divididos
- Caracteres corrompidos
- Texto com resolução de 200 a 600 dpi
- Fontes de texto de 8 a 72 pontos
- Números de 0 a 9
- Letras de A-Z e a-z
- Símbolos ! “ $ % & ( ) * + , - . / :, ; < = > ? @ [ \ ] { } £ • ß ´ ª

• Para obter os melhores resultados, use a resolução de 300 dpi e a fonte 
sans serif de 12 pontos (ou maior se usar resoluções inferiores a 300 dpi). 
Não use documentos inclinados.

• O Capture Pro Software oferece suporte para uma ampla variedade de 
idiomas para indexação de OCR. Para exibir uma lista desses idiomas:

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR 
Zone) será exibida.

4. Clique em qualquer zona de OCR e clique em Propriedades da zona 
(Zone Properties). A caixa de diálogo Configuração de zona de OCR 
(OCR Zone Setup) será exibida.
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5. Selecione o idioma do seu texto dentre os idiomas disponíveis na lista 
suspensa Idioma (Language).

Digitalização de uma 
imagem para a 
configuração de OCR

O Capture Pro Software permite separar páginas digitalizadas em lotes 
e documentos com base em zonas de OCR. Essas zonas de OCR também 
permitem que você crie anexos em seus documentos. 

Para usar o texto do OCR como separador, é necessário:

1. Digitalizar uma imagem com o texto do OCR para o Capture Pro Software. 

2. Criar e definir as zonas de OCR. 

3. Configurar seu trabalho para separação com zona de OCR.

Para digitalizar uma imagem diretamente na janela Separação por zona de 
OCR (Separation by OCR Zone):

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture). 

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida. 

4. Posicione o documento original no alimentador e clique em Iniciar/
Digitalizar (Start/Scan). A imagem será exibida na caixa de diálogo. 
Digitalize a imagem da maneira mais reta possível. Seu scanner usará os 
parâmetros de configuração de página atual do Capture Pro Software. 

OBSERVAÇÕES:
• Qualquer configuração do trabalho atual será aplicada à imagem 

digitalizada antes de ela ser mostrada.

• Se a imagem estiver aceitável, digite um nome para ela no campo Nome 
da imagem (Image Name). O nome da imagem não deve conter nenhum 
destes caracteres: : “ ? * . < > \ / . 

• Para descartar a imagem, clique em Cancelar (Cancel).

• Antes de definir uma zona de OCR, é necessário ter pelo menos uma 
imagem na lista suspensa Imagem (Image).
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• Você também pode transferir uma imagem do Visualizador de imagens 
(Image Viewer) para a janela Separação por zona de OCR (Separation 
by OCR Zone). Para mais informações, consulte “Transferência de uma 
imagem para a janela OCR” posteriormente neste capítulo.

5. Clique em OK.

Criação e seleção de 
uma zona de OCR

Antes de usar uma imagem de OCR para separar documentos ou lotes, 
é necessário criar e selecionar uma zona de OCR. 

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione a configuração Separação > Por zonas do OCR (Separation > 
By OCR Zones). A janela Separação por zona de OCR (Separation by 
OCR Zone) será exibida.

4. Selecione uma imagem na lista suspensa Imagem (Image). Se você 
precisar digitalizar a imagem, clique no ícone verde Iniciar/Digitalizar 
(Start/Scan) na janela Separação por zona de OCR (Separation by 
OCR Zone). 

OBSERVAÇÃO: posicione o cursor do mouse no canto superior esquerdo 
da área da imagem onde você deseja definir a localização 
dessa zona de OCR. Para fazer a indexação de OCR com 
comprimento e altura variáveis, trace a zona com um 
tamanho suficiente para capturar todos os dados de 
indexação. Ao mesmo tempo, tenha cuidado para não 
traçar a zona tão grande a ponto de capturar dados 
indesejados (por exemplo, linhas em um formulário).

As zonas de OCR são específicas do trabalho e não da 
imagem. Portanto, a exibição de uma nova imagem 
continua a exibir as zonas que você definiu usando 
imagens anteriores.

5. Mantenha pressionado o botão esquerdo do mouse e arraste o cursor 
para traçar um retângulo ao redor da área de texto. Depois que você 
liberar o cursor, a caixa de diálogo Configuração de zona de OCR 
(OCR Zone Setup) será exibida.

6. No campo Nome da zona (Zone name), insira um nome para a nova zona 
de OCR. É necessário criar um nome para salvar a zona.

7. Depois de digitar as outras configurações, clique em OK para fechar 
a caixa de diálogo e voltar à janela Separação por Zona de OCR 
(Separation by OCR Zone).

8. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). 

Caixa de diálogo 
Configuração de zona de 
OCR (OCR Zone Setup)

As zonas de OCR fornecem ao Capture Pro Software informações como, 
por exemplo, as dimensões da zona. Depois que você traça uma zona OCR, 
o Capture Pro Software tenta ler as informações na zona e exibe 
automaticamente a janela Propriedades da zona de OCR (OCR Zone 
Properties) com qualquer texto que o software possa ler na zona.
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OBSERVAÇÃO: a função OCR tem dificuldade em ler caracteres em itálico 
e sublinhados em conjuntos de caracteres asiáticos. 
Para aumentar a capacidade de leitura de OCR, recomenda-
se que você use imagens em preto-e-branco.

Nome da zona (Zone name) — digite um nome para a zona de OCR. 
Para salvar a zona de OCR, atribua um nome a ela. 

Face: (Side:) Frente (Front) ou Verso (Back) — selecione se a zona de OCR 
deve ficar localizada na frente ou no verso de uma imagem.

Regra para os valores a manter (Rule for values to keep) — qualquer 
expressão de texto com formato de entrada válido pode ser digitada ou você 
pode deixar esse campo em branco. Se alguma expressão de texto com 
formato de entrada for digitada, somente as sequências de leitura de OCR 
que cumprirem essa regra serão mantidas. Por exemplo, se a expressão 
digitada for A<10>, somente as sequências de leitura de OCR que contiverem 
até 10 caracteres alfabéticos serão mantidas. Para obter mais informações, 
consulte “Formatos de entrada” no Capítulo 2.

Pesquisar o valor na zona (Search for value in zone) — quando a Regra 
para os valores a manter (Rule for values to keep) é um formato de 
sequência fixa, o valor de leitura da zona de OCR só precisa conter 
sequências fixas para o valor a ser mantido.

Por exemplo, se a Regra para valores a manter (Rule for values to keep) 
fosse definida como Formulário 1099, as sequências a seguir seriam leituras 
válidas, e a separação de lote/documento ocorreria se fosse selecionada.

“77644 Formulário 1099 - revisão 1.2”
“81763 Formulário 1099 - revisão 1.4”
“77644 Formulário 1099 - revisão 2.2”

Regra do conjunto de caracteres (Character set rule) — não aplicável neste 
momento.

Idioma principal (Primary language) — selecionar o idioma principal 
apropriado garante que o Capture Pro Software faça adequadamente o OCR 
de caracteres especiais específicos do idioma (por exemplo, ç ou ü). 
Use a lista suspensa para exibir os idiomas suportados.

Idioma secundário (Secondary language) — um ou mais idiomas 
secundários podem ser selecionados quando uma zona possivelmente 
contém caracteres de mais de um idioma.
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Dicionário personalizado (Custom dictionary) — um dicionário 
personalizado pode ser usado para melhorar a precisão do reconhecimento 
de palavras exclusivas ou incomuns que aparecem no conjunto do 
documento. Clique em Procurar (Browse) para selecionar um dicionário 
personalizado. 

Separação (Separation) — as seguintes opções estão disponíveis:

• Criar novo lote (Create a new batch): todas as imagens após a separação 
vão para um novo documento em um novo lote.

• Criar novo documento (Create a new document): todas as imagens após 
a separação vão para um novo documento no lote atual.

• A página seguinte permanece no documento atual (Next page stays in 
current document): a página seguinte após a separação permanece no 
documento atual.

Sem separação (No separation) — selecione uma das seguintes opções:

• O OCR está situado em: (OCR is located on:) Nível de documento: 
(Document level:) As zonas de OCR localizadas no nível de documento 
e as zonas de OCR que separam documentos estão disponíveis para 
indexação de documento. No entanto, elas não estão disponíveis para 
indexação de lote.

• O OCR está situado em: (OCR is located on:) Nível de lote: (Batch 
level:) As zonas de OCR localizadas no nível de Lote e as zonas de OCR 
que separam lotes estão disponíveis para indexação de lote e documento. 

Só separar quando houver mudança no valor (Only separate when change 
in value) — o sistema separa por documento ou lote somente se um valor for 
alterado.

Excluir página (Delete page) — exclui a página que contém o valor de leitura 
de OCR que iniciou a separação é excluída.

OK — fecha a caixa de diálogo e volta à janela Separação por zona de OCR 
(Separation by OCR Zone).

Aplicação de zonas de 
OCR a páginas 
específicas

Para obter informações sobre como selecionar a(s) página(s) para aplicar 
todas as zonas de OCR, consulte “Caixa de diálogo Configuração das zonas 
das páginas (Zone Pages Setup)” anteriormente neste capítulo. 

Separação de 
documentos com zonas 
de OCR

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida.

4. Selecione uma imagem na lista suspensa Imagem (Image). Se você 
precisar digitalizar a imagem, clique no ícone verde Iniciar/Digitalizar 
(Start/Scan) na janela Separação por zona de OCR (Separation by 
OCR Zone).

OBSERVAÇÃO: use o mouse para traçar a zona de OCR. A caixa de 
diálogo Configuração de zona de OCR (OCR Zone Setup) 
será exibida.
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5. Em Separação (Separation), clique na opção Criar novo documento 
(Create a new document).

6. Clique em OK para sair da caixa de diálogo e voltar à janela Separação 
por zona de OCR (Separation by OCR Zone).

7. Clique em OK para salvar suas configurações e sair da caixa de diálogo 
Configuração do trabalho (Job Setup). 

OBSERVAÇÃO: Uma página de Cabeçalho de lote existe sempre que 
a separação de lote é definida através de códigos de 
correção, códigos de barras ou zonas de OCR 
(no mínimo uma zona na configuração de trabalho está 
configurada para separação de lote).

Separação de lotes com 
zonas de OCR

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida.

4. Selecione uma imagem na lista suspensa Imagem (Image). Se você 
precisar digitalizar a imagem, clique no ícone verde Iniciar/Digitalizar 
(Start/Scan) na janela Separação por zona de OCR (Separation by 
OCR Zone).

5. use o mouse para traçar a zona de OCR. A caixa de diálogo Configuração 
de zona de OCR (OCR Zone Setup) será exibida. Se você especificar uma 
área da imagem para separação de lotes por OCR, essa área deverá 
permanecer em branco em todas as outras páginas do lote. 

6. Em Separação (Separation), clique na opção Criar novo lote (Create 
a new batch).

7. Clique em OK para sair da caixa de diálogo e voltar à janela Separação 
por zona de OCR (Separation by OCR Zone).

8. Clique em OK para salvar suas configurações e sair da caixa de diálogo 
Configuração do trabalho (Job Setup). 

OBSERVAÇÃO: zonas de OCR no nível de lote são lidas apenas quando 
estão presentes em uma página de Cabeçalho de lote. 
Uma página de Cabeçalho de lote existe sempre que 
a separação de lote é definida através de códigos de 
correção, códigos de barras ou zonas de OCR (no mínimo 
uma zona na configuração de trabalho está configurada para 
separação de lote). 

Para obter informações sobre a separação de lotes com digitalização em 
cores/tons de cinza, consulte “Uso de separadores na digitalização em cores” 
posteriormente neste capítulo.

Edição das 
propriedades da zona 
de OCR

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione um nome de trabalho na lista suspensa Nome do trabalho 
(Job Name) e abra a guia Captura (Capture).
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3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida. 

4. Clique na zona de OCR que você deseja alterar ou clique no nome da 
zona de OCR na lista à esquerda da janela Separação por zona de OCR 
(Separation by OCR Zone).

5. Clique com o botão direito do mouse para exibir o menu contextual 
e clique em Propriedades da zona (Zone Properties). A caixa de diálogo 
Configuração de zona de OCR (OCR Zone Setup) será exibida.

6. Depois de alterar as configurações, clique em OK para fechar a caixa de 
diálogo e voltar à janela Separação por Zona de OCR (Separation by OCR 
Zone).

7. Clique em OK para salvar suas configurações e sair da caixa de diálogo 
Configuração do trabalho (Job Setup).

Após editar uma zona de OCR, teste-a para saber se ela ainda está legível.

Exclusão de uma 
zona de OCR

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida.

4. Clique na zona de OCR que deseja excluir. Também é possível clicar no 
nome da zona de OCR na lista à esquerda da janela Separação por zona 
de OCR (Separation by OCR Zone). A zona será realçada.

5. Clique em Delete (Excluir). 

6. Clique em OK. 

Transferência de uma 
imagem para a janela 
OCR

Você pode digitalizar uma imagem contendo texto para OCR diretamente no 
Visualizador de imagens (Image Viewer) e depois transferi-la para a janela 
Separação por zona de OCR (Separation by OCR Zone) a fim de criar uma 
zona de OCR.

1. Digitalize a imagem que contém o texto de OCR.

2. Localize a imagem no Visualizador de imagens (Image Viewer) e clique 
com o botão direito do mouse nela.

3. Selecione Copiar imagem na configuração de trabalho (Copy image to 
job setup). A caixa de diálogo Copiar imagem na configuração do trabalho 
(Copy Image to Job Setup) será exibida.

4. Digite o nome da nova imagem no campo Salvar imagem como 
(Save image as).

5. Clique em OK.
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Definição do 
intervalo do tamanho 
da imagem de OCR

Às vezes, uma imagem de OCR é pequena demais para ser lida. Você pode 
definir um intervalo de tamanho de imagem para excluir as imagens muito 
pequenas.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por OCR (Separation > By OCR). A janela 
Separação por zona de OCR (Separation by OCR Zone) será exibida.

4. Selecione uma imagem e clique com o botão direito do mouse na zona de 
OCR. A caixa de diálogo Propriedades gerais de código de barras e OCR 
(General Bar Code and OCR Zone Properties) será exibida.

OBSERVAÇÃO: se não houver uma zona de OCR, esta opção não estará 
disponível até essa zona ser definida.

5. Marque a caixa de seleção Extrair códigos de barra/OCR de imagens 
entre (Extract bar codes/OCR from images between) e defina um intervalo 
para o tamanho mínimo e máximo de bytes.

6. Depois de ajustar as configurações, clique em OK para fechar a caixa de 
diálogo e voltar à janela Separação por Zona de OCR (Separation by OCR 
Zone).

7. Após editar uma zona de OCR, teste-a para saber se ela ainda está 
legível. 

Criação de um anexo 
com zonas de OCR

Criar anexos é útil em trabalhos nos quais geralmente todas as páginas são 
documentos (por exemplo, documentos de transação como cheques, 
passagens aéreas, faturas etc.), mas que eventualmente contêm uma página 
(como um memorando correspondente) que precisa ser anexada a um 
documento.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione um nome de trabalho na lista suspensa Nome do trabalho 
(Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida.

4. Selecione uma imagem na lista suspensa Imagem (Image). Se você 
precisar digitalizar a imagem, clique no ícone verde Iniciar/Digitalizar 
(Start/Scan) na janela Separação por zona de OCR (Separation by OCR 
Zone) 

5. Usando o cursor, defina a zona de OCR na imagem onde você espera 
encontrar o texto do OCR. A área definida para o anexo de OCR deverá 
estar em branco em todas as demais páginas do lote. A caixa de diálogo 
Configuração de zona de OCR (OCR Zone Setup) será exibida.
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6. Em Separação (Separation), selecione A página seguinte permanece 
no documento atual (Next page stays in current document). Essa opção 
só é válida para uma página de anexo. Se houver necessidade de vários 
anexos, uma zona de OCR de anexo deverá ser aplicada a cada um 
deles. A zona de OCR na página de anexo não está disponível para 
indexação.

7. Marque a opção Excluir página (Delete page) para excluir a página 
(frente e verso) que contém a zona de OCR e para usar a página seguinte 
como anexo. Isso é útil quando se aplicam inserções que indicam se 
a página seguinte é um anexo.

8. Clique em OK para salvar suas configurações e fechar a caixa de diálogo.

Teste de zonas de OCR Quando você define uma nova zona de OCR de uma imagem, o Capture Pro 
Software automaticamente verifica a zona para ver se ela está legível. Porém, 
se você editar a zona de OCR ou alterar suas propriedades posteriormente, 
ela pode deixar de ser legível. Você pode testar as zonas de OCR 
manualmente para verificar se ainda estão legíveis.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Separação > Por zonas do OCR (Separation > By OCR 
Zones). A janela Separação por zona de OCR (Separation by OCR Zone) 
será exibida. 

4. Clique no ícone Testar todas as zonas do código de barras, de OCR 
e de detecção de marcas (Test All Bar Code, OCR & Mark Detection 
Zones) para testar todas as zonas de OCR ou clique emTestar zona 
selecionada do código de barras, de OCR e de exclusão de marcas 
(Test Selected Bar Code, OCR & Mark Deletion Zone) para testar uma 
zona de OCR individualmente. A caixa de diálogo Valores do código de 
barras, de OCR ou de detecção de marcas (Bar Code, OCR & Mark 
Detection Values) será exibida.

5. Após ver os valores, clique em OK para retornar para a janela Separação 
por zona de OCR (Separation by OCR Zone).

6. Clique em OK. Se as configurações das zonas de OCR forem alteradas, 
teste-as novamente.

Uso de separadores 
na digitalização em 
cores

O Capture Pro Software é capaz de digitalizar imagens coloridas, em tons de 
cinza e em preto e branco com separadores (zonas de código de barras, 
zonas de OCR ou códigos de correção). As imagens podem ser separadas ou 
combinadas. Para separar essas imagens coloridas/em tons de cinza de 
forma rápida e confiável, o Capture Pro Software usa suas imagens em preto-
e-branco duplicadas para ler os separadores.
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Quando você digitaliza imagens coloridas/em tons de cinza e em preto-e-
branco, e o software detecta uma zona de código de barras, código de 
correção ou zona de OCR, ele exclui todas as quatro imagens da página 
(frente colorida, verso colorido, frente em preto-e-branco e verso em preto-e-
branco) ou as anexa ao documento ou lote novo ou atual. Essa ação será 
determinada pelas configurações da caixa de diálogo Configuração de zona 
de código de barras (Bar Zone Code Setup), da Configuração de código de 
correção (Patch Code setup) ou da caixa de diálogo Configuração de zona de 
OCR (OCR Zone Setup).

Quando você digitaliza somente imagens coloridas/em tons de cinza, 
o software lê as imagens em preto-e-branco duplicadas. Embora essas 
imagens em preto-e-branco nunca sejam exibidas ou geradas, elas são 
usadas para a leitura de código de barras, leitura de código de correção 
e indexação de OCR.

Configuração de uma 
imagem em cores 
para zonas de código 
de barras/OCR 

O Capture Pro Software é capaz de usar imagens em cores ou em tons 
de cinza como fonte para códigos de barras ou texto de OCR. Entretanto, 
o desempenho e a confiabilidade do Capture Pro Software serão aprimorados 
se você usar uma imagem em preto-e-branco como fonte.

1. Selecione Capturar > Lista de configurações de página (Capture > 
Page Setup List). A caixa de diálogo Lista de configurações de página 
(Page Setup List) será exibida.

2. Selecione uma configuração de página de digitalização simultânea na lista 
(por exemplo, Colorido e preto-e-branco - 200 DPI – Excluir brancos).

3. Coloque o original colorido/em tons de cinza no scanner e clique no ícone 
verde Iniciar/Digitalizar (Start/Scan). As imagens serão exibidas no 
Visualizador de imagens (Image Viewer).

4. Selecione a imagem em preto-e-branco contendo as zonas de códigos de 
barras e de OCR, e clique com o botão direito do mouse para exibir 
o menu contextual Imagem (Image).

5. Selecione Editar > Copiar imagem (Edit > Copy Image) para 
configuração do código de barras/OCR. A caixa de diálogo Copiar imagem 
na configuração do trabalho (Copy Image to Job Setup) será exibida.
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6. Digite o nome da nova imagem na caixa de texto e clique em OK.

7. Clique em Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

8. Abra a guia Captura (Capture) e selecione Separação > Por zonas do 
código de barras (Separation > By Bar Code Zones) ou Separação > Por 
zonas do OCR (Separation By OCR Zones). Dependendo da sua seleção, 
a janela separação por código de barras ou separação por zona de OCR 
será exibida.

9. O nome da nova imagem será exibido na caixa suspensa Imagem 
(Image). Siga os procedimentos para definir uma zona de código de barras 
ou de OCR, descritos no capítulo anterior. 

10. Clique em OK.

Isenções de 
responsabilidade 
relacionadas a 
código de barras e 
OCR

Copyright 2000-2015, AllMyPapers. Todos os direitos reservados.

Este software inclui o ABBYY® FineReader®. ABBYY e FineReader são 
marcas registradas da ABBYY. Se a instalação original deste software foi 
o Capture Pro Versão 5.5 ou anterior, este software inclui o OmniPage/-E 
OCR software © 1995-2017 Nuance Communications, Inc. Todos os direitos 
reservados.

As condições de isenções de responsabilidade relacionadas ao código de 
barras, OCR e detecção de marcas a seguir aplicam-se ao Capture Pro 
Software.

Embora o produto use uma avançada tecnologia de código de barras, de OCR 
e de detecção de marcas, um reconhecimento preciso sob todas as condições 
não pode ser garantido. O software e a documentação completos são 
fornecidos no estado em que se encontram, sem garantias explícitas ou 
implícitas relacionadas à precisão do reconhecimento do código de barras, 
OCR e detecção de marcas.

A Kodak Alaris Inc. e seus fornecedores não serão responsáveis por qualquer 
uso indevido e/ou danos subsequentes diretos ou indiretos ao uso ou violação 
ilegal causado pelo usuário em modificar, copiar, reproduzir ou traduzir 
qualquer parte da informação recuperada com OCR, detecção de marca 
e tecnologias de reconhecimento de código de barras no Capture Pro 
Software.

Uso das zonas de 
detecção de marcas

A detecção de marcas é um método para detectar a presença ou a ausência 
de uma marca de tinta em uma área específica que é usada para transmitir 
algumas informações pretendidas.

Um bom desenho do documento e as instruções claras para os replicadores 
são muito importantes para obter precisão elevada. É recomendada 
a impressão de exemplos do modelo das caixas de seleção preenchidas 
idealmente ou preenchidas em caso de erro nas instruções. Os replicadores 
devem receber instruções para preencherem o documento com uma caneta 
azul escura ou preta. Os lápis devem ser evitados tal como as canetas com 
uma cor de tinta semelhante à cor de eliminação se a forma for colorida 
durante a digitalização.

A configuração de detecção de marcas permite que você defina:

• o nome da zona de detecção de marcas.

• o local físico onde você encontra a marca (localização da zona na imagem).
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• o valor quando a marca é detectada.

• o valor quando a marca não é detectada.

• se a marca estiver contida em uma moldura como uma caixa ou círculo.

• a sensibilidade para distinguir a marca devido a sujidade randômica ou 
“ruído”.

• um grupo de zonas de detecção de marcas para retornar um conjunto de 
valores simples.

Use a opção Configuração do código de barras, OCR e detecção de marcas 
(Bar Code, OCR and Mark Detection Setup) na guia Capturar (Capture) na 
caixa de diálogo Configuração do trabalho (Job Setup) para configurar os 
parâmetros da detecção de marcas para uma ou mais zonas de detecção 
de marcas.

OBSERVAÇÕES:

• A separação em lote e documento não é fornecida para zonas de 
detecção de marcas.

• Para obter os melhores resultados, use imagens com resolução de 
300 dpi. 

Digitalização de uma 
imagem para a 
configuração de 
detecção de marcas

O Capture Pro Software permite que você capture e salve o status de uma 
área de marcas ou de um grupo de áreas de marcas.

Para usar a detecção de marcas:

• Digitalize uma imagem com as áreas de marcas no Capture Pro Software.

• Desenhe e selecione as zonas de detecção de marcas.

• Configure grupos opcionais de zonas de detecção de marcas.

O Capture Pro Software permite que você digitalize imagens de detecção de 
marcas diretamente na janela Detecção de marcas (Mark Detection) para 
exibição, definição e edição.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).

3. Abra a guia Capturar (Capture) e selecione Código de barras, OCR 
e detecção de marcas (Bar Code, OCR and Mark Detection). A janela 
Detecção de marcas (Mark Detection) será exibida.

4. Selecione o botão verde Iniciar/Digitalizar (Start/Scan). A caixa de 
diálogo Digitalizar imagem (Scan Image) será exibida.

5. Posicione o documento original no alimentador e clique em Iniciar/
Digitalizar (Start/Scan). A imagem será exibida na caixa de diálogo. 
Digitalize a imagem da maneira mais reta possível. Seu scanner usará os 
parâmetros de configuração de página atual do Capture Pro Software.

OBSERVAÇÕES:

• Qualquer configuração atual de rotação automática, corte automático 
e correção de distorção será aplicada à imagem digitalizada antes de sua 
exibição.

• Se a imagem estiver aceitável, digite um nome para ela no campo Nome da 
imagem (Image name). O nome da imagem não deve conter nenhum 
destes caracteres:  : “  ?  .  <  >  \  /.



A-61993_pt-br  Março de 2022 161

• Para descartar a imagem, clique em Cancelar (Cancel).

• Antes de definir uma zona de detecção de marcas, é necessário ter pelo 
menos uma imagem na lista suspensa Imagem (Image).

• Você também pode transferir uma imagem do Visualizador de imagens para 
a janela Detecção de marcas (Mark Detection). Consulte “Transferência de 
uma imagem para a janela Detecção de marcas (Mark Detection)” a seguir 
neste mesmo capítulo.

6. Clique em OK para salvar a imagem.

Criação e seleção de 
uma zona de detecção de 
marcas

Antes de usar uma imagem de detecção de marcas para indexação, você 
precisa criar e selecionar uma ou mais zonas de detecção de marcas. 
As zonas de detecção de marcas são criadas para indicar onde procurar uma 
marca. Zonas múltiplas de detecção de marcas podem ser agrupadas para 
preencherem um campo de índice simples.

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name) e abra a guia Captura (Capture).

3. Selecione Código de barras, OCR e detecção de marcas (Bar Code, 
OCR and Mark Detection). A janela Código de barras, OCR e detecção de 
marcas (Bar Code, OCR & Mark Detection) será exibida.

4. Selecione uma imagem na lista suspensa Imagem (Image). Se você 
precisar digitalizar uma imagem, clique no ícone verde Iniciar/Digitalizar 
(Start/Scan) na janela Código de barras, OCR e detecção de marcas 
(Bar Code, OCR & Mark Detection).

• Posicione o cursor do mouse no canto superior esquerdo da área da 
imagem onde você deseja definir a localização dessa zona de 
detecção de marcas.

• Quando traçar uma zona ao redor de uma área de detecção de marcas 
que contenha uma moldura para a marca (caixa, círculo, elipse etc.) 
mantenha uma área de borda de aproximadamente 0,63 cm ao redor 
da moldura.

• Quando traçar uma zona ao redor de uma área de detecção de marcas 
que não contenha uma moldura (uma área vazia ou uma linha 
é fornecida para a marca), certifique-se de que os caracteres ou outros 
elementos da imagem não estão na zona.

5. Mantenha pressionado o botão esquerdo do mouse e arraste o cursor 
para traçar um retângulo ao redor da área de marcas. Depois que liberar 
o cursor, a caixa de diálogo Configuração de zona de detecção de marcas 
será exibida.

6. No campo Nome da zona (Zone name), digite um nome para a nova zona 
de detecção de marcas. É necessário criar um nome para salvar a zona.

7. Depois de digitar as outras configurações, clique em OK para fechar 
a caixa de diálogo e voltar à janela Detecção de marcas (Mark Detection). 
Consulte “Caixa de diálogo Configuração da zona de detecção de marcas 
(Mark Detection Zone Setup)” para ver descrições de campo.

8. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup).
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Edição de uma zona de 
detecção de marcas

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).

3. Abra a guia Capturar (Capture) e selecione Código de barras, OCR 
e detecção de marcas (Bar Code, OCR & Mark Detection). A janela Zona 
Código de barras, OCR e detecção de marcas (Bar Code, OCR & Mark 
Detection Zone) será exibida.

4. Clique na zona de detecção de marcas que deseja alterar. 

5. Clique com o botão direito do mouse para exibir o menu contextual 
e clique em Propriedades da zona (Zone Properties). A caixa de diálogo 
Configuração de zona de detecção de marcas (Mark Detection Zone 
Setup) será exibida.

6. Depois de alterar suas configurações, clique em OK para fechar a caixa 
de diálogo.

7. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). 

8. Após editar uma zona de detecção de marcas, teste a zona de detecção 
de marcas usando a função Testar zona do código de barras, OCR 
e detecção de marcas selecionada (Test Selected Bar Code, OCR or Mark 
Detection zone). 

Exclusão de uma zona 
de detecção de marcas

1. Selecione Arquivo > Configuração de trabalho (File > Job Setup). 
A caixa de diálogo Configuração de trabalho (Job Setup) será exibida.

2. Selecione uma configuração de trabalho na lista suspensa Nome do 
trabalho (Job Name).

3. Abra a guia Capturar (Capture) e selecione Código de barras, OCR 
e detecção de marcas (Bar Code, OCR & Mark Detection). A janela Zona 
Código de barras, OCR e detecção de marcas (Bar Code, OCR & Mark 
Detection Zone) será exibida.

4. Clique na zona de detecção de marcas que deseja excluir. 

5. Clique em Delete (Excluir). 

6. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração do trabalho (Job Setup). 

Transferência de uma 
imagem para a janela 
Detecção de marcas 
(Mark Detection)

O Capture Pro Software permite transferir uma imagem contendo zonas de 
detecção de marcas do Visualizador de imagens (Image Viewer) para a janela 
Detecção de marcas (Mark Detection) para criar zonas de detecção de 
marcas. 

1. Na janela Principal, digitalize a imagem que contém as marcas.
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2. Clique com o botão direito do mouse na imagem que você deseja 
transferir do Visualizador de imagens (Image Viewer).

3. Selecione Copiar imagem na configuração de trabalho (Copy Image to 
Job Setup). A caixa de diálogo Copiar imagem na configuração do 
trabalho (Copy Image to Job Setup) será exibida.

4. Digite o nome da nova imagem no campo Salvar imagem como (Save 
image as).

5. Clique em OK. Agora você pode exibir a imagem na janela Detecção de 
marcas (Mark Detection) e usá-la para criar uma zona de detecção de 
marcas.

Você também pode digitalizar imagens de detecção de marcas diretamente na 
janela Detecção de marcas (Mark Detection). Consulte “Digitalização de uma 
imagem para a configuração de detecção de marcas” anteriormente neste 
capítulo.

Caixa de diálogo 
Configuração da zona de 
detecção de marcas 
(Mark Detection Zone 
Setup)

Use esta caixa de diálogo para nomear sua zona de detecção de marcas, 
descrever como a marca é detectada e, opcionalmente, agrupar múltiplas 
zonas para produzir um resultado simples.

Nome da zona (Zone name) — insira o nome da sua nova zona de detecção 
de marcas. Este nome identifica a área de marcas e aparece na configuração 
do índice como MD_(nomedazona) na lista de valores padrão.
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Valor preenchido (Filled value) — a zona retornará este valor quando 
é detectado para ser “preenchido”. O valor pode ser um valor simples como 
“1” ou um valor com múltiplos caracteres como “Esta caixa de seleção foi 
marcada”. O valor também pode ser deixado vazio.

Se a zona for adicionada em um grupo de zonas de detecção de marcas, este 
valor é incluído no valor retornado pelo grupo da zona. Consulte “Configuração 
do grupo da zona de detecção de marcas” posteriormente nesta seção.

Valor não preenchido (Unfilled value) — a zona retornará este valor quando 
é detectado para ser “não preenchido” ou vazio. O valor pode ser um valor 
simples como “0” ou um valor com múltiplos caracteres como “Esta caixa de 
seleção não foi marcada”. O valor também pode ser deixado vazio. 

Se a zona for adicionada em um grupo de zonas de detecção de marcas, este 
valor não é usado. O valor não preenchido retornado por um grupo e zonas 
é definido na configuração do grupo. Consulte “Configuração do grupo da 
zona de detecção de marcas” posteriormente nesta seção.

Face: (Side:) Frente (Front) ou Verso (Back) — selecione se a área de 
marcas deve ficar localizada na frente ou no verso de uma imagem.

Moldura: (Frame:) Moldura (Frame) ou Sem moldura (No Frame) — uma 
moldura pode ser um retângulo, um círculo, uma elipse etc. onde a marca 
deve ser colocada. As dimensões da moldura devem ser, no mínimo, de 
50 pixels em cada direção, 4 mm (0,2 pol.) no caso de resolução de 300 dpi.

• Se a opção Moldura (Frame) for selecionada, deve ser preenchida por 
qualquer forma como um X, uma marca de conferido, sombreamento não 
sólido, linhas horizontais ou verticais etc. A forma de preenchimento 
recomendada é um X ou uma marca de conferido. Um número pequeno de 
pixels pretos contíguos na área da moldura levará a um valor de 
“preenchido” para a zona de detecção de marcas.

• Se a opção Sem moldura (No Frame) estiver selecionada, qualquer marca 
de vários pixels pretos contíguos levará a um valor de “preenchido” para 
a zona de detecção de marcas. Se a forma contiver molduras para uma 
marca, mas se a moldura for colorida então a opção Sem moldura 
(No Frame) deverá ser selecionada.

Sensibilidade da marca: (Mark sensitivity:) Baixa (Low) até Alta (High) — 
para formas bem impressas de alta qualidade, a sensibilidade deve ser 
definida para Alta (High). Quando a opção Alta (High) é selecionada, marcas 
pequenas ou somente alguns pixels pretos contíguos levarão a um valor de 
“preenchido”. Para formas de qualidade baixa, uma sensibilidade menor 
permitirá que as pequenas manchas ou as fibras visíveis do papel sejam 
ignoradas, resultando em um processamento com sucesso. 

Adicionar zona no grupo (Add zone to group) — selecione esta opção se 
esta zona de detecção de marcas estiver associada com outras zonas de 
detecção de marcas, e um resultado simples for desejado para o grupo de 
zonas associadas. Por exemplo, um formulário apresenta uma pergunta com 
três caixas de seleção “Gosto”, “Não gosto” e “Tanto faz”. Três zonas de 
detecção de marcas são definidas, uma para cada resposta possível. Todas 
as três zonas de detecção de marcas terão esta opção selecionada e serão 
adicionadas no mesmo grupo.

Aplicação de zonas de 
detecção de marcas a 
páginas específicas

Para obter informações sobre como selecionar a(s) página(s) para aplicar 
todas as zonas de detecção de marca, consulte “Caixa de diálogo 
Configuração das zonas das páginas (Zone Pages Setup)” anteriormente 
neste capítulo. 
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Configuração do grupo 
da zona de detecção de 
marcas

Para cada marca esperada em uma página, uma zona de detecção de marcas 
é criada e configurada conforme descrito na seção “Configuração da zona de 
detecção de marcas”. Cada zona de detecção de marcas retornará um valor, 
dependendo se a área de marcas for “preenchida” ou “não preenchida”. Isso 
funciona bem para perguntas simples de “Sim” ou “Não”. Para uma pergunta 
com respostas múltiplas possíveis, onde uma resposta simples é desejada, as 
zonas de detecção de marcas podem ser “agrupadas”. 

Por exemplo, a pergunta “Quando viajar de avião, qual é sua preferência de 
assento?” pode ter três respostas possíveis: “Corredor”, “Janela” ou “Tanto 
faz”. Três zonas de detecção de marcas serão criadas, uma para cada uma 
das três respostas possíveis. As três zonas de detecção de marcas serão 
todas adicionadas em um novo grupo de detecção de marcas. Um campo de 
índice simples será criado para a resposta a esta pergunta e o grupo de 
detecção de marcas será usado como o valor padrão para o campo do índice. 
Consulte “Adição de um campo de índice de documento” no Capítulo 2.

Para adicionar uma zona de detecção de marcas no grupo:

1. Selecione Adicionar zona no grupo (Add zone to group). Uma lista dos 
grupos de detecção de marcas existentes será exibida. Selecione o grupo 
onde deseja adicionar esta zona de detecção de marcas. 

• Se não existir nenhum grupo de detecção de marcas, a caixa de diálogo 
Criar novo grupo de zona (Create New Zone Group) será exibida.

• Digite o nome para o novo grupo e clique em OK.

2. Selecione Adicionar/Editar grupo (Add/Edit Group). A caixa de diálogo 
Grupo da zona de detecção de marcas (Mark Detection Zone Group) será 
exibida.
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• Lista de grupos (Group List) — mostra o nome do grupo atual de 
detecção de marcas. Clique na lista suspensa para exibir outros grupos 
de detecção de marcas.

• Nenhum valor de seleção (No selection value) — o grupo retornará 
este valor se não for detectada qualquer marca em nenhuma das 
zonas de detecção de marca no grupo. O valor pode ser um valor 
simples como “0” ou um valor com múltiplos caracteres como 
“Nenhuma seleção”. O valor também pode ser deixado vazio. 

• Propriedades do grupo (Group properties) — usando o botão ->, 
selecione e mova as zonas de detecção de marcas que deseja incluir 
no grupo, a partir da lista Zonas não no grupo (Zones not in group) para 
a lista Zonas no grupo (Zones in the group).

3. Usando o botão <-, selecione e mova as zonas de detecção de marcas 
que não deseja incluir no grupo, a partir da lista Zonas no grupo (Zones in 
the group) para a lista Zonas não no grupo (Zones not in group).

4. Clique em OK.
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5 Configuração de página 

Caixa de diálogo 
Configuração de 
página (Page Setup)

Use a caixa de diálogo Configuração de página (Page Setup) para definir 
parâmetros de digitalização de imagens, e excluir automaticamente imagens, 
dividi-las ou mesclá-las.

Para acessar a Configuração de página, clique em Arquivo > Configuração 
de página (File > Page Setup).

Nome da configuração de página (Page setup name) — selecione uma 
Configuração de página existente na lista suspensa.

Ícones
Adicionar (Add): exibe a caixa de diálogo Salvar como (Save 
As), que permite adicionar uma nova configuração de página.

Renomear (Rename): exibe a caixa de diálogo Renomear 
(Rename), que permite renomear a configuração de página 
selecionada. 
Excluir (Delete): exibe uma caixa de confirmação, que permite 
excluir a configuração de página selecionada. 
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Guia Imagem (Image) — permite definir a maneira como as imagens serão 
exibidas após a digitalização.

Guia Exclusão automática (Auto Delete) — permite excluir automaticamente 
uma imagem digitalizada se ela exceder as configurações inseridas nessa 
guia.

Guia Dividir (Split) — permite dividir automaticamente uma imagem 
digitalizada se ela exceder uma determinada largura. 

Guia Mesclar (Merge) — permite mesclar as imagens de frente e verso de 
uma página digitalizada em uma única imagem. 

Guia QC inteligente (Intelligent QC) — permite que você configure as 
seguintes opções a serem aplicadas durante o processamento de imagens: 
orientação automática, binarizar e enchimento de buracos.

OK — salva suas configurações e fecha a caixa de diálogo.

Cancelar (Cancel) — fecha a caixa de diálogo sem salvar nenhuma alteração. 

Aplicar (Apply) — aceita as alterações feitas na caixa de diálogo sem que 
a caixa seja fechada.

Guia Imagem (Image) A guia Imagem (Image) permite configurar os parâmetros de digitalização 
e fazer alterações nas imagens antes de armazená-las.

Configurações (Settings) — quando você clicar em Configurações 
(Settings), a fonte de dados TWAIN será exibida, permitindo definir as 
configurações de digitalização. Para obter informações mais específicas sobre 
o scanner, consulte o Guia do usuário do scanner. 

Exibir configurações antes de digitalizar (Display settings prior to scanning) 
— abre a fonte de dados TWAIN depois que você clica no ícone verde Iniciar/
Digitalizar (Start/Scan).

Atraso da mesa digitalizadora modular (Flatbed delay) — define uma 
demora cronometrada entre digitalizações de forma que o operador possa 
abrir outra página em um livro ou revista e colocá-la na mesa digitalizadora 
modular. Selecione o número de segundos do atraso na lista suspensa.
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Rotação de software (Software rotation) — gira a imagem automaticamente 
após a digitalização. Selecione as opções Nenhum (None), 90, 180 ou 
270 graus. Quando você digita uma configuração diferente, o ícone exibe 
a aparência que a imagem terá após a rotação. 

OBSERVAÇÃO: A configuração dessa rotação na fonte de dados TWAIN 
pode proporcionar melhor desempenho na digitalização do 
que o uso da rotação de software na guia Imagem.

Modo frente e verso (2-sided mode) — selecione o modo Clássico (Classic) 
ou Calendário (Calendar) na lista suspensa para digitalização em frente 
e verso; o ícone correspondente será exibido. Compare a imagem original 
com o ícone para determinar se ela tem um layout clássico ou de calendário.

• Clássico (Classic): normalmente usado para relatórios de várias páginas. 
A opção de Modo frente e verso (2-sided mode) influencia apenas 
a maneira como a imagem da frente é girada em relação à imagem do 
verso. Ela não define a rotação geral do documento (0°, 90°, 180° ou 
270°).

Ao usar a opção Clássico (Classic): Modo frente e verso (2-sided mode), 
as imagens de frente e verso correspondem ao seguinte:

Uma frente girada 0° resulta em um verso girado 0°.
Uma frente girada 180° resulta em um verso girado 180°.
Uma frente girada 90° resulta em um verso girado 270°. 
Uma frente girada 270° resulta em um verso girado 90°.

• Calendário (Calendar): usado geralmente em apresentações, relatórios 
financeiros, calendários etc. A opção Modo frente e verso (2-sided mode) 
influencia apenas a maneira como a imagem da frente é girada em relação 
à imagem do verso. Ela não define a rotação geral do documento (0°, 90°, 
180° ou 270°).

• Ao usar a opção Calendário (Calendar): Modo frente e verso (2-sided 
mode), as imagens de frente e verso correspondem ao seguinte: 

Uma frente girada 0° resulta em um verso girado 180°.
Uma frente girada 180° resulta em um verso girado 0°.
Uma frente girada 90° resulta em um verso girado 90°. 
Uma frente girada 270° resulta em um verso girado 270°.

Ordem da imagem (Image order) — selecione uma imagem e use Mover 
para cima (Move Up) ou Mover para baixo (Move Down) para alterar 
a ordem das imagens listadas na caixa.

Sobrecorte (Overcrop) — marque essa caixa de seleção para aparar todas as 
bordas da imagem no valor especificado em centésimos (1/100) de polegada.

OK — salva suas configurações e fecha a caixa de diálogo.

Cancelar (Cancel) — fecha a caixa de diálogo sem salvar nenhuma alteração. 

Aplicar (Apply) — aceita as alterações feitas na caixa de diálogo sem que 
a caixa seja fechada.
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Guia Exclusão 
automática (Auto Delete)

A guia Exclusão automática (Auto Delete) permite definir opções para excluir 
automaticamente uma imagem. Você pode querer excluir imagens sem 
conteúdo ou possivelmente páginas com muito conteúdo (por exemplo, 
o verso de um formulário que contém muitos textos explicativos). 
As configurações de exclusão automática são especificadas 
independentemente para imagens de frente e verso. 

Se você estiver digitalizando simultaneamente imagens em cores, em escala 
de cinza e em preto e branco, as configurações de exclusão automática 
também serão definidas independentemente. Portanto, você pode optar por 
excluir somente o tipo de imagem selecionado.

Ao usar a Exclusão automática, recomenda-se digitalizar alguns documentos 
representativos que você gostaria de excluir, usando a opção Teste (Test). 
Os resultados da opção Teste (Test) ajudarão a determinar se você deve 
definir os valores da exclusão automática usando a opção Tamanho da 
imagem (em bytes) é (Image size (byte) is) ou Conteúdo da imagem (em %) 
(Image content (%)). Para obter mais informações, consulte “Teste das suas 
configurações”. 

• Tamanho da imagem (em bytes) é (Image size (byte) is) Superior a 
(Above) — selecione essa opção para excluir páginas com excesso de 
informações. Por exemplo, se estiver digitalizando documentos com 
conteúdo semelhante (como formulários de seguro) na frente e no verso da 
página, e se a frente da página tiver algum conteúdo que você deseja 
manter, mas o verso tiver instruções sobre como fazer uma reclamação 
(que você não precisa manter), digite o número de bytes que você quer que 
o Capture Pro Software exclua qualquer arquivo de imagem que exceder 
esse número. Qualquer imagem com tamanho superior a esse valor será 
considerada grande demais e será excluída. 

• Tamanho da imagem (em bytes) é (Image size (byte) is) Inferior a (Below) 
— selecione esta opção se quiser excluir páginas com pouco ou nenhum 
conteúdo. Digite o número de bytes que o Capture Pro Software 
considerará como um arquivo de imagem em branco. Qualquer imagem 
com tamanho inferior a esse valor será considerada em branco e será 
excluída.
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• Conteúdo da imagem (em %) é (Image content (%) is) Superior a (Above) 
— esta opção é semelhante a Tamanho da imagem (em bytes) 
é Superior a, exceto pelo fato de que você deve digitar o valor percentual 
que fará com que o Capture Pro Software considere que a imagem tem 
conteúdo em excesso. Qualquer imagem maior do que esse valor será 
excluída. 

• Conteúdo da imagem (em %) é (Image content (%) is) Inferior a (Below) 
— esta opção é semelhante a Tamanho da imagem (em bytes) é Inferior 
a, exceto pelo fato de que você deve digitar o valor percentual que fará com 
que a imagem seja considerada em branco ou com pouco conteúdo pelo 
Capture Pro Software. Qualquer imagem com tamanho inferior a esse valor 
será considerada em branco e será excluída. Use essa configuração 
quando houver páginas em branco. 
OBSERVAÇÕES:

• Ao selecionar a opção Tamanho da imagem (em bytes) (Image size 
(byte)), outros fatores como resolução, compactação etc. afetarão 
o tamanho da imagem. 

• A opção Conteúdo da imagem (em %) (Image content (%)) apenas 
verifica a porcentagem de informações na imagem e, portanto, é uma 
opção mais consistente e confiável a ser usada quando as imagens 
tiverem diferentes tamanhos, resoluções, compactações etc.

Nunca (Never) — clique em Nunca (Never) se não quiser que o software 
exclua nenhuma imagem automaticamente.

Aplicar exclusão a ambas as imagens de um lado (Apply deletion to both 
images of a side) — exclui imagens em preto-e-branco e coloridas/em tons 
de cinza.

Excluir imagens após QC inteligente (Delete images after Intelligent QC) — 
selecione esta opção se quiser que as funções de processamento de imagem 
de QC inteligente atuem em uma imagem antes que ela seja excluída. Por 
exemplo, você pode querer criar uma imagem em escala de cinza a partir de 
uma imagem colorida antes de excluir a imagem colorida.

Teste (Test) — exibe a caixa de diálogo Testar imagem (Test Image), que 
permite digitalizar uma imagem de amostra e testar suas configurações.

OK — salva suas configurações e fecha a caixa de diálogo.

Cancelar (Cancel) — fecha a caixa de diálogo sem salvar nenhuma alteração. 

Aplicar (Apply) — aceita as alterações feitas na caixa de diálogo sem que 
a caixa seja fechada.

Manter imagens em branco (Keep blank images) — quando está opção está 
ativada (selecionada), as imagens em branco
ficam destacadas e não são excluídas.
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Teste das suas configurações A caixa de diálogo Testar imagem (Test Image) permite testar as imagens 
e determinar se elas correspondem ou não às suas configurações de 
exclusão. É altamente recomendado que você teste suas configurações para 
ter certeza de que as imagens que deseja excluir sejam excluídas e que 
mantenha as imagens que deseja manter.

1. Clique em Teste (Test) na guia Exclusão automática (Auto Delete) para 
exibir a caixa de diálogo Testar imagem.

2. Insira no scanner um documento semelhante àquele no qual você quer 
testar a exclusão automática.

3. Antes de digitalizar uma página, selecione Frente em preto-e-branco 
(Black and White - Front), Verso em preto-e-branco (Black and White - 
Back), Frente em cores (Color - Front) ou Verso em cores (Color - 
Back) na lista suspensa.

OBSERVAÇÃO: as opções que são exibidas na lista suspensa dependem 
da Configuração de página.

4. Clique no ícone Iniciar/Digitalizar (Start/Scan). Os resultados serão 
exibidos na caixa de diálogo Resultado do teste (Test result).
• A imagem é (The image is): indica se a imagem está Em branco 

(Blank) ou Não está em branco (Not Blank).

• A imagem tem - (bytes) (Image size is - (bytes)): o tamanho da 
imagem de teste em bytes.

• O conteúdo é - % (Content is - %): o percentual do conteúdo na 
imagem de teste.

5. Avalie os valores exibidos na caixa de resultados de teste A imagem tem 
- (bytes) (Image size is - (bytes)) e/ou O conteúdo é - % (Content is - %).

OBSERVAÇÃO: com base no valor exibido na caixa de resultados de 
teste, convém inserir um valor ligeiramente mais baixo 
ou mais alto do que o valor exibido, dependendo da 
saída desejada. Por exemplo, se o tamanho das 
imagens em branco da sua imagem representativa for 
799 bytes e das imagens quase em branco for 900 
bytes, convém inserir um valor de 850 bytes no campo 
A imagem tem - (bytes) (Image size is - (bytes)), na guia 
Exclusão automática.

6. Clique em OK.
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OBSERVAÇÃO: durante a digitalização da imagem de teste, as opções para 
Dividir e Mesclar serão ignoradas.

Divisão de imagens Dividir imagens é usado geralmente no processamento de formulários. 
Ao digitalizar formulários dobrados, talvez seja interessante dividi-los em 
várias imagens menores para tornar o registro e a verificação dos formulários 
ainda mais confiável. O Capture Pro Software divide e classifica as imagens, 
além de extrair dados delas na sequência correta.

A divisão ocorre somente em páginas que tenham as larguras mínima 
e máxima expressas em centésimos (1/100) de polegada. A operação de 
divisão é vertical, o que significa que a página é dividida em porções iguais 
à esquerda, ao meio e à direita (se a divisão for em três partes). A divisão 
ocorre após a rotação. Para digitalizar formulários grandes que não podem ser 
digitalizados no modo paisagem porque são maiores do que o transporte do 
scanner, a rotação é necessária.

Defina a opção Rotação de software (Software rotation) na guia Imagem 
(Image) da caixa de diálogo Configuração de página (Page Setup), 
dependendo de como você digitalizar o documento.

Após a divisão, as imagens com números ímpares serão consideradas 
imagens da frente e as com números pares serão consideradas imagens do 
verso. Como o Capture Pro Software mostra imediatamente o resultado após 
mesclagem ou divisão, você pode testar sua configuração de página e fazer 
alterações caso seja necessário.

Se você estiver digitalizando imagens de um lado (ou quando estiver 
digitalizando na mesa digitalizadora modular), a divisão ocorrerá somente na 
imagem da frente.

Divisão de uma imagem Para dividir imagens durante a digitalização:

1. Clique na caixa de seleção Dividir página ou Imagem (Split Page or 
Image).
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OBSERVAÇÃO: as opções Mesclar e Dividir não podem ser ativadas 
simultaneamente. Para desativar a opção Mesclar, abra 
a guia Mesclar (Merge) e desmarque a caixa de seleção 
Mesclar frente e verso em uma só imagem (Merge 
front and back into one single image).

2. Escolha de 2 a 12 imagens na lista suspensa Número resultante de 
imagens (Number of resultant images).

3. Selecione um intervalo de larguras para a página ou imagem no campo 
Dividir a imagem se a largura estiver entre (Split image if width is 
between). Se a largura da página estiver dentro desse intervalo, ela será 
dividida. Se a frente ou o verso estiver fora do intervalo, nenhum dos dois 
lados será dividido.

4. Selecione Frente (Front) e/ou Verso (Back) para ativar uma divisão. 
Um gráfico será exibido mostrando a seleção. Por exemplo, se ambas as 
caixas de seleção estiverem marcadas, os ícones serão exibidos com um 
“X” vermelho em cada página.

Clique em cada segmento de imagem na ordem em que você deseja que 
as imagens sejam enviadas. Quando você clica no segmento de imagem, 
o “X” vermelho desaparece.
Os segmentos de imagem que ainda estiverem marcados com um “X” 
vermelho serão excluídos e não serão enviados para a saída. Essa opção 
pode ser útil para a última página de um panfleto que seja sempre em 
branco.

OBSERVAÇÃO: ao usar um scanner simplex, selecionar Frente (Front) 
e Verso (Back) não resultará em uma divisão. Selecione 
só Frente (Front) para causar uma divisão.

5. Se desejar, clique em Redefinir ordem (Reset Order) para excluir 
a ordem de saída e começar novamente.

6. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração de página (Page Setup). 
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Guia Mesclar (Merge) Para mesclar imagens durante a digitalização:

1. Clique na caixa de seleção Mesclar frente e verso em uma só imagem 
(Merge front and back image into one single image).

OBSERVAÇÃO: as opções Mesclar e Dividir não podem ser ativadas 
simultaneamente. Para desativar a opção Dividir, abra 
a guia Dividir (Split) e desmarque a caixa de seleção 
Dividir página ou imagem (Split Page or Image).

2. Defina a largura e a altura mínima e máxima da imagem em centésimos 
(1/100) de polegada para imagens em frente e verso a serem mescladas 
nos campos se a largura estiver entre (if width is between) e se a altura 
estiver entre (if height is between). O Capture Pro Software mescla apenas 
as imagens que atendem a esses parâmetros. Nenhuma outra imagem 
é mesclada. 

3. Clique em Horizontal ou Vertical para obter a orientação desejada na 
imagem mesclada.

4. Clique em Frente (Front), Verso (Back) ou Verso (Back), Frente (Front) 
para obter a ordem desejada da frente e do verso da imagem mesclada.

5. Clique em OK para salvar suas configurações e fechar a caixa de diálogo 
Configuração de página (Page Setup).
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Guia QC inteligente 
(Intelligent QC)

A guia QC inteligente (Intelligent QC) da caixa de diálogo Configuração de 
página (Page Setup) permite que você configure as funções de 
processamento de imagem durante a captura de imagem:
• Orientação automática (Auto-orientation)
• Binarizar (Binarize)
• Criar tons de cinza a partir do colorido (Create Grayscale from Color) 
• Preenchimento de furos (Hole fill)
• Corte automático (Auto crop)
• Corrigir distorção (Deskew)

Orientação automática (Auto-
orientation)

Orientação automática (Auto-Orientation) analisa o conteúdo de seus 
documentos e orienta cada documento para que possa ser lido corretamente. 
Você pode selecionar Orientar frente (Orient Front), que orienta a frente de 
uma página, ou Orientar verso (Orient Back), que orienta o verso de uma 
página.

Binarizar (Binarize) Binarizar (Binarize) converte imagens coloridas ou em escala de cinza para 
preto e branco. O scanner deve ser configurado para digitalizar cores ou 
escala de cinza. Durante a digitalização, a imagem será convertida para preto 
e branco e verificada em relação a falhas. Se uma falha excessiva for 
detectada, a imagem será sinalizada e você terá a oportunidade de digitalizá-
la novamente para ajustar a imagem e melhorar o conteúdo desejado após 
a digitalização. 

Ajustes de imagem (Image Adjustments)

• Ativar binarizar (Enable Binarize) — marque esta opção para ajustar 
o Contraste (Contrast). 
- Contraste (Contrast): define o contraste de cada imagem. 

Se o documento definido contiver imagens com texto ou fundo colorido/
escuro com falhas, será recomendável aumentar o contraste.
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Se seus documentos forem de papel leve e o conteúdo da parte de trás for 
visível na parte da frente, a redução do contraste poderá produzir 
melhores resultados. Em muitos casos, um contraste de 0 produzirá 
o melhor resultado.

Opções de retenção de imagem (Image Retention Options)

• Manter todas as imagens (Keep all images) — por padrão, apenas as 
imagens coloridas ou em escala de cinza sinalizadas permanecerão no lote 
com as imagens em preto e branco e apenas essas imagens poderão ser 
modificadas depois da digitalização. Marque esta caixa se quiser manter 
todas as imagens coloridas ou em escala de cinza para que você possa 
modificar qualquer imagem enviada pelo scanner, sendo elas sinalizadas 
ou não.
OBSERVAÇÕES:

• Quando se utiliza um scanner Kodak ou Alaris com Limite - QC 
Inteligente (Thresholding - Intelligent QC) habilitado, a imagem em tons 
de cinza só fica disponível para as imagens identificadas pelo scanner 
como contendo muitas falhas.

• Selecionar Manter todas as imagens (Keep all images) não fará com 
que as imagens excluídas automaticamente sejam mantidas.

• Se você não deseja manter imagens coloridas ou em escala de cinza 
após a saída, basta marcar a caixa de seleção Preto e Branco 
(Black and White) na guia Saída (Output) da Configuração de trabalho 
(Job Setup).

Criar tons de cinza a partir do 
colorido (Create Grayscale 
from Color)

Criar escala de cinza a partir de cores (Create Grayscale from Color) criará 
uma imagem em escala de cinza para todas as imagens coloridas enviadas 
ao scanner. As imagens coloridas e em escala de cinza serão adicionadas ao 
lote. Nenhuma configuração é necessária.

Preenchimento de furos 
(Hole fill) 

Preenchimento de furos (Hole fill) preencherá furos redondos ou retangulares 
encontrados perto da borda da página.

O segundo plano do scanner deve ser preto. Você pode selecionar Preencher 
frente (Fill Front), que preenche furos encontrados na parte frontal de uma 
página, ou Preencher verso (Fill Back), que preenche furos encontrados no 
verso de uma página. 

Corte automático (Auto crop) Corte automático (Auto crop) cortará a imagem digitalizada para remover 
a borda de segundo plano que pode aparecer no final da imagem. 
É recomendável usar o recurso de Corte automático do scanner, se 
disponível. Nenhuma configuração é necessária.

Corrigir distorção (Deskew) Corrigir distorção (Deskew) corrige uma rotação ou inclinação leve de uma 
imagem. Quando esta opção for marcada, o corte automático será 
selecionado automaticamente. Nenhuma configuração é necessária.
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6 Atalhos de produtividade

Gerenciador 
de botões 

Depois que os atalhos de digitalização forem criados, você poderá atribuir 
cada nome de atalho a um valor específico para o botão Scanner 
(se o scanner tiver botões). É possível atribuir até 9 botões. Após a atribuição 
dos números, você pode acessar rapidamente e usar essas opções de 
digitalização, por meio do botão Iniciar do painel de controle. 

Para acessar a caixa de diálogo Gerenciador de botões (Button Manager):

1. Clique com o botão direito no ícone do Capture Pro Software na bandeja 
do sistema e selecione Configurar botões (Button Setup):

A caixa de diálogo Gerenciador de botões (Button Manager) será exibida.
2. Atribua os botões de 1 a 9 (Button) como desejar, selecionando a ação 

que o scanner deverá executar na lista suspensa. O padrão é sem ação. 

3. Clique em Configuração do atalho (Shortcut Setup) para exibir a caixa 
de diálogo Configuração do atalho (Shortcut Setup), que permite atribuir 
um nome de Atalho do trabalho, Configuração de página e Configuração 
do trabalho.

4. Clique em OK.

OBSERVAÇÃO: se houver qualquer problema com o uso do Gerenciador de 
botões, consulte as Perguntas mais frequentes no Capítulo 
9, Solução de problemas.

Ícone do Capture 
Pro Software
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Caixa de diálogo 
Configuração do 
atalho (Shortcut 
Setup)

Quando você seleciona Configuração do atalho (Shortcut Setup) na caixa de 
diálogo Gerenciador de botões (Button Manager), a caixa de diálogo 
Configuração do atalho (Shortcut Setup) é exibida. Essa caixa de diálogo 
permite criar um novo atalho do trabalho, e renomear ou excluir o atalho do 
trabalho selecionado. Essa caixa também pode ser usada para selecionar ou 
alterar as configurações de página e trabalho associadas a ela.

OBSERVAÇÃO: A atribuição de atalhos aos botões de scanners não 
é compatível com o Gerenciador de botões.

1. Selecione o nome do Atalho do trabalho (Job Shortcut) desejado na lista 
suspensa. Você também pode usar os ícones para adicionar, renomear ou 
excluir um atalho do trabalho.
• Adicionar (Add): exibe a caixa de diálogo Salvar como (Save As), que 

permite adicionar um novo atalho do trabalho.

• Renomear (Rename): exibe a caixa de diálogo Renomear (Rename), 
que permite renomear o atalho do trabalho selecionado.

• Excluir (Delete): exibe uma caixa de confirmação que permite excluir 
o atalho do trabalho selecionado.

2. Se desejar, selecione uma configuração de página na lista suspensa 
Configuração de página (Page Setup) ou clique em Configuração (Setup) 
para exibir a caixa de diálogo Configuração de página (Page Setup) e criar 
uma nova configuração.

3. Se desejar, selecione uma configuração de trabalho na lista suspensa 
Configuração do trabalho (Job Setup) ou clique em Configuração (Setup) 
para exibir a caixa de diálogo Configuração do trabalho (Job Setup) e criar 
uma nova configuração do trabalho.

4. Clique em OK.
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7 Configuração do usuário e do grupo

Caixa de diálogo 
Configuração do 
usuário (User Setup)

A caixa de diálogo Configuração do usuário (User Setup) permite que você 
configure e gerencie usuários do Capture Pro Software. As funções de 
configuração do usuário só podem ser definidas por indivíduos com acesso de 
administrador ao Capture Pro Software.

Para acessar a Configuração do usuário, selecione Arquivo > Configuração 
do usuário (File > User Setup). A caixa de diálogo Configuração do usuário 
(User Setup) será exibida.

A caixa de diálogo Configuração do usuário (User Setup) possui três guias: 
Geral (General), Usuário (User) e Grupo (Group).

Guia Geral (General) A guia Geral (General) permite ignorar a função de login para um usuário, 
marcando a caixa de seleção ID de login de usuário do Windows (Windows 
user ID login). 

Se você quiser autenticar usuários com seu Active Directory Server, marque 
a caixa de seleção Active Directory.

Configuração de 
usuários e grupos 
com o Active 
Directory

Quando o Active Directory está marcado e um novo usuários faz login, 
o Capture Pro Software verifica cada grupo do Active Directory do qual 
o usuário é membro para encontrar uma correspondência com um grupo do 
Capture Pro Software. O novo usuário será adicionado ao primeiro grupo do 
Capture Pro Software que corresponder ao grupo do Active Directory de um 
usuário.
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Se nenhum grupo correspondente for encontrado, o novo usuário ainda será 
adicionado ao Capture Pro Software e um grupo será criado no Capture Pro 
Software com base nos grupos do Active Directory do usuário. Por padrão, 
o novo grupo não terá permissão nem trabalhos no Capture Pro Software. 
Um usuário do Capture Pro Software com permissão para modificar 
a configuração de usuário precisará acessar a configuração de usuário 
e atribuir uma nova permissão de grupo e trabalhos ou atribuir o novo usuário 
a um grupo existente do Capture Pro Software.

Se um usuário novo não for membro de nenhum grupo do Active Directory, ele 
receberá uma mensagem de aviso no primeiro login, informando que ele deve 
ser membro de, pelo menos, um grupo.

É recomendável que o administrador do sistema do Capture Pro Software 
(sysadmin) adicione os grupos apropriados ao Capture Pro Software antes 
que os usuários façam login pela primeira vez. O nome do grupo informado no 
Capture Pro Software deve corresponder ao nome do grupo definido no Active 
Directory.

Quando os usuários fazem login no Capture Pro Software, o nome de usuário 
deve incluir o domínio. Por exemplo, domain\UserID.

Guia Usuário (User) Usuários e grupos de usuários podem ser configurados no Capture Pro 
Software para limitar o acesso a trabalhos e funções do Capture Pro Software 
específicos.

Adição de um novo usuário 1. Selecione Arquivo > Configuração do usuário (File > User Setup).



A-61993_pt-br  Março de 2022 183

2. Abra a guia Usuário (User).

3. Clique em Novo (New). A caixa de diálogo Novo usuário (New User) será 
exibida.

4. Digite o nome do usuário no campo Nome do usuário (User name).

5. Digite uma senha para esse usuário no campo Senha (Password).

6. Digite a senha novamente no campo Confirmar senha (Confirm password) 
e clique em Criar (Create). Esse usuário será adicionado 
automaticamente à lista.

OBSERVAÇÃO: a senha poderá ser alterada pelo usuário selecionando 
Arquivo > Alterar senha (File > Change Password).

Adição de um usuário a um 
grupo

1. Selecione Arquivo > Configuração do usuário (File > User Setup) 
e abra a guia Usuário (User). A caixa de diálogo Configuração do usuário 
(User Setup) será exibida.

2. Selecione um nome de usuário na lista suspensa Nome do usuário 
(User name).

3. Selecione um nome de grupo na lista suspensa Adicionar a grupo (Add to 
Group).

4. Marque a opção Permitir login automático (Allow automatic login) se 
desejar ignorar a função de login do Capture Pro Software e efetuar login 
automaticamente desse usuário quando o Capture Pro Software for 
iniciado.
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OBSERVAÇÃO: para efetuar login como outro usuário, selecione Arquivo > 
Logout (File > Logout) e então efetue o login como 
o novo usuário.

5. Clique em OK. 

Exclusão de um usuário 1. Selecione Arquivo > Configuração do usuário (File > User Setup) 
e abra a guia Usuário (User). A caixa de diálogo Configuração do usuário 
(User Setup) será exibida.

2. Selecione o usuário que você deseja excluir na lista suspensa Nome do 
usuário (User name).

3. Clique em Delete (Excluir). Uma caixa de confirmação será exibida.

4. Clique em Sim (Yes) para concluir a exclusão. 

5. Clique em OK.

Redefinição de uma senha 1. Selecione Arquivo > Configuração do usuário (File > User Setup) 
e abra a guia Usuário (User). A caixa de diálogo Configuração do usuário 
(User Setup) será exibida.

2. Selecione o usuário cuja senha você deseja redefinir na lista suspensa.

3. Clique em Redefinir senha (Reset Password). A caixa de diálogo Alterar 
senha - sysadmin (Change Password - sysadmin) será exibida.

4. Digite uma nova senha no campo Nova senha (New password).

5. Digite a senha novamente no campo Confirmar senha (Confirm 
password).

6. Clique em OK. 

OBSERVAÇÃO: a senha poderá ser alterada pelo usuário selecionando 
Arquivo > Alterar senha (File > Change Password).

Guia Grupo (Group) Use a guia Grupo (Group) para adicionar e excluir grupos de usuários, bem 
como adicionar e remover privilégios de trabalho.
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Configuração de um grupo 
de usuários

1. Selecione Arquivo > Configuração do usuário (File > User Setup) 
e abra a guia Grupo (Group). A guia Grupo (Group) da caixa de diálogo 
Configuração do usuário (User Setup) será exibida.

2. Clique no ícone Adicionar (Add). A caixa de diálogo Salvar como 
(Save as) será exibida.

3. Digite o nome do novo grupo e clique em OK. O nome do novo grupo será 
exibido na lista suspensa Nome do grupo (Group name). Você também 
pode adicionar observações no campo Descrição (Description).

OBSERVAÇÃO: ao criar um novo grupo, primeiro crie o grupo e, em 
seguida, acesse a guia Usuário (User) para adicionar 
membros a ele. 

4. Use os botões Adicionar (Add), Remover (Remove), Adicionar tudo 
(Add All) e Remover tudo (Remove All) nas caixas Membros (Members) 
para colocar ou tirar usuários no grupo selecionado. As caixas Membros 
(Members) contêm todos os usuários qualificados para serem adicionados 
ao grupo. Ao criar um novo grupo, os campos Fora do grupo (Not in group) 
e No grupo (In group) ficarão em branco.
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5. Em Privilégios: Recursos (Privileges: Features), selecione as funções, 
barras de ferramentas e menus do Capture Pro Software a disponibilizar 
para os membros desse grupo. Você pode usar Selecionar tudo (Select 
All) ou Desmarcar tudo (Deselect All) para efetuar alterações globais. 
As configurações padrão oferecem ao grupo acesso total a todos os 
recursos de software e configurações de trabalho.

6. Em Privilégios: Trabalhos (Privileges: Jobs), selecione as configurações 
de trabalho a disponibilizar para os membros desse grupo. Você pode usar 
Selecionar tudo (Select All) ou Desmarcar tudo (Deselect All) para 
efetuar alterações globais.

7. Clique em OK.

Exclusão de um grupo 1. Selecione Arquivo > Configuração do usuário (File > User Setup) 
e abra a guia Grupo (Group). A guia Grupo (Group) da caixa de diálogo 
Configuração do usuário (User Setup) será exibida.

2. Selecione o usuário que você deseja excluir na lista suspensa Nome do 
grupo (Group name). 

3. Clique no ícone Excluir (Delete). Uma caixa de confirmação será exibida. 
Clique em Sim (Yes) para excluir o grupo. 

OBSERVAÇÃO: quando você exclui um grupo, os usuários desse grupo 
são removidos e retornam à lista Membros: Fora do 
grupo (Members: Not in Group).

Renomeação de um grupo 1. Selecione Arquivo > Configuração do usuário (File > User Setup) 
e abra a guia Grupo (Group). A guia Grupo (Group) da caixa de diálogo 
Configuração do usuário (User Setup) será exibida.

2. Selecione o grupo que você deseja renomear na lista suspensa Nome do 
grupo (Group name). 

3. Clique no ícone Renomear. A caixa de diálogo Renomear (Rename) será 
exibida.

4. Digite o novo nome do grupo e clique em OK.
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8 Importação automática

Visão geral A importação automática permite importar imagens para o Capture Pro 
Software sem precisar de um scanner local ou de intervenção manual. 
Isso é feito observando-se os diretórios especiais denominados “pastas 
monitoradas”. Os arquivos a serem importados serão copiados em subpastas 
dentro de uma pasta monitorada, chamadas de pastas de importação 
automática ou lote IA. A importação automática extrai imagens desses 
arquivos e as transfere para a estação de trabalho do Capture Pro Software, 
como se tivessem sido geradas por um scanner local.

Para importar arquivos automaticamente, crie uma pasta de lote IA dentro de 
uma pasta monitorada. As instruções de processamento dessa pasta de lote 
IA foram definidas no processo de configuração da importação automática 
e associadas à pasta monitorada que contém a pasta de lote IA. 
Um temporizador de contagem regressiva será iniciado para o novo lote IA. 
O usuário copiará os arquivos (que podem estar dentro de subpastas 
aninhadas) para a pasta de lote IA. Toda vez que aparecer um novo arquivo 
em qualquer parte da pasta de lote IA ou em suas subpastas, o temporizador 
de contagem regressiva será redefinido para seu valor inicial e a contagem 
regressiva será reiniciada. Se o temporizador expirar, a pasta de lote IA será 
bloqueada e adicionada ao fim de uma fila de captura de importação 
automática para processamento. Consulte “Operação de importação 
automática” para obter mais informações.

Para dispositivos do tipo MFP (Multiple Function Printers) que não conseguem 
criar pastas em lote AI, os arquivos de imagem podem ser copiados 
diretamente para a pasta de visualização.

Regras especiais de separação de lotes podem ser especificadas para 
a importação automática, de modo a permitir a criação opcional de novos 
lotes para cada lote IA novo. Fora isso, o processamento ocorrerá como em 
qualquer outro trabalho de digitalização, de acordo com as regras de 
configuração de trabalho e página. Todos os lotes IA serão inteiramente 
processados antes que o próximo seja iniciado.

Os formatos de arquivo de imagem compatíveis são: tiff, jpg, pdf, bmp, ioca, 
modca, gif, cmp e png.
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Configuração da 
importação 
automática

1. Selecione Configuração da importação automática (Auto Import Setup) 
no menu Capturar (Capture). A caixa de diálogo Configuração da 
importação automática (Auto Import Setup) será exibida.

OBSERVAÇÃO: As configurações feitas nessa caixa de diálogo se 
aplicam a qualquer lote IA criado no local de importação 
automática especificado (pasta monitorada).

2. Selecione Iniciar a importação automática quando o aplicativo 
é inicializado (Start Auto Import when application is launched) para 
observar automaticamente as pasta monitorada da importação automática 
quando o Capture Pro for inicializado.

3. Digite um nome para essa configuração de importação automática. 
O nome é uma referência intuitiva, não se refere a um nome de pasta nem 
se trata de qualquer outra referência específica.

4. Selecione um local para a pasta monitorada de importação automática 
associada a essa configuração de importação automática. A importação 
automática monitorará essa pasta em busca de novas pastas de lote IA 
criadas e processará o lote IA após a expiração do intervalo de tempo-
limite (consulte “Operação de importação automática” para mais 
informações).
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Várias condições se aplicam à pasta monitorada. 
• A pasta monitorada deve ter acesso de leitura/gravação para qualquer 

usuário que execute o Capture Pro Software. 

• A pasta monitorada deve ser gravável a partir de qualquer fonte de 
imagens pretendido. Se ela for acessada de uma rede, é preciso que 
você confirme que o compartilhamento de rede está configurado para 
permitir acesso de gravação a qualquer usuário, scanner de rede ou 
outros dispositivos que copiam arquivos para a pasta monitorada. 

• O Capture Pro Software não tentará configurar nenhum 
compartilhamento de arquivo nem definir privilégios de acesso de 
usuário na pasta monitorada. A configuração e o compartilhamento de 
arquivos são de sua responsabilidade. 

• A pasta monitorada deve ser uma unidade local ou mapeada.

5. Selecione um intervalo de tempo-limite para a importação automática. 
Esse intervalo deve ser baseado no atraso máximo esperado de qualquer 
fonte que envie arquivos para a pasta monitorada. Isso pode variar 
bastante, dependendo da operação. Por exemplo:

• Scanner de rede — um usuário configurou um Scan Station 500 para 
enviar imagens diretamente para uma pasta monitorada pela rede. 
A operação consiste em digitalizar uma pilha de papel, removê-la do 
scanner, selecionar a próxima pilha e continuar a operação de 
digitalização. Ocorre um atraso de 60 segundos, necessário para essa 
transição. A pasta monitorada foi configurada com um atraso de 120 
segundos, para permitir que o usuário selecione a próxima pilha sem 
que o tempo-limite se esgote e feche o lote IA.

• Copiar imagens de pasta da rede — um usuário tem um conjunto de 
arquivos que foram capturados por outro scanner (ou outra fonte de 
entrada). A transferência deles para a estação de trabalho do Capture 
Pro Software para importação automática requer uma operação de 
“cópia”. A rede local transfere as imagens em intervalos de um 
segundo. O intervalo de tempo-limite é definido em 10 segundos.

Consulte a seção “Operação de importação automática” para obter mais 
informações.

6. Selecione ou crie uma nova configuração de trabalho a ser associada 
a essa pasta monitorada.
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7. Selecione ou crie uma configuração de página a ser associada a essa 
pasta monitorada. As opções de configuração de página estão restritas às 
mostradas abaixo.
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8. Selecione Opções de separação (Separation Options) para selecionar as 
opções de separação de documentos e lotes para a pasta e subpastas de 
importação automática. Um novo documento também poderá ser criado 
para cada arquivo. Essa opção é útil se cada arquivo contém um 
documento de várias páginas.
As opções de separação são limitadas quando os arquivos são copiados 
diretamente para a pasta de visualização, porque uma pasta e uma 
subpasta não existirão. A única opção que pode ser usada é Para cada 
arquivo crie um novo documento (For each file create new document). 
Quando esta opção não está selecionada, todos os arquivos copiados 
para a pasta de visualização serão colocados em um documento simples. 
Quando esta opção estiver marcada, um documento novo será criado para 
cada arquivo.

9. Selecione Fazer backup dos arquivos para (Backup the files to) 
e especifique um local de backup, se quiser arquivar o conteúdo do lote IA 
quando a importação automática for concluída. 
O arquivamento copiará todo o conteúdo de um lote IA para o local de 
arquivamento especificado, incluindo qualquer arquivo não processado 
(como planilhas ou documentos de processador de texto) na forma original 
e os arquivos de imagem originais. 

• Um único local de arquivamento pode ser usado para várias pastas 
monitoradas. 

• Você não precisa criar uma pasta de arquivamento exclusiva para cada 
configuração de importação automática.

• O local do arquivamento deve ser uma unidade local ou mapeada.

10. Especifique o número de erros permitidos antes que o processamento da 
importação automática seja interrompido. Ocorrem erros quando não 
é possível ler corretamente um arquivo de imagem. Esses erros não se 
aplicam a erros de indexação ou a qualquer outra coisa diferente da 
capacidade de abrir e ler o conteúdo de um arquivo de imagemsuportado. 
Se o valor na caixa suspensa Máximo de erros de importação 
(Maximum import errors) for excedido, o processamento será interrompido 
e será exibida uma caixa de diálogo, permitindo que o usuário repita 
a imagem inválida, ignore-a ou anule a importação automática. Consulte 
“Tratamento de erros” para obter mais informações sobre tratamento de 
erros e recuperação. 
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11. Especifique um local para arquivos ilegíveis serem copiados no campo 
Salvar os arquivos e dados de erro em cache em (Cache the error files 
and data to). Durante o processamento da importação automática, se um 
arquivo suportado não puder ser aberto, será substituído por uma imagem 
de “espaço reservado”, e a imagem com erro será copiada para o cache 
de erros.
OBSERVAÇÃO: o local do cache de erros deve ser uma unidade local ou 

mapeada.

12. Clique em OK quando terminar.

Operação de 
importação 
automática

OBSERVAÇÃO: nos exemplos a seguir, foram incluídos ícones especiais em 
algumas pastas para fins de esclarecimento. Eles não serão 
exibidos de fato nas pastas de uma real configuração de 
importação automática.

A partir da configuração de importação automática AIDemo1 descrita 
anteriormente, os diretórios terão aparência semelhante a esta:

Para ativar a Importação automática, selecione Arquivo > Configuração da 
estação de trabalho (File > Workstation Setup) e, em seguida, selecione 
Importação automática (Auto Import) como origem. Isso desativa todos os 
scanners e configurações específicas de scanner. Se você não selecionou 
Iniciar a importação automática quando o aplicativo é inicializado 
(Start Auto Import when application is launched), você precisará selecionar 
Iniciar (Start), como se estivesse iniciando um scanner. A importação 
automática começará a observar todas as pastas monitoradas predefinidas 
em busca de arquivos recebidos, monitorando ativamente todas as pastas 
monitoradas e processando qualquer novo trabalho do lote IA por ordem de 
chegada até que o comando Parar (Stop) seja selecionado. Para continuar as 
operações normais de digitalização, selecione Arquivo > Configuração da 
estação de trabalho (File > Workstation Setup) e selecione o scanner.

OBSERVAÇÃO: se uma configuração de importação automática ficar 
obsoleta, deverá ser excluída antes que as pastas 
relacionadas sejam manualmente removidas, a fim de evitar 
mensagens de erro.

AIDemo 1 Pasta monitorada
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Para a criação de um novo lote IA, uma nova pasta de lote IA será criada na 
pasta monitorada. 

O temporizador começará a contagem regressiva. Após 5 segundos, 
nenhum arquivo novo foi adicionado à pasta de lote IA (06112009_AIBatch) 
e o temporizador está marcando 5.

Um novo lote IA.
Temporizador = 10 s
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Sempre que aparece um arquivo na pasta de lote IA ou em uma de suas 
subpastas, o temporizador é redefinido. 

As subpastas dentro das pastas de lote IA podem ser aninhadas. 
O temporizador na pasta pai de lote IA será redefinido. As adições feitas às 
subpastas aninhadas em 06112009_AIBatch redefinirão o temporizador. 
As subpastas aninhadas não têm temporizadores próprios. Há apenas um 
temporizador para a pasta 06112009_AIBatch.

OBSERVAÇÃO: os caminhos que ultrapassarem 256 caracteres talvez não 
sejam suportados pelo sistema operacional Windows. 
É recomendável manter as subpastas e os nomes de arquivo 
dentro desse limite.
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Uma nova pasta de lote IA pode aparecer na pasta monitorada a qualquer 
momento. Ela terá seu próprio temporizador e funcionará independentemente 
dos outros lotes IA.

Quando um temporizador expira, a pasta de lote IA é bloqueada e inserida na 
fila de processamento de importação automática.

Fila de processamento da 
importação automática
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Outros trabalhos serão inseridos a fila de processamento quando os 
respectivos temporizadores expirarem.

A fila de processamento de importação automática será processada na ordem 
“primeiro a entrar, primeiro a sair”. Neste exemplo, o conteúdo total de 
06112009_AIBatch será processado após 06112009_AIBatch2. Visto que 
esses dois lotes IA possuem a mesma configuração de trabalho (porque 
provêm da mesma pasta monitorada), um separador de lote será inserido 
entre eles, de acordo com a configuração de trabalho AIDemo1. 

Os arquivos em um lote IA serão processados por iteração recursiva de todos 
os arquivos e subpastas, seguida do processamento dos respectivos 
conteúdos em ordem alfanumérica.

Porém, como TODOS os lotes IA compartilham a mesma fila de 
processamento de importação automática, se um lote IA de outra pasta 
monitorada vier em seguida na fila, um separador de lote será inserido, 
independentemente das opções de configuração de importação automática.

Os lotes IA da fila de processamento de importação automática serão 
processados na ordem “primeiro a entrar, primeiro a sair”. Não há nenhum 
recurso de gerenciamento para essa fila. Todos os lotes IA serão processados 
inteiramente e em sequência, excetuando-se os erros (consulte “Tratamento 
de erros”).

Quando o lote inteiro tiver sido processado, os arquivos originais 
opcionalmente serão copiados no arquivo de armazenamento.

Configuração do 
servidor/serviço

Instalar a importação automática em um sistema operacional Windows Server 
fornece um ambiente mais robusto e minimiza o envolvimento do operador. 
É recomendado que a pasta de visualização também esteja no mesmo servidor. 

1. Instale a opção Importação automática do Capture Pro no servidor usando 
o procedimento encontrado na seção Configuração de importação 
automática.

Fila de processamento da 
importação automática
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2. Inicie o Capture Pro e configure seus trabalhos de Importação automática. 
Certifique-se de marcar a opção: Iniciar Importação automática quando 
o aplicativo é iniciado (Start Auto Import when application is launched).
OBSERVAÇÃO: se a pasta de visualização não estiver no servidor, 

o Serviço de importação automática do Capture Pro 
precisará de ter acesso de leitura e escrita à pasta de 
visualização. Isso é tipicamente difícil porque os 
serviços não têm nenhum usuário definido.

3. Verifique se a opção Importação automática funciona corretamente.
4. Encerre o software Capture Pro.
5. O Serviço de importação automática do Capture Pro está disponível para 

download no site do Capture Pro Software, em: www.kodakalaris.com/go/
CaptureProAIService.

6. Instale o Serviço de importação do Capture Pro no mesmo servidor em 
que a Importação automática do Capture Pro está instalada.

7. Por padrão, o Serviço de importação automática do Capture Pro será 
configurado para inicialização automática e terá um status inicial de 
Parado. Inicie manualmente o serviço ou reinicie o servidor.

A Importação automática do Capture Pro está agora sendo executada no 
servidor. Todas as imagens colocadas na pasta de visualização serão 
importadas e processadas conforme descrito pelo trabalho selecionado na 
configuração de Importação automática.

A Importação automática será lançada automaticamente sempre que 
o servidor é reiniciado.
Para modificar ou adicionar configurações de trabalhos, pare o Serviço de 
importação automática do Capture Pro e inicie manualmente o Capture Pro 
Software. Quando as atualizações estiverem concluídas, encerre o Capture 
Pro Software e inicie manualmente o Serviço de importação automática do 
Capture Pro ou reinicie o servidor.
OBSERVAÇÃO: se uma configuração do trabalho for modificada em um 

ambiente de grupo de trabalho compartilhado, a opção 
Importação automática precisa ser parada e reiniciada para 
as alterações serem efetuadas.

Propriedades do serviço de importação automática
Se for necessário alterar o registro de serviço de auto-importação de uma 
conta do sistema local padrão para uma conta de usuário, certifique-se de 
adicionar o usuário ao grupo de administração local.
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Tratamento de erros Quando um lote está em processamento, se não for possível abrir um arquivo 
de imagem suportado: 

• o arquivo inválido será copiado para o cache de erros, 

• uma imagem de “erro” genérica será adotada e 

• a contagem de erro do lote IA será incrementada.

Se for atingido o limite de erro definido na configuração do lote, 
o processamento do lote será interrompido. Será exibida uma caixa de diálogo 
com as seguintes opções:

- Ignorar (Ignore): segue adiante para a próxima imagem. O lote continuará 
o processamento até que seja encontrada a próxima imagem inválida.

- Anular (Abort): os arquivos remanescentes do lote serão copiados para 
o cache de erros, e a importação automática será interrompida. Após uma 
anulação, a importação automática reiniciada prossegue com o próximo 
lote da fila. Não há nenhum procedimento de recuperação automatizada 
dos lotes que foram copiados para o cache de erros. O usuário terá que 
localizar e corrigir os arquivos inválidos e reinserir manualmente o lote na 
pasta monitorada.
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9 Seleção inteligente de trabalhos

Visão geral O recurso Seleção inteligente de trabalho (Intelligent Job Select) encontrado 
no menu Capture Pro File permite que você configure parâmetros avançados 
para alterar configurações de trabalho ou configurações de página 
automaticamente durante a digitalização. Quando um código de correção com 
condições predefinidas é digitalizado, cada configuração de página ou 
trabalho é alterada sem a necessidade de nenhuma ação do operador. 

O uso eficaz da Seleção inteligente de trabalhos exige a preparação dos 
documentos para adicionar página(s) de correção ao lote. 

Este recurso está disponível apenas para os scanners Kodak e Alaris. 
Se você não tiver um scanner Kodak ou Alaris, esta opção estará desativada. 
Este capítulo fornece informações e procedimentos sobre como selecionar 
opções nas guias Seleção geral de trabalho inteligente (Intelligent Job Select 
General) e Configuração (Setup). 

Você precisará: 

1. Configurar uma ou mais páginas de correção para sinalizar as alterações 
de configuração.

2. Configurar o Capture Pro para a alteração a ser feita por cada página de 
correção. 

 Para acessar a Seleção inteligente de trabalho, selecione Seleção 
inteligente de trabalho... (Intelligent Job Select...) no menu Capture Pro File. 
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Configuração da 
Seleção inteligente 
de trabalho - Guia 
Geral (General)

A janela de Configuração da Seleção inteligente de trabalho (Intelligent Job 
Select Setup) permite que você defina quando e como as mudanças de 
configuração acontecerão, com base em códigos de correção lidos pelo 
scanner. A guia Geral (General) da janela tem as seguintes opções:

Ativar a Seleção inteligente de trabalho em (Enable Intelligent Job Select 
on) — escolha o tipo de correção para sua página de correção de recursos. 
As correções de recurso válidas são Correção 10 (Patch 10), Correção 11 
(Patch 11), Correção 12 (Patch 12), Correção 13 (Patch 13), Correção 14 
(Patch 14) e Correção 15 (Patch 15). 

Imagem de amostra (Sample Image) — escolha uma imagem já armazenada 
como uma imagem de amostra, para definir a regra para essa correção. A lista 
suspensa contém todas as imagens que foram digitalizadas para a 
configuração da Seleção inteligente de trabalhos. É necessário que você 
tenha, no mínimo, uma imagem nessa lista antes de definir uma zona de 
código de barras ou de OCR. 

Ícones

Iniciar/Digitalizar (Start/Scan) — abre a caixa de diálogo 
Digitalizar imagem (Scan Image), que permite inserir o nome de 
uma imagem e digitalizar uma imagem que contenha códigos de 
barras ou segmentos de texto de OCR ou áreas de marcas.
OBSERVAÇÃO: o Capture Pro Software usará qualquer 

configuração de página selecionada 
atualmente para digitalizar a imagem de 
amostra.
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OK — salva suas configurações e fecha a caixa de diálogo

Demarcar região (Draw region) — permite que você trace um 
retângulo em torno de um código de barras ou segmento de 
texto de OCR na imagem digitalizada e, em seguida, exibe 
a caixa de diálogo Configuração de zona de código de barras 
(Bar Code Zone Setup) ou a caixa de diálogo Configuração de 
zona de OCR (OCR Zone Setup).
Ampliar (Magnify) — amplia uma parte da imagem. Para 
ampliar qualquer área da imagem, posicione a ferramenta 
Ampliar (Magnify) sobre a área e mantenha o botão do mouse 
pressionado.
Panorama (Pan) — permite que você mova a imagem em torno 
do visualizador quando ela for maior do que a janela 
Configuração da Correção de recursos.
Mais zoom (Zoom in) — amplia a imagem.

Menos zoom (Zoom out) — reduz a imagem.

Ajustar à janela (Fit window) — altera a exibição da imagem 
para que ela caiba na janela da imagem da Configuração da 
Seleção inteligente de trabalho (Intelligent Job Select Setup).
Tamanho real (Actual size) — exibe a imagem em seu tamanho 
real. Um pixel digitalizado é igual a um pixel na janela 
Configuração da Seleção inteligente de trabalhos (Intelligent 
Job Select Setup) da imagem.
Testar zona selecionada do código de barras, OCR ou 
detecção de marcas (Test selected bar code, OCR or Mark 
Detection zone) — abre a caixa de diálogo Valores do código de 
barras, de OCR e de detecção de marcas (Bar Code, OCR and 
Mark Detection Values), que permite visualizar os resultados 
dos testes em uma zona selecionada.
Criar zona de OCR (Create OCR zone) — permite que você 
crie uma zona de OCR a partir da imagem exibida na janela 
Configuração da Seleção inteligente de trabalho (Intelligent Job 
Select Setup).
Criar código de barras (Create barcode) — permite que você 
crie uma zona de código de barras a partir da imagem exibida 
na janela Código de barras, OCR e detecção de marcas (Bar 
Code, OCR & Mark Detection).
Propriedades da zona (Zone properties) — abre a caixa de 
diálogo Configuração de zona de código de barras (Bar Code 
Zone Setup), Configuração de zona de OCR (OCR Zone Setup) 
ou Configuração da zona de detecção de marcas (Mark 
Detection Zone Setup), que permite visualizar as propriedades 
das zonas selecionadas de código de barras, de OCR ou de 
detecção de marcas.
Excluir zona selecionada (Delete selected zone) — permite 
que você exclua uma zona do código de barras, OCR ou de 
detecção de marcas. Uma caixa de confirmação será exibida 
para verificar sua opção.
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CANCELAR (CANCEL) — descarta as alterações que não foram aplicadas e 
fecha a caixa de diálogo

APLICAR (APPLY) — salva suas configurações e deixa a caixa de diálogo 
aberta

Criação de uma 
página de correção 
de recursos

Crie uma página de correção que será usada para iniciar uma alteração de 
configuração. Use a Correção 10 (Patch 10), Correção 11 (Patch 11), 
Correção 12 (Patch 12), Correção 13 (Patch 13), Correção 14 (Patch 14) ou 
Correção 15 (Patch 15). A página de correção deve ser personalizada com um 
código de barras ou texto. 

OBSERVAÇÃO: apenas uma zona é permitida na configuração da Seleção 
inteligente de trabalhos. Para ter várias opções de alteração 
das configurações, crie uma página de correção para cada 
opção. 

Por exemplo, a página Correção 10 abaixo, à esquerda, pode ser utilizada 
para implementar uma alteração de configuração, como “Se o valor do código 
de barras for 12345678 e, em seguida, alterar a configuração de página para 
Cores 150 DPI”.

A página Correção 10 abaixo à direita poderia ser usada para implementar 
uma alteração de configuração, como “Se zona de OCR = ‘Digitalizar para 
PDF’, em seguida, altere o trabalho para Digitalizar para PDF.” 

Criação de uma 
configuração de 
correção de recurso

1. Depois de preparar sua(s) folha(s) de correção, você deverá definir 
a Configuração da Seleção inteligente de trabalhos. Na guia Geral 
(General), marque Ativar seleção inteligente de trabalhos em 
(Enable Intelligent Job Select on). Na lista suspensa, selecione o tipo de 
correção de recurso que você deseja personalizar para essa função. 

2. Escolha uma imagem da sua página de correção na lista suspensa 
Imagem de amostra (Sample Image) ou digitalize a página de correção 
que você criou em “Criação de uma página de correção de recursos”. 

3. Crie um zona de código de barras para a zona de OCR ou código de 
barras do texto que você adicionou à página de correção. 
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4. Teste a zona para assegurar que o código de barras ou texto será 
reconhecido. 

5. Use conforme necessário o menu exibido ao clicar com o botão direito do 
mouse sobre a imagem para ajustar a imagem ou zona. 

6. Em seguida, configure uma ou mais regras para definir a alteração de 
configuração que ocorrerá quando o scanner reconhecer essa página de 
correção. 

Seleção inteligente 
de trabalhos – guia 
Configuração (Setup)

Depois de ativar a Seleção inteligente de trabalhos e configurar uma página 
de imagem de amostra com uma zona de OCR ou código de barras, você 
precisará criar uma regra a ser seguida quando a correção de recurso for 
detectada. As regras são definidas na guia Configuração (Setup) da janela 
Seleção inteligente de trabalho (Intelligent Job Select). A guia Configuração 
(Setup) oferece as seguintes opções:

Se detectar (If detect) — digite o valor do código de barras ou o valor de texto 
OCR a partir da página de correção que você configurou na guia Geral 
(General).

Alterar (Change) — escolha uma Configuração de trabalho ou de Página na 
lista suspensa.

Para (To) — escolha um nome de Configuração de trabalho ou de Página na 
lista suspensa. Quando a página de correção é detectada, a configuração 
será alterada para a configuração inserida neste campo.
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Adicionar (Add) — depois de ter definido uma regra, o botão Adicionar (Add) 
vai adicioná-la à lista exibida.

Excluir (Delete) — Escolha uma regra na lista exibida e escolha Excluir para 
remover a regra selecionada. 

Ao alterar os trabalhos (When changing jobs) — esta opção não está 
disponível para os scanners que executam a leitura do código de correção do 
recurso nos scanners (por exemplo, Kodak i5x50). Nesses scanners, 
a digitalização será feita na velocidade do scanner.

• Sempre alterar para a configuração da página no trabalho (mais lento) 
(Always change to page setup in job (slower)): escolha se você deseja usar 
a Configuração da página que foi definida no trabalho ou a última 
configuração de página usada se não estiver definida.

• Usar uma configuração de página para todos os trabalhos (mais 
rápido) (Use one page setup for all jobs (faster)): escolha se deseja 
digitalizar na taxa de velocidade do scanner. Você deve definir uma 
Configuração de página na lista suspensa que será usada para todos os 
trabalhos.

OK — salva suas configurações e fecha a caixa de diálogo.

CANCELAR (CANCEL) — descarta as alterações que não foram aplicadas na 
lista e fecha a caixa de diálogo.

APLICAR (APPLY) — salva suas configurações e deixa a caixa de diálogo 
aberta.

Definição de uma regra Sua regra terá um formato como: Se detectar <valor> alterar <configuração 
do trabalho ou da página> para <nome de configuração desejado>. 

1. Configure uma regra para uma página de correção usando os campos 
Se detectar (If detect), alterar (change) e para (to). 

2. Depois que a regra for definida, selecione o botão Adicionar (Add) para 
adicionar a regra à lista. 

3. Use Aplicar (Apply) ou OK para salvar suas alterações. 

4. Crie regras adicionais conforme necessário. Se tiver vários tipos de folhas 
de correção personalizadas, você precisará de uma regra para cada folha.

OBSERVAÇÃO: para alterar uma regra, exclua-a e adicione uma nova regra. 
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10 Solução de problemas

Eliminação de erros A janela Status do processo em lote (Batch Process Status) do Capture Pro 
apresenta informações sobre lotes que você está preparando para envio no 
Capture Pro Software.

Para exibir a janela Status de lotes (Batch Status):

• Selecione Lote > Exibir status de saída do lote (Batch > View Batch 
Output Status).

Para limpar os erros:

• Clique em Nome do trabalho (Job Name) para Limpar todos os erros 
(Clear All Errors) ou Limpar os erros selecionados (Clear Selected 
Errors).

Login de linha de 
comando

O Capture Pro Software fornece suporte para um login no comando nesta 
forma:

Capture.exe/username<nome de usuário>/password<senha>
Por exemplo, uma pessoa com nome de usuário “testador” e senha “123465” 
poderia iniciar o Capture Pro Software com o comando:

Capture.exe/username testador/password 123465
Se a pessoa estiver usando o nome de usuário atual do Windows para efetuar 
login no Capture Pro Software, ela poderá iniciar o Capture Pro Software com 
o comando:

Capture.exe/username

Suporte técnico O suporte para o Capture Pro Software está disponível no site da Kodak 
Alaris: www.kodakalaris.com/go/CaptureProSupport. As páginas de suporte 
fornecem informações específicas sobre o produto, como acesso a download 
de atualizações, drivers, acessórios e perguntas mais frequentes (FAQ), além 
de detalhes sobre as opções de suporte disponíveis para o Capture Pro 
Software no seu país/região.
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Apêndice A   Gerenciador de licenças

O Gerenciador de licenças (License Manager) é um utilitário que pode ser 
instalado e executado de modo independente do Capture Pro Software. 
O Gerenciador de licenças é instalado com o Capture Pro Software. Para 
acessar e inicializar o gerenciador, selecione Gerenciador de licenças 
(License Manager) no menu Ajuda (Help) ou selecione o atalho encontrado 
em Kodak > Kodak Capture Pro Software. Caso o Capture Pro Software 
não esteja instalado no computador, é possível fazer o download do 
Gerenciador de licenças no site www.alarisworld.com/go/
CaptureProDownload. O utilitário fornece um conjunto de funções que podem 
ser usadas para adquirir e gerenciar uma licença para seu Capture Pro 
Software.

O Gerenciador de licenças é a forma mais fácil de obter uma licença para uma 
estação de trabalho com o Capture Pro Software que não tenha acesso 
à Internet.

Número de série do software (Software Serial Number) — exibe o número 
de série do software usado para identificar sua licença.

Número da versão (Version Number) — especifica a versão do Capture Pro 
Software que você deseja usar. Versões anteriores à versão 4.0.0 não podem 
ser selecionadas.
Local da licença (License Location) — especifica o local no qual sua licença 
está instalada. Para uma instalação típica, o local será C:\Arquivos de 
Programas\Kodak\Capture Pro\System.
Status de licença (License Status) — status são: Licenciado (Licensed), 
Licença temporária (Temporary License) e Não licenciado (Not Licensed). 
Licenças temporárias expiram em uma data predeterminada.

http://www.alarisworld.com/go/CaptureProDownload
http://www.alarisworld.com/go/CaptureProDownload
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Guias Solicitação de licença (License Request), Liberar licença (Release 
License) e Substituir licença (Replace License) — consulte as seções 
a seguir para informações e procedimentos detalhados.
Registrar (Register) — permite registrar o Capture Pro Software e obter um 
ID de registro (Registration ID). O ID de registro (Registration ID) pode ser 
usado para futuras instalações desta licença ou outras licenças do Capture 
Pro Software que você possa possuir.

Mostrar ID do hardware (Show Hardware ID) — exibe o ID do hardware 
usado para identificar a estação de trabalho licenciada.
Fechar (Close) — fecha a janela Gerenciador de licenças (License Manager).

Solicitação de uma 
licença

As funções de Solicitação de licença (Request License) são usadas para 
solicitar uma licença no servidor de licenças Kodak Alaris.  

Obter licença (Get License) — use esta opção se a estação de trabalho a ser 
licenciada tiver acesso à Internet. 

Obter licença de avaliação (Get Trial License) — permite-lhe solicitar uma 
licença de avaliação se não tiver um número serial do software.

Solicitar licença (Request License) — se a estação de trabalho a ser 
licenciada não tiver acesso à Internet, selecione Solicitar Licença (Request 
License) para criar um arquivo de solicitação de licença que possa ser usado 
para solicitar uma licença com o uso de um computador com acesso 
à Internet. Você será solicitado a inserir um local para o arquivo de solicitação 
de licença.

Fazer upload da solicitação (Upload Request) — esta função é usada em 
um computador com acesso à Internet para enviar o arquivo de solicitação de 
licença para o servidor de licença Kodak Alaris. Você será solicitado a inserir 
o local do arquivo de solicitação de licença. Se a solicitação de licença for 
bem-sucedida, o arquivo de licença será retornado para esse local.
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Instalar licença (Install License) — esta função é usada na estação de 
trabalho sem acesso à Internet para instalar a licença recuperada de um 
computador com acesso à Internet. Será solicitado o local do arquivo de licença.

Abaixo estão alguns exemplos de quando você poderá usar a função Solicitar 
licença:

Exemplo 1

Cenário: O Capture Pro Software está instalado na minha estação de trabalho. 
Comprei um recurso opcional e preciso atualizar minha licença para habilitá-
lo. Minha estação de trabalho tem acesso à Internet.

Solução: 

1. Selecione Ajuda > Gerenciador de licenças (Help > License Manager) 
na barra de menus. 

2. Na janela Gerenciador de licenças (License Manager), selecione a guia 
Solicitar licença (Request License) e, em seguida, selecione Obter 
licença (Get License).

Sua nova licença será recuperada e instalada.

Exemplo 2

Cenário: Estou instalando o Capture Pro Software em uma estação de 
trabalho sem acesso à Internet. Durante a instalação, o instalador criou um 
arquivo de solicitação de licença. O que devo fazer agora?

Solução: 

1. Em outro computador com acesso à Internet, faça o download da 
ferramenta Gerenciador de licenças disponível no site de downloads do 
Capture Pro Software. (www.alarisworld.com/go/CaptureProDownload). 

2. Instale e inicie o Gerenciador de licenças. 

3. Na guia Solicitar licença (Request License), selecione Fazer upload da 
solicitação (Upload Request). 

4. Procure o arquivo de solicitação de licença que foi criado na estação de 
trabalho sem acesso à Internet e faça o upload. 

Sua licença será retornada e armazenada no mesmo local para o qual 
você navegou para selecionar o arquivo de solicitação de licença.

5. Mova o arquivo de licença retornado para a estação de trabalho na qual 
você estiver instalando o Capture Pro Software e continue a instalação.

Exemplo 3

Cenário: O Capture Pro Software está instalado na minha estação de trabalho. 
Comprei um recurso opcional e preciso atualizar minha licença para habilitá-
lo. Minha estação de trabalho não tem acesso à Internet.

Solução: 

1. Selecione Ajuda > Gerenciador de licenças (Help > License Manager) 
na barra de menus. 

2. Na janela Gerenciador de licenças (License Manager), selecione a guia 
Solicitação de licença (License Request) e, em seguida, selecione 
Solicitar licença (Request License). 

http://www.alarisworld.com/go/CaptureProDownload
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3. Insira o caminho no qual você deseja salvar o arquivo de solicitação de 
licença. Selecione Solicitar (Request). Um arquivo de solicitação de 
licença será criado. 

4. Mova o arquivo de solicitação de licença para um computador com acesso 
à Internet. 

5. No computador com acesso à Internet, faça o download da ferramenta 
Gerenciador de licenças disponível no site de downloads do Capture Pro 
Software (www.alarisworld.com/go/CaptureProDownload). 

6. Instale e inicie o Gerenciador de licenças. 

7. Na guia Solicitação de licença (License Request), selecione Fazer upload 
da solicitação (Upload Request). 

8. Procure o arquivo de solicitação de licença que você moveu para esse 
computador e selecione Fazer upload (Upload).

Sua licença será retornada e armazenada no mesmo local para o qual 
você navegou para selecionar o arquivo de solicitação de licença. 

9. Mova o arquivo de licença retornado para a estação de trabalho na qual 
o Capture Pro Software está em execução e selecione Instalar licença 
(Install License) na guia Solicitação de licença (License Request). Você 
será solicitado a inserir o caminho para o arquivo de licença que moveu 
para a estação de trabalho.

Liberar licença 
(Release license)

As funções de Liberar licença (Release License) são usadas para liberar 
a licença da estação de trabalho atribuída atualmente. Libere uma licença 
antes de desinstalar o Capture Pro Software ou de mover a licença para uma 
estação de trabalho diferente.  

http://www.alarisworld.com/go/CaptureProDownload
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Liberar licença (Release License) — se a estação de trabalho licenciada tiver 
acesso à Internet, esta opção removerá a licença da estação de trabalho 
e disponibilizará a licença para uma nova estação de trabalho.

Solicitar liberação (Request Release) — se a estação de trabalho licenciada 
não tiver acesso à Internet, use esta opção para criar um arquivo de 
solicitação de liberação. Esse arquivo poderá ser movido para um computador 
com acesso à Internet e enviado para o servidor de licença Kodak Alaris com 
a função Fazer upload da solicitação (Upload Request). Você será solicitado 
a inserir um local para o arquivo de solicitação de liberação.
Fazer upload da solicitação (Upload Request) — esta opção é usada para 
liberar sua licença, enviando o arquivo de solicitação de liberação para 
o servidor de licenças Kodak Alaris a partir de um computador com acesso 
à Internet. Você será solicitado a inserir o local do arquivo de solicitação de 
liberação.

Abaixo estão alguns exemplos de quando você poderá usar a função Liberar 
licença:
Exemplo 1

Cenário: O Capture Pro Software está instalado na minha estação de trabalho. 
Eu gostaria de mover o Capture Pro Software para uma estação de trabalho 
nova e mais rápida. Minha estação de trabalho tem acesso à Internet.

Solução: 

1. Selecione Ajuda > Gerenciador de licenças (Help > License Manager) 
na barra de menus. 

2. Na janela Gerenciador de licenças (License Manager), selecione a guia 
Liberar licença (Release License) e, em seguida, selecione Liberar 
licença (Release License). 

3. Saia do Capture Pro Software. Sua licença será removida desta estação 
de trabalho e estará disponível para instalação na nova estação de 
trabalho.

Exemplo 2

Cenário: O Capture Pro Software está instalado na minha estação de trabalho, 
e preciso reconfigurar a estação de trabalho (adicionar/remover memória, 
atualizar o BIOS, alterar o nome da máquina, substituir a placa-mãe etc.). 
Minha estação de trabalho tem acesso à Internet.

Solução: 

1. Selecione Ajuda > Gerenciador de licenças (Help > License Manager) 
na barra de menus. 

2. Na janela Gerenciador de licenças (License Manager), selecione a guia 
Liberar licença (Release License) e, em seguida, selecione Liberar 
licença (Release License). 

3. Saia do Capture Pro Software.
4. Reconfigure a estação de trabalho conforme necessário. 

5. Inicie a ferramenta Gerenciador de licenças, normalmente encontrada na 
pasta do aplicativo Capture Pro <drive>: \Arquivos de 
Programas\Kodak\Capture Pro\KCSPLM.exe.

6. Na janela Gerenciador de licenças (License Manager), selecione a guia 
“Solicitação de licença” e selecione Obter licença (Get License). 
Sua nova licença será recuperada e instalada. 
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Exemplo 3

Cenário: O Capture Pro Software está instalado na minha estação de trabalho, 
e preciso reconfigurar a estação de trabalho (adicionar/remover memória, 
atualizar o BIOS, alterar o nome da máquina, substituir a placa-mãe etc.). 
Minha estação de trabalho não tem acesso à Internet.

Solução: 

1. Selecione Ajuda > Gerenciador de licenças (Help > License Manager) 
na barra de menus. 

2. Na janela Gerenciador de licenças (License Manager), selecione a guia 
Liberar licença (Release License) e, em seguida, selecione Solicitar 
liberação (Request Release). Insira o caminho no qual você deseja 
armazenar o arquivo de solicitação de liberação. Selecione Solicitar 
(Request).

3. Saia do Capture Pro Software.

4. Mova o arquivo de solicitação de liberação para um computador com 
acesso à Internet. 

5. Faça o download da ferramenta Gerenciador de licenças do site de 
download do Capture Pro Software. 

6. Instale e inicie o Gerenciador de licenças. 

7. Na guia Liberar licença (Release License), selecione Fazer upload da 
solicitação (Upload Request). 

8. Procure o arquivo de solicitação de licença que você moveu para esse 
computador e selecione Fazer upload (Upload).

9. Reconfigure a estação de trabalho na qual o Capture Pro Software estiver 
em execução. 

10. Quando a configuração estiver concluída, inicie a ferramenta Gerenciador 
de licenças, normalmente encontrada na pasta do aplicativo Capture Pro 
<drive>: \Arquivos de Programas\Kodak\Capture Pro\KCSPLM.exe. 

11. Selecione a guia Solicitação de licença (License Request) e, em seguida, 
selecione Solicitar licença (Request License). Insira o caminho no qual 
você deseja salvar o arquivo de solicitação de licença. Selecione Solicitar 
(Request). Um arquivo de solicitação de licença será criado. 

12. Mova o arquivo de solicitação de licença para o computador com acesso 
à Internet no qual o Gerenciador de licenças está instalado. 

13. Na guia Solicitação de licença (License Request), selecione Fazer upload 
da solicitação (Upload Request). 

14. Procure o arquivo de solicitação de licença que você moveu para esse 
computador e selecione Fazer upload (Upload). 

15. Mova o arquivo de licença retornado para a estação de trabalho sem 
acesso à Internet, selecione a guia Solicitação de licença e, em seguida, 
selecione Instalar licença (Install License). Você será solicitado a inserir 
o caminho para o arquivo de licença que moveu para essa estação de 
trabalho.
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Exemplo 4

Cenário: Fiz alterações na configuração do hardware da minha estação de 
trabalho. Agora, quando inicio o Capture Pro Software, recebo a mensagem 
Código de licença inválido (Invalid license code). O que devo fazer?

Solução 1: 

1. Retorne a configuração do hardware da estação de trabalho para as 
configurações originais. Se não for possível, consulte a Solução 2. 

2. Consulte o Exemplo 2 se você tiver acesso à Internet ou o Exemplo 3 
se sua estação de trabalho não tiver acesso à Internet.

Solução 2: 

• Se sua estação de trabalho tiver acesso à Internet: 

1. Na pasta de instalação do Capture Pro (normalmente Arquivos de 
Programas > Kodak > Capture Pro), execute o Gerenciador de 
licenças, KCSPLM.exe.

2. Na guia Substituir licença (Replace License), selecione Substituir 
licença perdida (Replace Lost License). Uma nova licença será 
recuperada e instalada.

• Se sua estação de trabalho não tiver acesso à Internet: 

1. Na pasta de instalação do Capture Pro (normalmente Arquivos de 
Programas > Kodak > Capture Pro), execute o Gerenciador de 
licenças, KCSPLM.exe.

2. Na guia Substituir licença (Replace License), selecione Solicitar 
substituição (Request Replacement). Insira o caminho no qual você 
deseja salvar o arquivo de solicitação de substituição. Selecione 
Solicitar (Request). Um arquivo de solicitação de substituição de 
licença será criado.

3. Saia do Capture Pro Software.

4. Mova o arquivo de solicitação de substituição para um computador 
com acesso à Internet. 

5. No computador com acesso à Internet, faça o download da ferramenta 
Gerenciador de licenças no site de download do Capture Pro Software. 

6. Instale e inicie o Gerenciador de licenças. 

7. Na guia Substituir licença (Replace License), selecione Fazer upload 
da solicitação (Upload Request). 

8. Procure o arquivo de solicitação de substituição que você moveu para 
esse computador e selecione Fazer upload (Upload). Sua licença será 
retornada e armazenada no mesmo local para o qual você navegou 
para selecionar o arquivo de solicitação de substituição.

9. Mova o arquivo de licença retornado para a estação de trabalho sem 
acesso à Internet.

10. Na estação de trabalho sem acesso à Internet, acesse a guia Substituir 
licença (Replace License) e selecione Instalar licença (Install License).

11. Procure o local do arquivo de licença que você moveu para essa 
estação de trabalho e selecione Instalar (Install).
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Substituição de uma 
licença 

As funções Substituir licença (Replace License) são usadas para substituir 
uma licença original perdida devido a falha ou perda de equipamento. 
A substituição de uma licença que não foi perdida é uma violação do contrato 
de licença e pode resultar na perda do direito à licença.

Substituir licença perdida (Replace Lost License) — se a estação de 
trabalho de substituição tiver acesso à Internet, esta opção recuperará 
e instalará uma nova licença para essa estação de trabalho.

Solicitar substituição (Request Replacement) — se a estação de trabalho de 
substituição não tiver acesso à Internet, use esta opção para criar um arquivo 
de solicitação de substituição de licença. Esse arquivo poderá ser movido 
para um computador com acesso à Internet e enviado para o servidor de 
licença Kodak Alaris com a função Fazer upload da solicitação (Upload 
Request).

Fazer upload da solicitação (Upload Request) — esta opção é usada em um 
computador com acesso à Internet para enviar o arquivo de solicitação de 
licença de substituição para o servidor de licença Kodak Alaris.

Instalar licença (Install License) — esta função é usada na estação de 
trabalho sem acesso à Internet para instalar a licença recuperada de um 
computador com acesso à Internet.

Abaixo estão alguns exemplos de quando você poderá usar a função 
Substituir licença:

Exemplo 1

Cenário: Houve falha no disco rígido da minha estação de trabalho do Capture 
Pro Software, e não consigo recuperar o conteúdo. Minha estação de trabalho 
tem acesso à Internet. O que devo fazer?
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Solução: 

1. Antes de instalar o Capture Pro Software, faça o download da ferramenta 
Gerenciador de licenças no site de download do Capture Pro Software. 

2. Instale e inicie o Gerenciador de licenças. 

3. Na guia Substituir licença (Replace License), selecione Substituir licença 
perdida (Replace Lost License). Uma nova licença é recuperada, mas 
isso não é necessário neste momento. 

4. Faça download do Capture Pro Software no site de download do Capture 
Pro Software e inicie o instalador. Durante a instalação, uma cópia da nova 
licença do Capture Pro Software será recuperada do servidor de licença 
Kodak Alaris.

Exemplo 2

Cenário: Houve falha no disco rígido da minha estação de trabalho do Capture 
Pro Software, e não consigo recuperar o conteúdo. Minha estação de trabalho 
não tem acesso à Internet. O que devo fazer?

Solução:

1. Antes de instalar o Capture Pro Software, faça o download da ferramenta 
Gerenciador de licenças no site de download do Capture Pro Software. 

2. Instale o Gerenciador de licenças na estação de trabalho que não tem 
acesso à Internet e inicie-o. 

3. Na guia Substituir licença (Replace License), selecione Solicitar 
substituição (Request Replacement). Insira o caminho no qual você 
deseja salvar o arquivo de substituição. Selecione Solicitar (Request). 
Um arquivo de solicitação de substituição de licença será criado. 

4. Mova o arquivo de solicitação de substituição de licença para um 
computador com acesso à internet. 

5. No computador com acesso à Internet, faça o download da ferramenta 
Gerenciador de licenças no site de download do Capture Pro Software. 

6. Instale e inicie o Gerenciador de licenças. 

7. Na guia Substituir licença (Replace License), selecione Fazer upload da 
solicitação (Upload Request). 

8. Procure o arquivo de solicitação de substituição de licença que você 
moveu para esse computador e selecione Fazer upload (Upload). 
Sua licença será retornada e armazenada no mesmo local para o qual 
você navegou para selecionar o arquivo de solicitação de substituição de 
licença.

9. Volte à estação de trabalho na qual você deseja instalar o Capture Pro 
Software e execute o instalador do Capture Pro Software. Durante 
a instalação, o instalador criará um arquivo de solicitação de licença. 

OBSERVAÇÃO: o arquivo de solicitação de licença não é necessário 
porque você já criou uma licença de substituição na 
Etapa 8.

10. Mova o arquivo de licença de substituição para a estação de trabalho na 
qual você estiver instalando o Capture Pro Software e continue 
a instalação.
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